Admissibility in Finitely Generated Quasivarieties

Inauguraldissertation
der Philosophisch-naturwissenschaftlichen Fakultät
der Universität Bern

vorgelegt von

Christoph Röthlisberger
von Langnau im Emmental BE

Leiter der Arbeit:

Prof. Dr. George Metcalfe
Mathematisches Institut der Universität Bern
Admissibility in Finitely Generated Quasivarieties

Inauguraldissertation
der Philosophisch-naturwissenschaftlichen Fakultät
der Universität Bern

vorgelegt von

Christoph Röthlisberger
von Langnau im Emmental BE

Leiter der Arbeit:
Prof. Dr. George Metcalfe
Mathematisches Institut der Universität Bern

Von der Philosophisch-naturwissenschaftlichen Fakultät angenommen.

Der Dekan:
Prof. Dr. Silvio Decurtins

Bern, 10. Dezember 2013
Acknowledgement

First and foremost, I would like to express my gratitude to my advisor, George Metcalfe for his great support. Thank you for your belief in my abilities to finish the thesis, for your helpful guidance and inspiring advice – I could not imagine a better supervisor than you.

Furthermore, I would like to thank the University of Bern for giving me the possibility to complete my thesis. I acknowledge financial support from Swiss National Science Foundation Grant 200021_129507.

Special thanks also go to the following people: Markus Sprenger for providing me with the source code of the Algebra Workbench, Leonardo Cabrer for all the instructive discussions and his friendship, Jürg Schmid for motivating me to do a PhD, Lukas Gerber for answering my questions when starting at the University of Bern, Stefan Bachmann for explaining Delphi programming to me, Rosalie Iemhoff for taking the time to read and review my work.

Finally, I would like to express my love and gratitude to my beloved wife Rosana and my boys Julian, Noah and Ben, for their understanding and ongoing support during my studies.

Overall I praise God, the Almighty, for loving me.
Contents

1 Introduction 9

2 Preliminaries 15
   2.1 Algebras .............................................. 15
   2.2 Varieties and Quasivarieties .......................... 18
   2.3 Lattices and Congruences ............................ 20
   2.4 Subdirect Representations ............................ 23
   2.5 Free Algebras ......................................... 25

3 Finitely Generated Quasivarieties 29
   3.1 Minimal Generating Sets ............................... 30
   3.2 Unification .............................................. 36
   3.3 Admissibility ........................................... 38
   3.4 Structural Completeness .............................. 45
   3.5 Almost Structural Completeness ....................... 49
   3.6 Clone Equivalences ................................... 51
   3.7 Finite-Valued Logics .................................. 53
   3.8 Automatically Generated Proof Systems ............... 55

4 Case Studies 63
   4.1 Two Element Algebras ................................. 63
   4.2 Three Element Groupoids .............................. 67
4.3 Lattices ........................................ 68
4.4 De Morgan and Kleene Algebras ............ 72
4.5 Reducts of Sugihara Monoids ............... 81
4.6 Summary ........................................ 84

5 TFA - A Toolbox for Finite Algebras ........ 87
  5.1 Basic Operations ............................. 88
  5.2 Advanced Features ......................... 90
  5.3 Example Session ............................. 90

6 Concluding Remarks ............................ 97
  6.1 Contribution of the Thesis ................ 97
  6.2 Outlook ....................................... 99

Appendix A List of Three Element Groupoids ... 105

List of Figures .................................. 123
List of Tables .................................. 125
List of Algorithms ............................. 127
References ..................................... 129
Index .......................................... 139
Chapter 1

Introduction

A rule $\varphi_1, \ldots, \varphi_n / \varphi$, understood as “if $\varphi_1$ and $\ldots$ and $\varphi_n$, then $\varphi$”, of a logic $L$ is said to be admissible in $L$ if it can be added to the logic without producing any new theorems (in particular, every derivable rule is admissible). Intuitively, adding an admissible rule to a logical system may change the internal structure of the system, but does not affect its output. Equivalently, the rule $\varphi_1, \ldots, \varphi_n / \varphi$ is admissible in the logic $L$, if for any substitution $\sigma$, whenever $\sigma(\varphi_1), \ldots, \sigma(\varphi_n)$ are theorems of $L$, also $\sigma(\varphi)$ is a theorem of $L$.

Admissibility often plays a substantial role in proving properties of logical systems. For example, establishing the completeness of a proof system usually involves showing that a certain rule is admissible. In particular, cut-elimination proofs verify that the cut-rule is admissible with respect to the given proof system without cut, leading in some cases to decidability, complexity and interpolation results (see, e.g., [74, 4]). Moreover, admissible rules like the cut rule can be used to shorten proofs, and other admissible rules might be used to improve proof search. Admissibility is also closely related to the topic of unification (see, e.g., [99, 42, 43, 44, 46, 1]); in particular, a formula $\varphi$ is unifiable in a logic $L$ if and only if $\varphi / \bot$ is not admissible in $L$ (assuming that $\bot$ is in the language).

The notion of admissibility was defined by Lorenzen in the 1950s [69, page 19] (see Figure 1.1). However, particular admissible rules were already stud-
Ist eine Aussage ableitbar, so kann diese Aussage zu den Anfängen
des Kalküls hinzugefügt werden, ohne dadurch die Klasse der ableit-
baren Aussagen echt zu erweitern, d.h. jede Aussage, die nach der Hin-
zufügung ableitbar wird, war auch schon vor der Hinzufügung ableitbar.

Wir fragen jetzt nach Regeln, deren Hinzufügung ebenfalls die Klasse
der ableitbaren Aussagen nicht echt erweitert. Eine solche Regel wollen
wir zulässig nennen. Fügen wir z.B. zu $K_1$ die Regel
\[(R) \quad a \rightarrow a\]
hinzu, so entsteht ein neuer Kalkül — wir nennen ihn $K_1'$ — und in $K_1'$
ist $\circ+$ ableitbar. Hätten wir nun einen Beweis der Unableitbarkeit von
$\circ+$ in $K_1$, so wäre damit die Zulässigkeit von $(R)$ in $K_1$ widerlegt, mit
anderen Worten, $(R)$ wäre als unzulässig bewiesen. Sowie wir im Besitz

Figure 1.1: Excerpt from *Einführung in die operative Logik und Mathematik*
where admissible (german: *zulässig*) rules are defined, Lorenzen 1955.

ied by Gentzen [41, e.g., page 13] and Johansson [63, page 128] in the context
of sequent calculi and minimal logic, respectively; twenty years earlier.

All admissible rules of classical propositional logic CPC are derivable,
i.e., CPC is *structurally complete* (see [83]). For many other logics this is not
the case. The most famous example is intuitionistic propositional logic IPC
where, e.g., the Kreisel-Putnam rule is admissible, but not derivable:

$$
\neg \varphi \rightarrow (\psi \vee \chi) \quad / \quad (\neg \varphi \rightarrow \psi) \vee (\neg \varphi \rightarrow \chi).
$$

The notion of structural completeness was introduced by Pogorzelski [83] and
has been studied for many-valued logics (in particular, Gödel and Lukasiewicz
logics) [36, 107, 108, 109, 30], modal and intermediate logics [85, 32, 99] and
substructural logics [82]. Also algebraic characterizations have been given
for structural completeness (see, e.g., [86, 12, 9]).

In 1975, Friedman posed the question as to whether “There is a decision
procedure for determining whether a figure $A / B$ represents a valid rule of
inference in the intuitionistic propositional calculus (where $A, B$ are formulae
in the propositional calculus).” ([39, Question 40]), i.e., whether there is
a *decision procedure* for admissible rules in IPC. Rybakov answered this
question positively not only for IPC, but also for the modal logic S4 in [96, 98].
Concrete proof systems for checking admissibility in modal and intermediate logics have also been provided (see, e.g., [45, 59, 58, 6]).

Another question of interest is to find (possibly small) sets of rules characterizing the admissible rules of a given logic which is not structurally complete. More formally, a set of admissible rules of a given logic L is called a \textit{basis for the admissible rules of} L, if every admissible rule of L is derivable from this set in L. Rybakov showed in particular that there is no finite basis for the admissible rules of IPC [97]. Iemhoff [56] and Rozière [95] subsequently proved, independently, that an elegant infinite set of rules conjectured by De Jongh and Visser provides a basis. Bases for admissible rules have also been found for other logics, in particular modal logics [100, 60, 5], intermediate logics [57, 31], Lukasiewicz logics [61, 62] and other fuzzy logics [30], fragments of the substructural logic R-Mingle [73] and classes of De Morgan algebras [26].

The focus of this work is on admissibility in \textit{finite-valued} logics. At the beginning of the twentieth century, Lukasiewicz introduced the three-valued logic $L_3$ to handle future contingents such as “tomorrow it will rain” [70]. This and further investigations of finite and infinite valued Lukasiewicz logics [71, 72] together with the work of Post [84], which introduced other logics to tackle questions of functional completeness, stimulated further research on finite-valued logics. Since then many different finite-valued logics have been defined to treat statements which can have more than just the two truth values \textit{true} and \textit{false}. These additional truth values typically stand for uncertain, vague, undefined or senseless statements. Famous finite-valued logics were introduced, e.g., by Gödel [48], Bochvar [23], Kleene [66] and Belnap [8].

Checking the \textit{derivability} of rules in finite-valued logics is decidable and has been investigated extensively in the literature. In particular, general methods for generating proof systems to check derivability such as tableaux, resolution and multisequent calculi, have been developed, as have standard optimization techniques for these systems such as lemma generation and indexing (see, e.g., [28, 29, 54, 110, 3, 2]). However, checking the \textit{admissibility}
of rules in finite-valued logics is not so well-understood. Although the problem is decidable, a naive approach leads to computationally unfeasible procedures even for very small logics. A central goal of this thesis is to obtain a general and more feasible method to check admissibility in finite-valued logics. These techniques can then be useful for improving proof systems to check derivability in the logics or understanding their properties.

Even though the motivation comes from logic, the theory developed in this thesis makes use of the notions and methods of universal algebra. Many well-known logics are algebraizable in the sense of [21], i.e., they correspond to some quasivariety (their algebraic semantics), and hence results obtained in universal algebra can be translated back into the logical context. A logical rule corresponds to a quasiequation, i.e., to a finite set of equations implying another equation. A quasiequation

\[
\{ \varphi_1 \approx \psi_1, \ldots, \varphi_n \approx \psi_n \} \Rightarrow \varphi \approx \psi
\]

is called admissible in a class of algebras \( \mathcal{K} \) if every \( \mathcal{K} \)-unifier of the premises is a \( \mathcal{K} \)-unifier of the conclusion, where a \( \mathcal{K} \)-unifier of an equation \( \varphi \approx \psi \) is a substitution \( \sigma \) such that \( \sigma(\varphi) \approx \sigma(\psi) \) is valid in \( \mathcal{K} \).

The starting point for this work is the observation that for a finite set of finite algebras \( \mathcal{K} \), checking admissibility in the quasivariety \( \mathbb{Q}(\mathcal{K}) \) is the same as checking validity in the free algebra \( F_{\mathcal{K}}(n) \), where \( n \) is the maximal cardinality of the algebras in \( \mathcal{K} \) (see Theorem 3.9 and Corollary 2.19). This algebra \( F_{\mathcal{K}}(n) \) is finite (see Lemma 2.12), hence checking admissibility in \( \mathbb{Q}(\mathcal{K}) \) is decidable. But in some cases, even for small \( n \) and a small set of small algebras \( \mathcal{K} \), the size of \( F_{\mathcal{K}}(n) \) is very large. An implementation of a derived proof system to check validity for such algebras would not be practical. However, sometimes \( \mathcal{K} \)-admissibility corresponds to validity in other, quite small algebras. We aim to discover these small algebras using features of the free algebra. It turns out that every subalgebra of the free algebra \( F_{\mathcal{K}}(n) \) for which there are homomorphisms onto the algebras in \( \mathcal{K} \), may also be used for checking \( \mathcal{K} \)-admissibility. Unfortunately, these subalgebras of \( F_{\mathcal{K}}(n) \) are
not always the smallest algebras with this property. Therefore we provide an algorithm which finds the minimal (with respect to the standard multiset ordering) set of algebras satisfying the requirements (see Algorithm 3.1). Using this algorithm MinGenSet we are then able to characterize structural completeness and the related property of almost structural completeness.

These algorithms have been implemented in the tool TAFA, which has then been used to obtain admissibility results (some known and some new) for a wide range of (classes of) algebras. In particular, after showing that all two element algebras are structurally complete, we describe admissibility for all three element groupoids and lattices with up to five elements. We also provide bases for admissible quasiequations for De Morgan and Kleene algebras.

We proceed as follows. First, Chapter 2 recalls some required notions and results from universal algebra. Then Chapter 3 develops the theoretical core of the thesis, including results on minimal generating sets for quasivarieties, characterizations for admissibility, structural and almost structural completeness and algorithms to find sets of algebras to check admissibility. Chapter 4 presents admissibility related results for well known classes of algebras, including, e.g., the proof that all two element algebras are structurally complete, a study of all three element groupoids (see also Appendix A) and bases for admissible quasiequations for the quasivarieties of Kleene and De Morgan lattices and algebras. Chapter 5 describes the system TAFA, a tool for studying admissibility in finite algebras as well as solving general algebraic problems like calculating subalgebras, different kinds of morphisms, products, congruences and their lattices and checking properties like being subdirectly irreducible. Finally, Chapter 6 provides a summary of the contribution of the thesis to the theory of admissible rules and lists some ideas for further work.

Chapter 3 presents joint work with George Metcalfe of which substantial parts have been published as [76] and [77]. Section 4.4 also presents joint work with George Metcalfe that has appeared in [75]. The rest of Chapter 4
and the whole of *Chapter 5* is my own work, some of which has appeared in [92, 93].
Chapter 2

Preliminaries

This chapter introduces some basic definitions and known results of Universal Algebra that we will need to develop the theoretical machinery of the following chapters. We refer to [25] and [49] for further details.

2.1 Algebras

A language \( \mathcal{L} \) is a set of operation symbols \( \mathcal{L} \) with a nonnegative integer \( \ar(*) \) assigned to each operation symbol \( * \in \mathcal{L} \), called the arity of \( * \). We say that \( * \) is \( n \)-ary if \( \ar(*) = n \) for some operation symbol \( * \in \mathcal{L} \) (nullary, unary or binary if \( n \) is 0, 1 or 2, respectively). An \( \mathcal{L} \)-algebra \( A \) (algebra, if the language is clear from the context) is an ordered pair consisting of a nonempty set \( A \) (the universe of \( A \)) and an \( n \)-ary operation \( *^A : A^n \to A \) corresponding to each \( n \)-ary operation symbol \( * \) of \( \mathcal{L} \) (as usual, calling nullary operations constants). We often omit superscripts when describing the operations of an algebra. Sometimes we write \( \mathcal{F} \) for the set of operations on an algebra \( A \) and represent the algebra as follows:

\[
A := (A, \mathcal{F}).
\]
An algebra \( A' := \langle A, F' \rangle \) is called a reduct of the algebra \( A := \langle A, F \rangle \) if \( F' \subseteq F \). The \( \mathcal{L} \)-algebra \( A \) is said to be finite if \( A \) is a finite set and \( \mathcal{L} \) consists of finitely many operation symbols with finite arity.

We use the letters \( x_1, x_2, \ldots, y_1, y_2, \ldots, z_1, z_2, \ldots \), sometimes without indices, to denote countably infinitely many variables. For a set \( X \) of variables and a language \( \mathcal{L} \), the set \( \text{Tm}_\mathcal{L}(X) \) of \( \mathcal{L} \)-terms over \( X \) is inductively defined as usual: every variable \( x \in X \) is an \( \mathcal{L} \)-term over \( X \) and if \( \varphi_1, \ldots, \varphi_n \) are \( \mathcal{L} \)-terms over \( X \) and the operation symbol \( * \in \mathcal{L} \) has arity \( n \), then also \( *(\varphi_1, \ldots, \varphi_n) \) is an \( \mathcal{L} \)-term over \( X \). We call members of \( \text{Tm}_\mathcal{L}(\{x_1, x_2, \ldots\}) \) \( \mathcal{L} \)-terms and denote them by \( \text{Tm}_\mathcal{L}(\omega) \) or just \( \text{Tm}_\mathcal{L} \). We usually omit brackets where convenient and use the infix notation for binary operation symbols, e.g., we write \( x * y \) instead of \( *(x, y) \). The \( \mathcal{L} \)-terms over \( X \) build the universe of the term algebra over \( X \). The operations of \( \text{Tm}_\mathcal{L}(X) \) are defined as expected, i.e., for each \( n \)-ary \( * \in \mathcal{L} \), \( \varphi_1, \ldots, \varphi_n \in \text{Tm}_\mathcal{L}(X) \),

\[
*_{\text{Tm}_\mathcal{L}(X)}(\varphi_1, \ldots, \varphi_n) := *(\varphi_1, \ldots, \varphi_n).
\]

Let \( \varphi(x_1, \ldots, x_n) \) be an \( \mathcal{L} \)-term over some set \( X \) and \( A \) an \( \mathcal{L} \)-algebra. We define a map \( \varphi^A : A^n \to A \) called the term operation on \( A \) corresponding to \( \varphi \) (we often omit the superscripts for convenience) as follows:

- If \( \varphi \) is a variable \( x_i \) (\( 0 \leq i \leq n \)), then \( \varphi^A(a_1, \ldots, a_n) := a_i \).

- If \( \varphi \) is of the form \( *(\varphi_1(x_1, \ldots, x_n), \ldots, \varphi_k(x_1, \ldots, x_n)) \) for an operation symbol \( * \in \mathcal{L} \) of arity \( k \), then

\[
\varphi^A(a_1, \ldots, a_n) := *^A(\varphi_1^A(a_1, \ldots, a_n), \ldots, \varphi_k^A(a_1, \ldots, a_n)).
\]

The \( n \)-ary \( i \)-th projection \( p^A_i \) is defined by \( p^A_i(x_1, \ldots, x_n) := x_i \) and the \( n \)-ary constant operation \( c^A_k \) is defined by \( c^A_k(x_1, \ldots, x_n) := a \). Let \( * \) be an \( n \)-ary operation and \( \diamond_1, \ldots, \diamond_n \) \( m \)-ary operations. Then the composition of

16
the operations $*$ and $*$ is defined as the $m$-ary operation

$$*[\diamond_1, \ldots, \diamond_n](x_1, \ldots, x_m) := *(\diamond_1(x_1, \ldots, x_m), \ldots, \diamond_n(x_1, \ldots, x_m)).$$

The clone of operations of $A$, denoted $\text{Clo} A$, is the smallest set of operations on $A$ which contains all projections $p^a_i$ ($n \in \mathbb{N}, 0 \leq i \leq n$), the operations of $A$ and is closed under compositions. We write $\text{Clo}_n A$ to denote the set of $n$-ary members of $\text{Clo} A$. We say that two algebras $A_1$ and $A_2$ over the universe $A$ are clone equivalent if $\text{Clo} A_1 = \text{Clo} A_2$, and write $A_1 \approx_{\text{clo}} A_2$. We say that an $n$-ary operation $*(x_1, \ldots, x_n)$ is definable by the set of operations $\mathcal{F}$ of an algebra $A := \langle A, \mathcal{F} \rangle$ if there exists an $*^' \in \text{Clo} A$ such that $*(a_1, \ldots, a_n) = *'(a_1, \ldots, a_n)$ for any $a_1, \ldots, a_n \in A$.

Example 2.1. Let $A := \langle \{0, 1\}, \land, \neg \rangle$ be an algebra with $x \land y := \min \{x, y\}$ and $\neg x := 1 - x$. Then the unary operation $c^1_0$ is definable by $\{\land, \neg\}$, e.g., by $x \land \neg x$, while the nullary operation $c^0_0$ is not definable by $\{\land, \neg\}$.

Note that two algebras $A_1 := \langle A, \mathcal{F} \rangle$ and $A_2 := \langle A, \mathcal{G} \rangle$ are clone equivalent if and only if every operation in $\mathcal{F}$ is definable by $\mathcal{G}$ and vice versa.

Example 2.2. Let $G_{16} := \langle G_{16}, \circ \rangle$ and $G_{17} := \langle G_{17}, * \rangle$ be two $\mathcal{L}$-algebras with universe $\{a, b, c\}$ and the binary operations defined as follows (see Appendix A):

<table>
<thead>
<tr>
<th>$\circ$</th>
<th>$a$</th>
<th>$b$</th>
<th>$c$</th>
<th>$*$</th>
<th>$a$</th>
<th>$b$</th>
<th>$c$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
</tr>
<tr>
<td>$b$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
<td>$b$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
</tr>
<tr>
<td>$c$</td>
<td>$b$</td>
<td>$c$</td>
<td>$a$</td>
<td>$c$</td>
<td>$b$</td>
<td>$c$</td>
<td>$b$</td>
</tr>
</tbody>
</table>

$G_{16}$ and $G_{17}$ are clone equivalent since for any $x, y \in \{a, b, c\}$, we have that

$$x \circ y = (x \ast (x \ast (y \ast x))) \ast y, \quad \text{and}$$
$$x \ast y = x \circ ((x \circ y) \circ (x \circ x)).$$

Let $A$ and $B$ be two $\mathcal{L}$-algebras. $B$ is said to be a subalgebra of $A$, written $B \leq A$, if $B \subseteq A$ and every operation of $B$ is the restriction of the

17
corresponding operation of $A$ to the universe $B$.

A map $h: A \to B$ is called a homomorphism from $A$ to $B$, written $h: A \to B$, if it is compatible with all operations, i.e., for all $a_1, \ldots, a_n \in A$ and every $n$-ary operation $*: \mathcal{L}$,

$$h(^A{*}(a_1, \ldots, a_n)) = ^B{*}(h(a_1), \ldots, h(a_n)).$$

The algebra $C$ with universe $C := \{h(a) : a \in A\} \subseteq B$ and the restrictions of the operations of $B$ to $C$ as operations is called a homomorphic image of $A$. $A$ is called the prehomomorphic image of $C$ in this case. The kernel of a homomorphism $h: A \to B$ is defined by \(\ker h := \{(a_1, a_2) \in A^2 : h(a_1) = h(a_2)\}\). We often call injective homomorphisms embeddings and a homomorphism $h: A \to B$ that is bijective is called an isomorphism. We say that $A$ is isomorphic to $B$ if there is an isomorphism from $A$ to $B$, and write $A \cong B$.

The direct product of the $\mathcal{L}$-algebras $\{A_i\}_{i \in I}$ for an index set $I$ has universe $\prod_{i \in I} A_i$ and its operations are defined coordinate-wise, i.e., for an $n$-ary operation symbol $*: \mathcal{L}$, the $i$-th coordinate is defined as follows:

$$^*_i \prod_{i \in I} ^{A_i}(a_1, \ldots, a_n)(i) := ^{A_i}(a_1(i), \ldots, a_n(i)).$$

### 2.2 Varieties and Quasivarieties

An $\mathcal{L}$-equation is a pair of $\mathcal{L}$-terms, written $\varphi \approx \psi$. An $\mathcal{L}$-clause is defined as an ordered pair $\Sigma, \Delta$ of finite sets of $\mathcal{L}$-equations, written $\Sigma \Rightarrow \Delta$, and called an $\mathcal{L}$-quasiequation if $|\Delta| = 1$ and an $\mathcal{L}$-negative clause if $\Delta = \emptyset$. As usual, if the language is clear from the context, we may omit the prefix $\mathcal{L}$.

Let us fix $\mathcal{K}$ to be a class of $\mathcal{L}$-algebras, noting that often in what follows $\mathcal{K}$ will consist of a finite set of $\mathcal{L}$-algebras $A_1, \ldots, A_n$, and in this case we typically omit brackets. For a finite set of $\mathcal{L}$-equations $\Sigma \cup \Delta$, we say that the set $\Sigma$ is $\mathcal{K}$-satisfiable if $\Sigma \subseteq \ker h$ for some $A \in \mathcal{K}$ and homomorphism $h: \text{Tm}_\mathcal{L} \to A$, and the $\mathcal{L}$-clause $\Sigma \Rightarrow \Delta$ is $\mathcal{K}$-valid (or, $\mathcal{K}$ satisfies the $\mathcal{L}$-
clause \( \Sigma \Rightarrow \Delta \), written \( \Sigma \vdash_{\mathcal{K}} \Delta \) (or \( \vdash_{\mathcal{K}} \Delta \), if \( \Sigma = \emptyset \)), if for every \( A \in \mathcal{K} \) and homomorphism \( h: \text{Trm}_{\mathcal{L}} \to A \),

\[
\Sigma \subseteq \ker h \quad \text{implies} \quad \Delta \cap \ker h \neq \emptyset.
\]

The class \( \mathcal{K} \) is said to be \textit{axiomatized} by a set of \( \mathcal{L} \)-clauses \( \Lambda \) if \( \mathcal{K} \) is the class of \( \mathcal{L} \)-algebras \( A \) such that all \( \mathcal{L} \)-clauses in \( \Lambda \) are \( A \)-valid, i.e., \( A \in \mathcal{K} \) if and only if \( \Sigma \vdash_{A} \Delta \) for all \( \Sigma \Rightarrow \Delta \in \Lambda \). The class of \( \mathcal{L} \)-algebras \( \mathcal{K} \) is called an \( \mathcal{L} \)-universal class, \( \mathcal{L} \)-variety, \( \mathcal{L} \)-quasivariety or \( \mathcal{L} \)-antivariety if it is axiomatized by a set of \( \mathcal{L} \)-clauses, \( \mathcal{L} \)-equations, \( \mathcal{L} \)-quasiequations or \( \mathcal{L} \)-negative clauses, respectively. The universal class \( U(\mathcal{K}) \), variety \( V(\mathcal{K}) \), quasivariety \( Q(\mathcal{K}) \) and antivariety \( V^{-}(\mathcal{K}) \) \textit{generated by} \( \mathcal{K} \) are the smallest universal class, variety, quasivariety and antivariety containing \( \mathcal{K} \), respectively. \( \mathcal{K} \) is called the \textit{generating set} in this cases. If \( \mathcal{K} \) is a finite set of finite \( \mathcal{L} \)-algebras, these classes are called \textit{finitely generated}.

Moreover, let \( H, I, S, P, P_{U}, P_{U}^{*} \) and \( H^{-1} \) be the class operators (mapping classes of algebras to classes of algebras) of taking homomorphic images, isomorphic images, subalgebras, products, ultraproducts, non-empty ultraproducts\(^1\) and prehomomorphic images, respectively. E.g., \( A \in H(\mathcal{K}) \) if \( A \) is a homomorphic image of some \( B \in \mathcal{K} \). Birkhoff proved in his famous HSP theorem [17] that the equational classes, i.e., varieties, are exactly the classes which are closed under \( H, S \) and \( P \). Tarski refined this result to \( V(\mathcal{K}) = HSP(\mathcal{K}) \) in [105]. Similar results were also obtained for other syntactically defined classes of algebras:

\textbf{Theorem 2.3.} Let \( \mathcal{K} \) be a class of \( \mathcal{L} \)-algebras.

\begin{enumerate}
\item \( U(\mathcal{K}) = ISP_{U}(\mathcal{K}) \) ([25, Theorem V.2.20]).
\item \( V(\mathcal{K}) = HSP(\mathcal{K}) \) ([17, Theorem 6] and [105, Theorem]).
\item \( Q(\mathcal{K}) = ISP_{P}(\mathcal{K}) \) ([51, Theorem]).
\end{enumerate}

\(^1\)We refer to Section IV.6 in [25] for a proper definition of ultraproducts since they do not play any special role when considering finite sets of finite algebras.
(d) \( V^-(\mathcal{K}) = H^{-1}\mathbb{S}_U^*(\mathcal{K}) \) ([50, Theorem 1.2]).

If \( \mathcal{K} \) is a finite set of finite algebras, then \( P_U(\mathcal{K}) \subseteq I(\mathcal{K}) \) (see [25, Lemma IV.6.5]); hence \( U(\mathcal{K}) = IS(\mathcal{K}), Q(\mathcal{K}) = ISP(\mathcal{K}) \) and \( V^- (\mathcal{K}) = H^{-1}\mathbb{S}(\mathcal{K}) \). Note furthermore, that all varieties and quasivarieties contain trivial algebras since empty products are allowed (contrary to, e.g., [25]).

**Example 2.4.** A Boolean algebra is an algebra \( B := \langle B, \&, \lor, \neg, \bot, \top \rangle \) such that \( \langle B, \&, \lor \rangle \) is a distributive lattice (see Section 2.3) and the following hold:

\[
\begin{align*}
x \& \bot & \approx & \bot, \\
x \lor \top & \approx & \top, \\
x \& \neg x & \approx & \bot, \\
x \lor \neg x & \approx & \top.
\end{align*}
\]

If \( B_2 \) is the two element Boolean algebra, then \( Q(B_2) = Q(B_2 \times B_2) \) since \( B_2 \in P(B_2) \) and \( B_2 \in IS(B_2 \times B_2) \), but \( U(B_2 \times B_2) \not\subseteq U(B_2) \) since \( B_2 \times B_2 \not\in IS(B_2) \).

It is crucial to note that equations are preserved by the class operators defining universal classes, varieties and quasivarieties.

**Lemma 2.5** ([25, Lemma II.11.3]). Let \( \mathcal{K} \) be a class of \( \mathcal{L} \)-algebras. Then \( \mathcal{K}, \ I(\mathcal{K}), \ H(\mathcal{K}), \ S(\mathcal{K}), \ P(\mathcal{K}), \ P_U(\mathcal{K}) \) and \( P^*_U(\mathcal{K}) \) satisfy the same equations.

**Proof.** The cases \( \mathcal{K}, \ I(\mathcal{K}), \ H(\mathcal{K}), \ S(\mathcal{K}), \ P(\mathcal{K}) \) are covered in [25]. For the ultraproducts note that \( P^*_U(\mathcal{K}) \subseteq P_U(\mathcal{K}) \subseteq HP(\mathcal{K}) \).

### 2.3 Lattices and Congruences

A *lattice* is an algebra \( L := \langle L, \&, \lor \rangle \), where \( \& \) and \( \lor \) (called *meet* and *join*) are binary operations satisfying the following equations:

- **Commutativity**  
  \[
  x \& y \approx y \& x \\
  x \lor y \approx y \lor x
  \]

- **Associativity**  
  \[
  x \& (y \& z) \approx (x \& y) \& z \\
  x \lor (y \lor z) \approx (x \lor y) \lor z
  \]

- **Idempotency**  
  \[
  x \& x \approx x \\
  x \lor x \approx x
  \]

- **Absorption**  
  \[
  x \& (x \lor y) \approx x \\
  x \lor (x \land y) \approx x
  \]
A *distributive* lattice is a lattice admitting the equations of

\[
distributivity \quad x \land (y \lor z) \approx (x \land y) \lor (x \land z)
\]

\[
x \lor (y \land z) \approx (x \lor y) \land (x \lor z),
\]

and a *bounded lattice* \( L \) is an algebra \( \langle L, \land, \lor, \bot, \top \rangle \) such that \( \langle L, \land, \lor \rangle \) is a lattice and the constants \( \bot \) and \( \top \) satisfy the equations \( x \lor \bot \approx x \) and \( x \land \top \approx x \).

A lattice \( L \) is *complete* if for every subset \( B \subseteq L \) the meet \( \bigwedge B \) and join \( \bigvee B \) exist. An element \( a \) of a complete lattice \( L \) is called *completely meet irreducible* (meet irreducible) if for any (finite) subset \( B \subseteq L \), \( a = \bigwedge B \) implies \( a \in B \). The notion of join irreducibility is defined dually.

Besides this algebraic definition of a lattice there exists a corresponding order theoretic definition. To establish this connection we first have to introduce the notion of a partially ordered set. A *partially ordered set*, *poset* for short, is a set \( P \) together with a binary relation \( \leq \) (the partial order), written \( \langle P, \leq \rangle \), such that for all \( a, b, c \in P \) the following hold: \( a \leq a \) (reflexivity), \( a \leq b \) and \( b \leq a \) imply \( a = b \) (antisymmetry) and \( a \leq b \) and \( b \leq c \) imply \( a \leq c \) (transitivity). An upper (lower) bound of a subset \( A \) of a poset \( P \) is an element \( b \in P \) such that \( a \leq b \) (\( b \leq a \)) for all \( a \in A \). A least upper (greatest lower) bound is an upper (lower) bound \( m \in P \) such that for all other upper (lower) bounds \( b, m \leq b \) (\( b \leq m \)). We now define a *lattice* as a poset \( P \) such that any two elements \( a, b \in P \) have a least upper bound and a greatest lower bound. These two definitions of lattices are equivalent in the following sense: If \( L \) is a lattice by the first definition, we define a partial order \( \leq \) on \( L \) by \( a \leq b \) if \( a = a \land b \). If \( P \) is a lattice by the second definition, we define the binary operations \( \land \) and \( \lor \) to be the greatest lower bound and the least upper bound, respectively.

We say that \( b \) *covers* \( a \) in the poset \( P \), denoted \( a \prec b \), if \( a \leq c \leq b \) for any \( c \in P \) implies \( a = c \) or \( b = c \). We usually draw finite posets using *Hasse Diagrams*: a circle “○” represents an element of the poset and whenever \( a \prec b \), we draw the \( b \)-circle above the \( a \)-circle and connect them with a line.

**Example 2.6.** The Hasse Diagram depicted below shows two posets \( \langle P, \leq \rangle \) and \( \langle C_{2}, \leq \rangle \). \( P \) is not a lattice since \( a, b \in P \) do not have a lower bound.
Interpreted as algebras $\mathbf{P} := \langle P, \land, \lor \rangle$ (setting $a \land b := b$) and $\mathbf{C}_2 := \langle C_2, \land, \lor \rangle$ we can define a homomorphism $h$ as indicated by the dotted arrows in the picture. Note that $\mathbf{C}_2$ satisfies the $\land$-distributivity law $x \land (y \lor z) \approx (x \land y) \lor (x \land z)$, while $\mathbf{P}$ does not (e.g., $a \land (b \lor a) = a \land T = a \neq T = b \lor a = (a \land b) \lor (a \land a)$). Hence prehomomorphisms do not preserve equations (compare with Lemma 2.5).

An equivalence relation $\theta$ on a set $A$ is a subset $\theta \subseteq A \times A$, such that for all $a, b, c \in A$, $\langle a, a \rangle \in \theta$ (reflexivity), $\langle a, b \rangle \in \theta$ implies $\langle b, a \rangle \in \theta$ (symmetry) and $\langle a, b \rangle, \langle b, c \rangle \in \theta$ implies $\langle a, c \rangle \in \theta$ (transitivity). For the elements $a \in A$ we define $a/\theta := \{b \in A : \langle a, b \rangle \in \theta\}$, the equivalence class modulo $\theta$ (sometimes just $[a]$ if it is clear which equivalence relation we mean). The quotient of $A$ by $\theta$, denoted $A/\theta$, is the collection of the equivalence classes of $\theta$, i.e., $A/\theta := \{a/\theta : a \in A\}$. A congruence on an $\mathcal{L}$-algebra $\mathbf{A}$ is an equivalence relation $\theta$ on $A$ satisfying for each $n$-ary operation symbol $\ast$ of $\mathcal{L}$ and $a_1, \ldots, a_n, b_1, \ldots, b_n \in A$: $\langle a_1, b_1 \rangle \in \theta, \ldots, \langle a_n, b_n \rangle \in \theta$ implies $\langle \ast^A(a_1, \ldots, a_n), \ast^A(b_1, \ldots, b_n) \rangle \in \theta$.

The congruences of $\mathbf{A}$, denoted $\text{Con}(\mathbf{A})$, form a complete lattice $\text{Con}(\mathbf{A}) := \langle \text{Con}(\mathbf{A}), \land, \lor \rangle$ with bottom element $\Delta_\mathbf{A} := \{\langle a, a \rangle : a \in A\}$ and top element $\nabla_\mathbf{A} := \{\langle a, b \rangle : a, b \in A\}$, where the meet of two congruences $\theta_1, \theta_2$ on $\mathbf{A}$ is just the intersection $\theta_1 \cap \theta_2$ and the join of $\theta_1$ and $\theta_2$ is the intersection of all congruences containing $\theta_1 \cup \theta_2$.

Given $\theta \in \text{Con}(\mathbf{A})$, the quotient algebra of $\mathbf{A}$ by $\theta$ is the $\mathcal{L}$-algebra $\mathbf{A}/\theta$ with universe $A/\theta$ and operations defined for each $n$-ary operation symbol $\ast \in \mathcal{L}$ by $\ast^{\mathbf{A}/\theta}(a_1/\theta, \ldots, a_n/\theta) := \ast^A(a_1, \ldots, a_n)/\theta$. 
For an algebra $A$ and a congruence $\theta \in \text{Con}(A)$, the natural homomorphism $\nu_\theta : A \rightarrow A/\theta$ (sometimes just $\nu$ for convenience) sends each element of $A$ to its congruence class, i.e., $\nu_\theta(a) := a/\theta$.

We finish this section by stating that term operations behave as the operations of an algebra with respect to congruences and homomorphisms:

**Lemma 2.7** ([25, Theorem II.10.3]). Let $A, B$ be $L$-algebras, $\varphi(x_1, \ldots, x_n)$ an $n$-ary $L$-term and $a_1, \ldots, a_n, b_1, \ldots, b_n \in A$.

(a) If $\theta \in \text{Con}(A)$ and $\langle a_i, b_i \rangle \in \theta$ for $1 \leq i \leq n$, then $\langle \varphi^A(a_1, \ldots, a_n), \varphi^A(b_1, \ldots, b_n) \rangle \in \theta$.

(b) If $h : A \rightarrow B$ is a homomorphism, then $h(\varphi^A(a_1, \ldots, a_n)) = \varphi^B(h(a_1), \ldots, h(a_n))$.

### 2.4 Subdirect Representations

An $L$-algebra $A$ is called a subdirect product of the family $(A_i)_{i \in I}$ if there exist surjective homomorphisms $f_i : A \rightarrow A_i$ for each $i$ of the index set $I$ such that the induced homomorphism

$$f : A \rightarrow \prod_{i \in I} A_i, \quad f(x)(i) := f_i(x),$$

is an embedding. In this case, $f$ is called a subdirect representation of $A$ and the members of $(A_i)_{i \in I}$ are called subdirect components (for this representation). If $K$ is a class of $L$-algebras and $A_i \in K$ for all $i \in I$, then $A$ is called a $K$-subdirect product of the algebras $A_i$, $i \in I$ and $f$ is called a $K$-subdirect embedding. $A$ is called $K$-subdirectly irreducible if for every $K$-subdirect embedding $f : A \rightarrow \prod_{i \in I} A_i$, $A$ is isomorphic to $A_i$ for some $i \in I$.

The well known Subdirect Decomposition Theorem for equational classes [19, Theorem 2] also holds for more general classes, including quasivarieties:
Theorem 2.8 ([27, Corollary 6]). Let $Q$ be a quasivariety and $A \in Q$. Then $A$ is a $Q$-subdirect product of $Q$-subdirectly irreducible members of $Q$.

Moreover, the $Q(K)$-subdirectly irreducible algebras always embed into a generating algebra $A \in K$ of the quasivariety:

Lemma 2.9 ([49, Proposition 3.1.6]). Let $Q(K)$ be a finitely generated quasivariety and $A$ a $Q(K)$-subdirectly irreducible algebra. Then $A \in IS(K)$.

Theorem 2.10 ([18, Theorem VI.11]). Let $A$ be a subdirect product of the family $(A_i)_{i \in I}$. Then there exist for $i \in I$, congruences $\theta_i \in \text{Con}(A)$ such that $A_i \cong A/\theta_i$ and $\bigcap_{i \in I} \theta_i = \Delta_A$.

Conversely, let $(\theta_i)_{i \in I}$ be a family of congruences on $A$. Then the quotient $A/(\bigcap_{i \in I} \theta_i)$ is a subdirect product of the family $(A/\theta_i)_{i \in I}$.

We now translate this theorem to $Q$-subdirect representations of an algebra $A$, where $Q$ is a quasivariety containing $A$. This establishes the relationship between $Q$-subdirect representations of $A$ and families of $Q$-congruences on $A$. The set of $Q$-congruences on $A$ is defined as

$$\text{Con}_Q(A) := \{ \theta \in \text{Con}(A) : A/\theta \in Q \}.$$ 

Corollary 2.11. Let $Q$ be a quasivariety and $A \in Q$.

(a) Let $A$ be a $Q$-subdirect product of the family $(A_i)_{i \in I}$. Then there exist for $i \in I$, $Q$-congruences $\theta_i \in \text{Con}_Q(A)$ such that $A_i \cong A/\theta_i$ and $\bigcap_{i \in I} \theta_i = \Delta_A$.

Conversely, let $(\theta_i)_{i \in I}$ be a family of $Q$-congruences on $A$ with $\bigcap_{i \in I} \theta_i = \Delta_A$. Then $A$ is a $Q$-subdirect product of the family $(A/\theta_i)_{i \in I}$.

(b) $A$ is $Q$-subdirectly irreducible iff it is trivial or the bottom element $\Delta_A$ of $\text{Con}_Q(A)$ is completely meet-irreducible.

Proof. (a) Suppose that $A$ is a $Q$-subdirect product of the family $(A_i)_{i \in I}$ and hence obviously also a subdirect product of the family $(A_i)_{i \in I}$. So there exist
for \( i \in I \), congruences \( \theta_i \in \text{Con}(A) \) such that \( A_i \cong A/\theta_i \) and \( \bigcap_{i \in I} \theta_i = \Delta_A \) by Theorem 2.10. But then \( \theta_i \in \text{Con}_Q(A) \) for all \( i \in I \) since \( A_i \in Q \) for all \( i \in I \) by assumption and \( Q \) is closed under isomorphisms. For the other direction consider a family of \( Q \)-congruences \( (\theta_i)_{i \in I} \) on \( A \) with \( \bigcap_{i \in I} \theta_i = \Delta_A \).

By Theorem 2.10, \( A/(\bigcap_{i \in I} \theta_i) \) is a subdirect product of the family \( (A/\theta_i)_{i \in I} \).

But since \( \bigcap_{i \in I} \theta_i = \Delta_A \) and \( A/\theta_i \in Q \) for all \( i \in I \) by assumption, \( A \) is a \( Q \)-subdirect product of the family \( (A/\theta_i)_{i \in I} \).

(b) Define \( J := \text{Con}_Q(A) \setminus \{\Delta_A\} \). Suppose for a contradiction that \( A \) is non-trivial and \( Q \)-subdirectly irreducible and that \( \bigcap J = \Delta_A \). \( A \) is a \( Q \)-subdirect product of the algebras \( \{A/\theta : \theta \in J\} \) by (a). Since \( A \) is subdirectly irreducible, there is an isomorphism \( f : A \to A/\theta \) for some \( \theta \in J \), which contradicts \( \Delta_A \notin J \). For the other direction suppose that \( \bigcap J \neq \Delta_A \) and let \( f : A \to \prod_{i \in I} A_i \) be a subdirect representation of \( A \). By (a) there exist for \( i \in I \), \( Q \)-congruences \( \theta_i \in \text{Con}_Q(A) \) such that \( A_i \cong A/\theta_i \) and \( \bigcap_{i \in I} \theta_i = \Delta_A \). So by assumption \( \theta_i = \Delta_A \) for some \( j \in I \), hence \( A \cong A/\theta_j \) and \( A \) is subdirectly irreducible. \( \square \)

Note, moreover, that the number of congruences needed to obtain a subdirect representation of a finite algebra \( A \) is at most \(|A|\), the maximal number of coatoms of the congruence lattice \( \text{Con}(A) \).

### 2.5 Free Algebras

Given a class of \( L \)-algebras \( K \) and a set of variables \( X \) such that either \( X \neq \emptyset \) or \( L \) contains at least one constant symbol, the term algebra \( Tm_L(X) \) exists and admits the following congruence:

\[
\Psi_K(X) := \bigcap \{ \theta \in \text{Con}(Tm_L(X)) : Tm_L(X)/\theta \in IS(K) \}.
\]

Following [25], we let \( \overline{X} := X/\Psi_K(X) \) and define the free algebra of \( K \) over \( \overline{X} \) by:

\[
F_K(\overline{X}) := Tm_L(X)/\Psi_K(X).
\]
Then \( F_K(\overline{X}) \) has the \emph{universal mapping property} for \( K \) over \( \overline{X} \), i.e., for each \( A \in K \), any map from \( \overline{X} \) to \( A \) extends to a homomorphism from \( F_K(\overline{X}) \) to \( A \) (see [25, Theorem II.10.10]).

Note that \( F_K(\overline{X}) \cong F_K(\overline{Y}) \) whenever \( |X| = |Y| \). Also \( |\overline{X}| = |X| \) if \( K \) contains at least one non-trivial algebra (in this case we write \( x \) for \( \overline{x} \in \overline{X} \)). Hence we may consider for each cardinal \( \kappa \), the (unique up to isomorphism) \emph{free algebra of \( K \) on} \( \kappa \) \emph{generators} \( F_K(\kappa) \), where \( F_K(\kappa_1) \) is a subalgebra of \( F_K(\kappa_2) \) for cardinals \( \kappa_1 \leq \kappa_2 \).

It is crucial for us that for a finite set of finite algebras\(^2\) \( K \), the free algebra \( F_K(n) \) is finite for all \( n \in \mathbb{N} \):

\[
\text{Lemma 2.12 ([17, Corollary 2]). For any set of finite } \mathcal{L}\text{-algebras } K := \{A_1, \ldots, A_m\} \text{ and } n \in \mathbb{N}:
\[
|F_K(n)| \leq \prod_{i=1}^{m} |A_i|^{|A_i|^n}.
\]

We will sometimes need the fact that a free algebra is contained in the corresponding quasivariety and variety.

\[
\text{Lemma 2.13 ([25, Theorem II.10.12]). Suppose that } \text{Tm}_\mathcal{L}(X) \text{ exists. Then for a nonempty class } K \text{ of } \mathcal{L}\text{-algebras,}
\[
F_K(\overline{X}) \in \text{ISP}(K).
\]

Note that if \( K \) is a universal class or an antivariety, then \( F_K(\overline{X}) \in K \) does not hold in general.

\[
\text{Theorem 2.14 ([25, Theorem II.11.4]). Let } K \text{ be a class of } \mathcal{L}\text{-algebras and } \varphi, \psi \in \text{Tm}_\mathcal{L}(x_1, \ldots, x_n). \text{ Then the following are equivalent:}
\]

\[
(1) \vdash_K \varphi \approx \psi.
\]

2This was extended in [15, Theorem 2.8] to members of finitely generated varieties.
\( (3) \quad \varphi^{F_K(X)}(x_1, \ldots, x_n) = \psi^{F_K(X)}(x_1, \ldots, x_n). \)

\( (4) \quad \langle \varphi, \psi \rangle \in \Psi_K(X). \)

It follows that the free algebras of two classes of algebras \( \mathcal{K}_1 \) and \( \mathcal{K}_2 \) are the same if and only if \( \mathcal{K}_1 \) and \( \mathcal{K}_2 \) satisfy the same equations. Define \( \text{Eq}_K(X) := \{ \varphi \approx \psi : \varphi, \psi \in \text{Tm}_L(X) \text{ and } \models_K \varphi \approx \psi \}. \)

**Corollary 2.15.** Let \( \mathcal{K}_1, \mathcal{K}_2 \) be classes of \( \mathcal{L} \)-algebras. Then \( F_{\mathcal{K}_1}(X) = F_{\mathcal{K}_2}(X) \) iff \( \text{Eq}_{\mathcal{K}_1}(X) = \text{Eq}_{\mathcal{K}_2}(X) \). In particular, \( F_{\mathcal{V}(\mathcal{K}_1)}(\omega) = F_{\mathcal{V}(\mathcal{K}_2)}(\omega) \) iff \( \mathcal{V}(\mathcal{K}_1) = \mathcal{V}(\mathcal{K}_2) \).

Combining this with Lemma 2.5 we immediately get:

**Corollary 2.16.** Let \( \mathcal{K} \) be a class of \( \mathcal{L} \)-algebras and \( \kappa \) a cardinal number with \( \kappa \leq \omega \). Then

\[ F_{\mathcal{K}}(\kappa) = F_{\mathcal{U}(\mathcal{K})}(\kappa) = F_{\mathcal{V}(\mathcal{K})}(\kappa) = F_{\mathcal{Q}(\mathcal{K})}(\kappa). \]

Also, Lemma 2.13 and Theorem 2.14 imply that the free algebra of a variety \( \mathcal{V} \) on infinitely many generators generates \( \mathcal{V} \).

**Corollary 2.17.** If \( \mathcal{V} \) is a variety, then \( \mathcal{V} = \mathcal{V}(F_{\mathcal{V}}(\omega)) \).

If \( \mathcal{Q} \) is a finitely generated quasivariety, then only finitely many generators are needed to generate \( \mathcal{Q}(F_{\mathcal{Q}}(\omega)) \).

**Theorem 2.18** ([99, Lemma 4.1.10]). Let \( \mathcal{K} \) be a finite set of finite \( \mathcal{L} \)-algebras \( \{ A_1, \ldots, A_n \} \) and \( m := \max\{|A| : A \in \mathcal{K}\} \). Then \( \mathcal{Q}(F_{\mathcal{Q}(\mathcal{K})}(\omega)) = \mathcal{Q}(F_{\mathcal{Q}(\mathcal{K})}(m)). \)

Hence we obtain, using Lemma 2.12, Corollary 2.16 and \( P_{\mathcal{V}}(A) \subseteq I(A) \) for a finite algebra \( A \) (see Section 2.2), the following useful corollary:

**Corollary 2.19.** Let \( \mathcal{K} \) be a finite set of finite \( \mathcal{L} \)-algebras \( \{ A_1, \ldots, A_n \} \) and \( m := \max\{|A| : A \in \mathcal{K}\} \). Then \( \mathcal{Q}(F_{\mathcal{K}}(\omega)) = \text{ISP}(P_{\mathcal{V}}(F_{\mathcal{K}}(m))) = \text{ISP}(F_{\mathcal{K}}(m)). \)
Finitely Generated Quasivarieties

In this chapter, we address issues of admissibility in finitely generated quasivarieties: that is, quasivarieties generated by a finite number of finite algebras. We start by defining minimal generating sets for a finitely generated quasivariety $Q$: minimal sets of algebras $K$ (with respect to some multiset ordering) with $Q(K) = Q$ (Section 3.1). Due to the fact that the considered quasivarieties $Q(K)$ are finitely generated, we are able to present an algorithm which calculates a minimal generating set for $Q(K)$, given $K$ (see Algorithm 3.1). Sections 3.2, 3.4 and 3.5 provide useful characterizations of unification, structural completeness and almost structural completeness, respectively, and Section 3.3 presents an algorithm to build a proof system for checking admissibility in finitely generated quasivarieties. Section 3.6 takes a closer look at clone equivalences to prove that if the clones of operations of two algebras $A_1, A_2$ are the same, the free algebras $F_{A_1}(n)$ and $F_{A_2}(n)$ and the corresponding minimal generating sets are isomorphic up to a translation (inside the clone) of their languages. Section 3.7 explains how the algebraic ideas presented in this chapter can be transferred to finite-valued logics and Section 3.8 finally gives a concrete example of how a proof system for checking admissibility can be automatically generated.
3.1 Minimal Generating Sets

If \( Q \) is a quasivariety, a quasiequation \( \Sigma \Rightarrow \varphi \approx \psi \) is \( Q \)-admissible if and only if \( \Sigma \models_{F_Q(\omega)} \varphi \approx \psi \) (see Theorem 3.9). I.e., to check the \( Q \)-admissibility of a quasiequation, we have to check whether this quasiequation holds in the quasivariety generated by the free algebra \( F_Q(\omega) \). When \( Q \) is finitely generated there is an \( n \in \mathbb{N} \) such that \( F_Q(n) \) generates the same quasivariety (see Theorem 2.18). Since this algebra \( F_Q(n) \) is finite (see Lemma 2.12), it is possible to generate a proof system with a tool such as Multlog [101] or \( 3TAP \) [7] to check the validity of the quasiequation \( \Sigma \Rightarrow \varphi \approx \psi \) (e.g., using Multseq [47]). See Section 3.8 for an example system.

It is natural to ask for the “smallest” set of algebras generating the quasivariety \( Q(F_Q(\omega)) \). But first we have to determine a suitable measure for comparison. It turns out that a good choice for comparing the cardinalities of the algebras is the multiset well-ordering defined in [34]. Recall that a multiset over a set \( S \) is an ordered pair \( \langle S, f \rangle \) where \( f \) is a function \( f : S \rightarrow \mathbb{N} \). The multiset \( \langle S, f \rangle \) is called finite if \( \{ x \in S : f(x) > 0 \} \) is finite. We will write a finite multiset over \( S \) as \( [a_1, \ldots, a_n] \) where \( a_1, \ldots, a_n \in S \) may include repetitions. For a well-ordered set \( \langle S, \leq \rangle \), the multiset ordering \( \leq_m \) on the set \( M(S) \) of finite multisets over \( S \) is defined by \( \langle S, f \rangle \leq_m \langle S, g \rangle \) if \( f(x) > g(x) \) implies that for some \( y \in S, y > x \) and \( g(y) > f(y) \). Intuitively, \( M_1 \leq_m M_2 \) holds for two multisets \( M_1 \) and \( M_2 \) if \( M_1 \) can be obtained from \( M_2 \) by replacing its elements with a finite number (possibly zero) of strictly smaller elements of \( M_1 \).

Example 3.1. Let \( M_1 := [1, 1, 3, 3, 7] \) and \( M_2 := [2, 8] \) be multisets over \( \mathbb{N} \). Then \( M_1 \leq_m M_2 \) since 8 can be replaced by 3, 3, 3, 7 and 2 by 1, 1 to obtain \( M_1 \) from \( M_2 \).

We are now able to compare sets of algebras by comparing the corresponding multisets of cardinalities using \( \leq_m \). A set of finite \( \mathcal{L} \)-algebras \( \mathcal{A} := \{A_1, \ldots, A_n\} \) will be called a minimal generating set for the quasi-
variety \( Q(A_1, \ldots, A_n) \) if for every set of finite \( \mathcal{L} \)-algebras \( \mathcal{B} := \{B_1, \ldots, B_k\} \):

\[
Q(A) = Q(B) \quad \text{implies} \quad [|A_1|, \ldots, |A_n|] \leq_m [|B_1|, \ldots, |B_k|].
\]

The smallest free algebra \( F_K(n), n \in \mathbb{N} \), that generates the quasivariety \( Q(F_K(\omega)) \) is called the minimal generating free algebra for \( Q(F_K(\omega)) \). By Theorem 2.18 such a free algebra must exist.

Although it may seem counter-intuitive to say that twenty algebras with three elements are an improvement over one single four-element algebra, the measure \( \leq_m \) is a good choice for comparing generating sets. Checking a quasiequation with \( r \) variables in a finite algebra \( A \) requires checking \( |A|^r \) assignments of variables to elements of \( A \). But then checking validity in \( \{A_1, \ldots, A_n\} \) will involve checking fewer assignments of variables than checking validity in \( \{B_1, \ldots, B_k\} \) if \([|A_1|, \ldots, |A_n|] \leq_m [|B_1|, \ldots, |B_k|]\) for quasiequations with sufficiently many variables\(^1\).

Given a finitely generated quasivariety, we would like to calculate a minimal generating set. To do this, we need the following decomposition lemma:

**Lemma 3.2.** Let \( \mathcal{K} \) be a class of \( \mathcal{L} \)-algebras and suppose that \( \mathcal{K}' \) is obtained from \( \mathcal{K} \) by either (a) replacing \( A \in \mathcal{K} \) with \( A_1, \ldots, A_n \) where \( A \) is a \( Q(\mathcal{K}) \)-subdirect product of \( A_1, \ldots, A_n \), or (b) replacing \( A, B \in \mathcal{K} \) with \( B \) where \( A \in IS(B) \). Then \( Q(\mathcal{K}) = Q(\mathcal{K}') \).

**Proof.** Assume that \( \mathcal{K} \) is a class of \( \mathcal{L} \)-algebras. If \( A \) is a \( Q(\mathcal{K}) \)-subdirect product of \( A_1, \ldots, A_n \), then \( A \in ISP(A_1, \ldots, A_n) \subseteq Q(A_1, \ldots, A_n) \) and \( A_1, \ldots, A_n \in Q(\mathcal{K}) \). Hence \( Q(\mathcal{K}) = Q(\mathcal{K}') \), where \( \mathcal{K}' \) is obtained from \( \mathcal{K} \) by replacing \( A \) with \( A_1, \ldots, A_n \). On the other hand, if \( A \in IS(B) \), then \( A \in IS(\mathcal{K} \setminus \{A\}) \subseteq Q(\mathcal{K} \setminus \{A\}) \) and hence \( Q(\mathcal{K}) = Q(\mathcal{K}') \), where \( \mathcal{K}' \) is obtained from \( \mathcal{K} \) by replacing \( A, B \in \mathcal{K} \) with \( B \). \( \square \)

In particular, replacing each algebra \( A \) in a finite set \( \mathcal{K} \) of finite algebras with

---

\(^1\)In the example above where we have twenty three element algebras or one single four-element algebra, we need at least eleven variables to see the advantage with respect to \( \leq_m \), since \( 20 \cdot 3^r < 4^r \) for \( r \geq 11 \).
the \( \mathcal{Q}(\mathcal{K}) \)-subdirectly irreducible algebras in some \( \mathcal{Q}(\mathcal{K}) \)-subdirect representation of \( A \), then removing any algebra that embeds into another algebra in the set, produces a minimal generating set for \( \mathcal{Q}(\mathcal{K}) \) that is unique up to isomorphism.

**Theorem 3.3.** Suppose that \( \mathcal{Q} := \mathcal{Q}(A_1, \ldots, A_n) \) where \( A_i \) is a finite \( \mathcal{Q} \)-subdirectly irreducible algebra for \( i \in \{1, \ldots, n\} \) and \( A_i \not\in \mathbb{I}(A_j) \) for \( j \neq i \). Then \( \{A_1, \ldots, A_n\} \) is the unique minimal generating set for \( \mathcal{Q} \) up to isomorphism.

**Proof.** Let \( \mathcal{Q} := \mathcal{Q}(A_1, \ldots, A_n) \) where \( A_i \) is a finite \( \mathcal{Q} \)-subdirectly irreducible algebra for \( i \in \{1, \ldots, n\} \) and \( A_i \not\in \mathbb{I}(A_j) \) for \( j \neq i \). Suppose for a contradiction that \( \mathcal{Q} := \mathcal{Q}(B_1, \ldots, B_k) \) and \(|B_1|, \ldots, |B_k| < \text{max} \{|A_1|, \ldots, |A_n|\} \). Without loss of generality, we can suppose that \( B_j \) is \( \mathcal{Q} \)-subdirectly irreducible for \( j \in \{1, \ldots, k\} \); otherwise, by Theorem 2.8 and Lemma 3.2, \( B_j \) can be replaced with the \( \mathcal{Q} \)-subdirectly irreducible components of a \( \mathcal{Q} \)-subdirect representation of \( B_j \) and we obtain a smaller (according to \( \leq \text{max} \)) generating set of algebras for \( \mathcal{Q} \).

It follows that there exists a largest \( r \in \mathbb{N} \) such that there are strictly more occurrences of \( r \) in \(|A_1|, \ldots, |A_n|\) than in \(|B_1|, \ldots, |B_k|\), and for each \( r' > r \), the number of occurrences of \( r' \) in \(|A_1|, \ldots, |A_n|\) and \(|B_1|, \ldots, |B_k|\) are equal. Each \( A_i \) is finite and \( \mathcal{Q} \)-subdirectly irreducible, and hence by Lemma 2.9, embeds into some \( B_j \) where \(|A_i| \leq |B_j|\). If every \( A_i \) of size \( r \) embeds into, and is hence isomorphic to, a \( B_j \) of size \( r \), then (by the pigeonhole principle) there must be two isomorphic algebras in \( \{A_1, \ldots, A_n\} \), a contradiction. Hence, suppose without loss of generality that \( A_1 \) embeds into \( B_1 \) with \(|A_1| = r \) and \(|B_1| > r \). But notice now that \( B_1 \) is also \( \mathcal{Q} \)-subdirectly irreducible and hence embeds into some \( A_i \) with \( i \in \{2, \ldots, n\} \). So \( A_1 \in \mathbb{I}(A_i) \), a contradiction.

Finally, consider any minimal generating set \( \{B_1, \ldots, B_k\} \) for \( \mathcal{Q} \), and suppose for a contradiction that \( B_i \not\in \mathbb{I}(A_1, \ldots, A_n) \) for some \( i \in \{1, \ldots, k\} \). Then by Lemma 2.9, \( B_i \) properly embeds into \( A_j \) for some \( j \in \{1, \ldots, n\} \). But also by Lemma 2.9, \( A_j \) embeds into \( B_d \) for some \( d \in \{1, \ldots, k\} \setminus \{i\} \).
It follows that $B_i$ can be embedded into the strictly larger algebra $B_d$. But then \{B_1, \ldots, B_k\} is not a minimal generating set for $Q$, a contradiction. □

Hence, to calculate a minimal generating set for a finitely generated quasivariety $Q(\mathcal{K})$, we should find $Q(\mathcal{K})$-subdirect products with $Q(\mathcal{K})$-irreducible components of the algebras in $\mathcal{K}$. Recalling the connection between subdirect representations of a given algebra $A$ and sets of congruences on $A$ (see Theorem 2.10), it would appear to be a good idea to calculate the set $\text{Con}_{Q(\mathcal{K})}(A)$, the universe of a sublattice of the lattice of congruences $\text{Con}(A)$ (see [49, Corollary 1.4.11]). It is known that the problem of finding the congruence closure for a given equivalence relation on a finite algebra, i.e., the smallest congruence containing this equivalence, can be solved in polynomial time\(^2\). The problem of finding the $Q$-congruence closure of an equivalence relation on a finite algebra with respect to a finitely generated quasivariety $Q$ appears to be much harder, however. Instead, we use here the following characterization of $Q$-subdirectly irreducible algebras without needing to calculate the $Q$-congruence lattice.

**Lemma 3.4.** Let $\mathcal{K}$ be a finite set of finite $L$-algebras and $A \in Q(\mathcal{K})$. Then the following are equivalent:

1. $A$ is $Q(\mathcal{K})$-subdirectly irreducible.
2. $\bigcap\{\theta \in \text{Con}(A) \setminus \{\Delta_A\} : A/\theta \in \mathbb{IS}(\mathcal{K})\} \neq \Delta_A$.

**Proof.** For convenience, let

$$\Theta := \{\theta \in \text{Con}(A) \setminus \{\Delta_A\} : A/\theta \in \mathbb{IS}(\mathcal{K})\} \subseteq \text{Con}_{Q(\mathcal{K})}(A).$$

(1) $\Rightarrow$ (2) We proceed contrapositively. If $\bigcap\Theta = \Delta_A$, then by Corollary 2.11(a), $A$ is a $Q(\mathcal{K})$-subdirect product of algebras in $\{A/\theta : \theta \in \Theta\}$. But also by Corollary 2.11(b), since $\Delta_A \not\subseteq \Theta$, $A$ is not $Q(\mathcal{K})$-subdirectly irreducible.

\(^2\)This was used in [33] to provide a polynomial time algorithm for calculating a subdirect representation of a finite algebra. We refer to [24] for the definitions of complexity classes.
(2) ⇒ (1) Again, we proceed contrapositively and assume that \( A \) is not \( Q(K) \)-subdirectly irreducible. By combining Theorem 2.8 and Corollary 2.11, there exist \((\theta_i)_{i \in I} \subseteq \text{Con}_{Q(K)}(A) \setminus \{\Delta_A\}\) such that \( \bigcap_{i \in I} \theta_i = \Delta_A \) and \( A \) is a \( Q(K) \)-subdirect product of \( Q(K) \)-subdirectly irreducible algebras \( A/\theta_i \) \((i \in I)\). But then we have \( A/\theta_i \in \mathbb{I}(K) \) for each \( i \in I \) by Lemma 2.9, so \((\theta_i)_{i \in I} \subseteq \Theta\), and hence \( \bigcap \Theta = \Delta_A \).

We now have all the ingredients necessary to describe the algorithm \textsc{MinGenSet} (see Algorithm 3.1) that calculates the (unique up to isomorphism) minimal generating set for a finitely generated quasivariety.

\textbf{Theorem 3.5.} For a finite set \( K \) of finite \( L \)-algebras, \textsc{MinGenSet}(\( K \)) returns the (unique up to isomorphism) minimal generating set for \( Q(K) \).

\textit{Proof.} Let \( Q := Q(K) \). By Theorem 3.3, it suffices to find a set of \( Q \)-subdirectly irreducible algebras that generates \( Q \), where no member of the set embeds into another member of the set. The algorithm proceeds by considering each \( A \in K \) in turn. First, the congruence lattice \( \text{Con}(A) \) is generated (line 10) by checking for all equivalence relations if they are congruences. Next, the congruences \( \theta \in \text{Con}(A) \setminus \{\Delta_A\} \) such that \( A/\theta \) embeds into \( A \) or some other member of \( K \) are collected in sets \( S_1 \) and \( S_2 \), respectively. If \( \bigcap(S_1 \cup S_2) \neq \Delta_A \), then \( A \) is \( Q \)-subdirectly irreducible by Lemma 3.4, so the algorithm proceeds to the next algebra in \( K \). Otherwise \( \bigcap(S_1 \cup S_2) = \Delta_A \) and by Lemma 3.4, \( A \) is not \( Q \)-subdirectly irreducible. In this case, for each \( \theta \in S_1 \setminus S_2 \), the algebra \( A/\theta \) is added to \( K \) (line 15) and \( A \) is removed from \( K \) (line 17). Note that since the cardinalities of the added algebras are strictly smaller than the cardinality of the removed algebra, the new set of algebras is smaller according to the multiset ordering \( \preceq_m \). Hence this procedure is terminating. Moreover, the resulting finite set of finite algebras must generate the quasivariety \( Q \) (by Lemma 3.2), contain only \( Q \)-subdirectly irreducible algebras, and not contain any algebra that embeds into another member of the set (lines 22–26). Hence \textsc{MinGenSet}(\( K \)) is the minimal generating set of \( Q(K) \) up to isomorphism by Theorem 3.3. \qed
Algorithm 3.1 \texttt{MinGenSet}(\mathcal{K})$: For a finite set $\mathcal{K}$ of finite algebras, return the minimal generating set of $\mathbb{Q}(\mathcal{K})$.

1: function \texttt{MinGenSet}(\mathcal{K})
2: \hspace{1em} declare $S_1, S_2, C$ : set
3: \hspace{1em} declare $\mathcal{M}$ : list
4: \hspace{1em} declare $A$ : algebra
5: \hspace{1em} declare $i$ : integer
6: \hspace{1em} $\mathcal{M} \leftarrow \text{list}(\mathcal{K})$
7: \hspace{1em} $i \leftarrow 1$
8: \hspace{1em} while $i \leq \text{length}(\mathcal{M})$ do
9: \hspace{2em} $A \leftarrow \mathcal{M}[i]$
10: \hspace{2em} $C \leftarrow \text{Con}(A) \setminus \{\Delta_A\}$
11: \hspace{2em} $S_1 \leftarrow \{\theta \in C : A/\theta\text{ embeds into }A\}$
12: \hspace{2em} $S_2 \leftarrow \{\theta \in C : A/\theta\text{ embeds into some }\mathcal{M}[j] \neq A\}$
13: \hspace{2em} if $\bigcap(S_1 \cup S_2) = \Delta_A$ then
14: \hspace{3em} for all $\theta$ in $S_1 \setminus S_2$ do
15: \hspace{4em} add $A/\theta$ to $\mathcal{M}$
16: \hspace{3em} end for
17: \hspace{2em} remove $A$ from $\mathcal{M}$
18: \hspace{2em} else
19: \hspace{3em} $i \leftarrow i + 1$
20: \hspace{2em} end if
21: \hspace{2em} end while
22: \hspace{1em} for all $A$ in $\mathcal{M}$ do
23: \hspace{2em} if $A$ embeds into some $\mathcal{M}[j] \neq A$ then
24: \hspace{3em} remove $A$ from $\mathcal{M}$
25: \hspace{2em} end if
26: \hspace{2em} end for
27: \hspace{1em} return $\text{set}(\mathcal{M})$
28: end function
We remark that although the algorithm MinGenSet does not need to calculate the \(Q\)-congruence lattice, already calculating the congruence lattice of a finite algebra can take exponential time \(EXPTIME\). Moreover, the algorithm repeatedly checks for embeddings, which is in general an NP-complete problem (see [78, 13]).

### 3.2 Unification

For a class of \(L\)-algebras \(\mathcal{K}\), a set of \(L\)-equations \(\Sigma\) is said to be \(\mathcal{K}\)-unifiable, if there is a homomorphism \(\sigma : \text{TM}_L \rightarrow \text{TM}_L\) (often called a substitution) such that \(\models_{\mathcal{K}} \sigma(\varphi) \approx \sigma(\psi)\) for all \(\varphi \approx \psi \in \Sigma\). In this case we call \(\sigma\) a \(\mathcal{K}\)-unifier of \(\Sigma\) and say that it \(\mathcal{K}\)-unifies \(\Sigma\).

Note that a finite set \(\Sigma\) of \(L\)-equations is \(\mathcal{K}\)-unifiable if and only if the \(L\)-negative clause \(\Sigma \Rightarrow \emptyset\) is not \(\mathcal{K}\)-admissible. Or equivalently, when \(\mathcal{K}\) contains a non-trivial algebra, if and only if the \(L\)-quasiequation \(\Sigma \Rightarrow x \approx y\) with \(x, y\) not occurring in \(\Sigma\) is not \(\mathcal{K}\)-admissible.

We will prove in Theorem 3.7 that for checking \(\mathcal{K}\)-unifiability for a given set of \(L\)-equations \(\Sigma\), it suffices to find a smallest subalgebra \(C\) of the free algebra \(F_{\mathcal{K}}(1)\), noting that this is \(F_{\mathcal{K}}(0)\) if the language \(L\) contains constants. Then \(\Sigma\) is \(\mathcal{K}\)-unifiable if and only if \(\Sigma\) is \(C\)-valid, and indeed there is no smaller algebra with this property. First, however, we prove a useful lemma:

**Lemma 3.6.** Let \(\mathcal{K}\) and \(\mathcal{K}’\) be classes of \(L\)-algebras. Then the following are equivalent:

1. \(\Sigma\) is \(\mathcal{K}\)-unifiable iff \(\Sigma\) is \(\mathcal{K}’\)-satisfiable.

2. \(\forall^*(\mathcal{K}’) = \forall^*(F_{\mathcal{K}}(\omega))\).

**Proof.** Recall (from Section 2.2) that \(\forall^*(\mathcal{K}’) = \forall^*(F_{\mathcal{K}}(\omega))\) is equivalent to the condition that an \(L\)-negative clause \(\Sigma \Rightarrow \emptyset\) is \(\mathcal{K}’\)-valid iff it is \(F_{\mathcal{K}}(\omega)\)-valid. However, \(\Sigma \Rightarrow \emptyset\) is \(\mathcal{K}’\)-valid iff \(\Sigma\) is not \(\mathcal{K}’\)-satisfiable and \(\Sigma \Rightarrow \emptyset\) is \(F_{\mathcal{K}}(\omega)\)-valid iff \(\Sigma\) is not \(F_{\mathcal{K}}(\omega)\)-satisfiable. For the equivalence of (1) and (2),
it suffices therefore to show that $\Sigma$ is $F_K(\omega)$-satisfiable iff $\Sigma$ is $K$-unifiable.
Suppose first that $h: Tm_L \to F_K(\omega)$ satisfies $\Sigma$. Then any homomorphism $\sigma: Tm_L \to Tm_L$ defined such that $\sigma(x) \in h(x)$ for each variable $x$ is a $K$-unifier of $\Sigma$. Conversely, if $\sigma$ is a $K$-unifier of $\Sigma$, then the homomorphism $h: Tm_L \to F_K(\omega)$ defined by $h(x) := \sigma(x) / \Psi_K(\omega)$ for each variable $x$ satisfies $\Sigma$ as required. 

Theorem 3.7. Let $K$ be a class of $L$-algebras and $A \in S(F_K(\omega))$.

(a) $\Sigma$ is $K$-unifiable iff $\Sigma$ is $A$-satisfiable.

(b) If $A$ is a smallest finite subalgebra of $F_K(\omega)$ and $K'$ is a class of $L$-algebras such that $\Sigma$ is $K$-unifiable iff $\Sigma$ is $K'$-satisfiable, then $|A| \leq |B|$ for each $B \in K'$.

Proof. (a) By assumption, $A \in \mathcal{V}(F_K(\omega))$, so $\mathcal{V}(A) \subseteq \mathcal{V}(F_K(\omega))$. But also, since $A \in S(F_K(\omega)) \subseteq \mathcal{V}(F_K(\omega)) = \mathcal{V}(K)$ by Corollary 2.16 and $F_K(\omega) = F_{\mathcal{V}(K)}(\omega)$ has the universal mapping property for $\mathcal{V}(K)$ over countably infinitely many generators, we obtain a homomorphism $h: F_K(\omega) \to A$ defined by $h(x) := a$ for every variable $x$ for some fixed $a \in A$. But then $h[F_K(\omega)]$ is a subalgebra of $A$. Hence $F_K(\omega) \in \mathbb{H}^{-1}S(A) \subseteq \mathcal{V}(A)$. So $\mathcal{V}(F_K(\omega)) \subseteq \mathcal{V}(A)$ and the result follows by Lemma 3.6.

(b) Let $A$ be a smallest finite subalgebra of $F_K(\omega)$ and suppose that $K'$ is a class of $L$-algebras such that $\Sigma$ is $K$-unifiable iff $\Sigma$ is $K'$-satisfiable. Then by Lemma 3.6 and part (a), $\mathcal{V}(K') = \mathcal{V}(F_K(\omega)) = \mathcal{V}(A)$. Hence if $B \in K' \subseteq \mathcal{V}(K') = \mathcal{V}(F_K(\omega)) = \mathcal{V}(A) = \mathbb{H}^{-1}\mathcal{S}_U^*(A) = \mathbb{H}^{-1}(A)$, then clearly $|A| \leq |B|$. 

Example 3.8. De Morgan algebras are algebras $\langle A, \land, \lor, \neg, \bot, \top \rangle$ such that $\langle A, \land, \lor, \bot, \top \rangle$ is a bounded distributive lattice satisfying the following equations:

- **involution** $\neg\neg x \approx x$
- **De Morgan laws** $\neg(x \land y) \approx \neg x \lor \neg y$ $\neg(x \lor y) \approx \neg x \land \neg y$. 

37
The variety DMA of De Morgan algebras is generated as a quasivariety by the De Morgan algebra \( D_4 \) illustrated below (the negation is indicated by the dotted arrows):

\[
\begin{array}{c}
\top \\
\mathcal{a} \\
\mathcal{b} \\
\bot
\end{array}
\]

Since there are constants in the language of \( D_4 \), the smallest algebra for checking DMA-unifiability is the two element ground algebra \( F_{D_4}(0) \): i.e., the two element Boolean algebra. That is, checking unifiability amounts to checking classical satisfiability. E.g., \( x \land \neg x \approx x \lor \neg x \) is not DMA-unifiable, since in the two element Boolean algebra, \( \top \land \neg \top \neq \top \lor \neg \top \) and \( \bot \land \neg \bot \neq \bot \lor \neg \bot \).

The case of the “constant-free” variety DML of De Morgan lattices, generated as a quasivariety by \( D'_L := \langle \{ \bot, a, b, \top \}, \land, \lor, \neg \rangle \), is not so immediate. However, there is also a smallest two element subalgebra of \( F_{D'_L}(\omega) \) with elements corresponding to \( x \land \neg x \) and \( x \lor \neg x \). So checking DML-unifiability amounts again to checking classical satisfiability.

### 3.3 Admissibility

Let \( \mathcal{K} \) be a class of \( \mathcal{L} \)-algebras. An \( \mathcal{L} \)-quasiequation \( \Sigma \Rightarrow \varphi \approx \psi \) is called \( \mathcal{K} \)-admissible if every \( \mathcal{K} \)-unifier \( \sigma \) of \( \Sigma \) also \( \mathcal{K} \)-unifies \( \varphi \approx \psi \). More formally, \( \Sigma \Rightarrow \varphi \approx \psi \) is \( \mathcal{K} \)-admissible (or admissible in \( \mathcal{K} \)) if for every homomorphism \( \sigma : Tm_{\mathcal{L}} \rightarrow Tm_{\mathcal{L}} \):

\[
\models_{\mathcal{K}} \sigma(\varphi') \approx \sigma(\psi') \quad \text{for all} \quad \varphi' \approx \psi' \in \Sigma \quad \text{implies} \quad \models_{\mathcal{K}} \sigma(\varphi) \approx \sigma(\psi).
\]

Actually, \( \mathcal{K} \)-admissible quasiequations are simply the quasiequations that are valid in \( F_{\mathcal{K}}(\omega) \). We integrate this fact, which was already proven in [99, Theorem 1.4.5], into the following characterization theorem.
Theorem 3.9 ([99, Theorem 1.4.5] and [26, Theorem 2]). Let $\mathcal{K}$ be a class of $\mathcal{L}$-algebras and $\Sigma \cup \{\varphi \approx \psi\}$ a finite set of $\mathcal{L}$-equations. Then the following are equivalent:

(1) $\Sigma \Rightarrow \varphi \approx \psi$ is $\mathcal{K}$-admissible.

(2) $\Sigma \Rightarrow \varphi \approx \psi$ is $Q(\mathcal{K})$-admissible.

(3) $\Sigma \models_{F_{\mathcal{K}}(\omega)} \varphi \approx \psi$.

(4) $\forall(\mathcal{K}) = \forall(\{A \in Q(\mathcal{K}) : \Sigma \models_{A} \varphi \approx \psi\})$.

Proof. (1) $\Rightarrow$ (2) Suppose $\Sigma \Rightarrow \varphi \approx \psi$ is $\mathcal{K}$-admissible and $\models_{Q(\mathcal{K})} \sigma(\varphi') \approx \sigma(\psi')$ for all $\varphi' \approx \psi' \in \Sigma$ and some homomorphism $\sigma : \text{Tm}_\mathcal{L} \rightarrow \text{Tm}_\mathcal{L}$. By Lemma 2.5, $\models_{\mathcal{K}} \sigma(\varphi') \approx \sigma(\psi')$ for all $\varphi' \approx \psi' \in \Sigma$ and since $\Sigma \Rightarrow \varphi \approx \psi$ is $\mathcal{K}$-admissible also $\models_{\mathcal{K}} \sigma(\varphi) \approx \sigma(\psi)$. Again by Lemma 2.5, $\models_{Q(\mathcal{K})} \sigma(\varphi) \approx \sigma(\psi)$ and hence $\Sigma \Rightarrow \varphi \approx \psi$ is $Q(\mathcal{K})$-admissible.

(2) $\Rightarrow$ (1) is similar.

(1) $\Rightarrow$ (3) Suppose that $\Sigma \Rightarrow \varphi \approx \psi$ is $\mathcal{K}$-admissible and let $g : \text{Tm}_\mathcal{L} \rightarrow F_{\mathcal{K}}(\omega)$ be a homomorphism such that $\Sigma \subseteq \ker g$. We define a map $\sigma$ that sends each variable $x$ to a member of the equivalence class $g(x)$. By the universal mapping property of $\text{Tm}_\mathcal{L}$, this extends to a homomorphism $\sigma : \text{Tm}_\mathcal{L} \rightarrow \text{Tm}_\mathcal{L}$. But since $\nu(\sigma(x)) = g(x)$ for each variable $x$ ($\nu$ is the natural homomorphism for the congruence $\Psi_{\mathcal{K}}(\omega)$), we obtain $\nu \circ \sigma = g$. But then $\Sigma \subseteq \ker(\nu \circ \sigma)$, so for each $\varphi' \approx \psi' \in \Sigma$, we have $\nu(\sigma(\varphi')) = \nu(\sigma(\psi'))$ and therefore $\models_{\mathcal{K}} \sigma(\varphi') \approx \sigma(\psi')$. Hence by assumption, $\models_{\mathcal{K}} \sigma(\varphi) \approx \sigma(\psi)$, and $g(\varphi) = \nu(\sigma(\varphi)) = \nu(\sigma(\psi)) = g(\psi)$ as required.

(3) $\Rightarrow$ (1) Suppose that $\Sigma \models_{F_{\mathcal{K}}(\omega)} \varphi \approx \psi$ and let $\sigma : \text{Tm}_\mathcal{L} \rightarrow \text{Tm}_\mathcal{L}$ be a homomorphism such that $\models_{\mathcal{K}} \sigma(\varphi') \approx \sigma(\psi')$ for each $\varphi' \approx \psi' \in \Sigma$ and hence $\nu(\sigma(\varphi')) = \nu(\sigma(\psi'))$. By assumption, $\nu(\sigma(\varphi)) = \nu(\sigma(\psi))$. Hence $\models_{\mathcal{K}} \sigma(\varphi) \approx \sigma(\psi)$ as required.

We define $Q' := \{A \in Q(\mathcal{K}) : \Sigma \models_{A} \varphi \approx \psi\}$ for the rest of the proof.

(3) $\Rightarrow$ (4) Suppose that $\Sigma \models_{F_{\mathcal{K}}(\omega)} \varphi \approx \psi$. Then $F_{\mathcal{K}}(\omega) \in Q'$ and, using Corollary 2.17 and Lemma 2.13, $\forall(\mathcal{K}) = \forall(F_{\mathcal{K}}(\omega)) \subseteq \forall(Q')$, hence $\forall(\mathcal{K}) = \forall(Q')$ since $Q' \subseteq Q(\mathcal{K}) \subseteq \forall(\mathcal{K})$. 

39
(4) ⇒ (2): Suppose $V(\mathcal{K}) = V(\mathcal{Q}')$ and let $\sigma: \text{TM}_L \rightarrow \text{TM}_L$ be a homomorphism such that $|=_{\mathcal{Q}(\mathcal{K})} \sigma(\varphi') \approx \sigma(\psi')$ for all $\varphi' \approx \psi' \in \Sigma$. Since $\Sigma =_{\mathcal{Q}(\mathcal{K})} \sigma(\varphi) \approx \sigma(\psi)$ and by assumption, $|=_{\mathcal{K}} \sigma(\varphi) \approx \sigma(\psi)$. Hence by Lemma 2.5, $|=_{\mathcal{Q}(\mathcal{K})} \sigma(\varphi) \approx \sigma(\psi)$ as required. □

Example 3.10. The following quasiequations, expressing meet and join semi-distributivity for $\mathcal{L} := \{\land, \lor\}$, are satisfied by all free lattices (see [64, Lemma 2.6]), and are therefore admissible in the variety of lattices.

\[
\begin{align*}
  x \land y &\approx x \land z \quad \Rightarrow \quad x \land y \approx x \land (y \lor z) \\
  x \lor y &\approx x \lor z \quad \Rightarrow \quad x \lor y \approx x \lor (y \land z).
\end{align*}
\]

Given a class $\mathcal{K}$ of $\mathcal{L}$-algebras, we are interested in determining when the $\mathcal{K}$-admissibility of quasiequations coincides with their $\mathcal{K}'$-validity in another class of $\mathcal{L}$-algebras $\mathcal{K}'$. By Theorem 3.9, this is the case exactly when $\mathcal{Q}(\mathcal{K}') = \mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))$. The next result provides a further useful characterization of this situation.

**Theorem 3.11.** Let $\mathcal{K}$ be a class of $\mathcal{L}$-algebras and $\Sigma \cup \{\varphi \approx \psi\}$ a finite set of $\mathcal{L}$-equations. Then the following are equivalent:

1. $\Sigma \Rightarrow \varphi \approx \psi$ is $\mathcal{K}$-admissible iff $\Sigma |=_{\mathcal{K}} \varphi \approx \psi$.
2. $\mathcal{Q}(\mathcal{K}') = \mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))$.
3. $\mathcal{K}' \subseteq \mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))$ and $\mathcal{K} \subseteq V(\mathcal{K}')$.

**Proof.** (1) ⇔ (2) follows directly from Theorem 3.9.

(2) ⇒ (3) Suppose that $\mathcal{Q}(\mathcal{K}') = \mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))$. Then clearly $\mathcal{K}' \subseteq \mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))$. Moreover, $V(\mathcal{K}') = V(\mathcal{Q}(\mathcal{K}')) = V(\mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))) = V(\mathcal{F}_\mathcal{K}(\omega)) = V(\mathcal{K})$, so $\mathcal{K} \subseteq V(\mathcal{K}')$.

(3) ⇒ (2) Suppose that $\mathcal{K}' \subseteq \mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))$ and $\mathcal{K} \subseteq V(\mathcal{K}')$. Then clearly $\mathcal{Q}(\mathcal{K}') \subseteq \mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))$. But also $V(\mathcal{K}) \subseteq V(\mathcal{K}') \subseteq V(\mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega))) = V(\mathcal{F}_\mathcal{K}(\omega)) = V(\mathcal{K})$. That is, $V(\mathcal{K}) = V(\mathcal{K}')$. Hence $\mathcal{F}_\mathcal{K}(\omega) = \mathcal{F}_{\mathcal{K}'}(\omega) \in \mathcal{Q}(\mathcal{K}')$ and $\mathcal{Q}(\mathcal{F}_\mathcal{K}(\omega)) \subseteq \mathcal{Q}(\mathcal{K}')$. □
For checking $\mathcal{K}$-admissibility, we make use of a known result for finitely generated quasivarieties (see [99, Lemma 4.1.10]), obtained here as a corollary of Theorem 3.11:

**Corollary 3.12.** Let $\mathcal{K}$ be a finite set of finite $\mathcal{L}$-algebras with $n := \max\{|A| : A \in \mathcal{K}\}$.

(a) $\mathbb{Q}(F_{\mathcal{K}}(\omega)) = \mathbb{Q}(F_{\mathcal{K}}(n))$.

(b) $\Sigma \Rightarrow \varphi \approx \psi$ is $\mathcal{K}$-admissible iff $\Sigma \models_{F_{\mathcal{K}}(n)} \varphi \approx \psi$.

*Proof.* Observe first that each $A \in \mathcal{K}$ is a homomorphic image of $F_{\mathcal{K}}(n)$. That is, define any surjective map from the $n$ generators of $F_{\mathcal{K}}(n)$ to $A$; this extends to a surjective homomorphism from $F_{\mathcal{K}}(n)$ onto $A$ since $F_{\mathcal{K}}(n)$ has the universal mapping property for $\mathcal{K}$ over $n$ generators. So $\mathcal{K} \subseteq \forall(F_{\mathcal{K}}(n))$ and, since also $F_{\mathcal{K}}(n) \in \mathbb{Q}(F_{\mathcal{K}}(\omega))$, (a) and (b) follow by Theorem 3.11. □

Hence, since the finitely generated free algebra $F_{\mathcal{K}}(n)$ is finite when $\mathcal{K}$ is a finite set of finite algebras (see Lemma 2.12), checking $\mathcal{K}$-admissibility of quasiequations is decidable. However, even when $\mathcal{K}$ consists of a small number of small algebras, free algebras on a small number of generators can be quite large. For example, the free algebra $F_{D_4}(2)$ (see Example 3.8) has 168 elements. We therefore seek smaller algebras or finite sets of smaller algebras that also generate $\mathbb{Q}(F_{\mathcal{K}}(\omega))$ as a quasivariety. In fact, since $\mathbb{Q}(F_{\mathcal{K}}(\omega))$ is finitely generated, we may apply the multiset ordering $\leq_m$ and seek a minimal generating set of finite algebras for this quasivariety that is unique up to isomorphism. One strategy would therefore be to apply the algorithm $\text{MinGenSet}$ directly to $F_{\mathcal{K}}(n)$. However, this method is not feasible for large free algebras, since it involves the computationally labor-intensive task of building the congruence lattice of $F_{\mathcal{K}}(n)$. Instead, we make use of the following corollary of Theorem 3.11:

**Corollary 3.13.** Let $\mathcal{K}$ be a class of $\mathcal{L}$-algebras and $\mathcal{K}' \subseteq S(F_{\mathcal{K}}(\omega))$ such that $\mathcal{K} \subseteq \mathbb{H}(\mathcal{K'})$. 41
(a) $Q(K') = Q(F_K(\omega))$.

(b) $\Sigma \Rightarrow \varphi \approx \psi$ is $K$-admissible iff $\Sigma \models_{K'} \varphi \approx \psi$.

Hence, given a class $K$ of $L$-algebras, we might seek a set $K'$ of smallest subalgebras (according to $\leq_m$) of the free algebra $F_K(\omega)$ such that $K \subseteq \mathbb{H}(K')$ to reduce the complexity of checking admissibility. Note, however, that this set $K'$ might not be the minimal generating set for $Q(F_K(\omega))$.

**Example 3.14.** Consider the algebra $G_{106} := \langle\{a,b,c\}, \circ\rangle$ with the binary operation $\circ$ defined as follows (see also Appendix A):

<table>
<thead>
<tr>
<th>$\circ$</th>
<th>$a$</th>
<th>$b$</th>
<th>$c$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
<td>$a$</td>
</tr>
<tr>
<td>$b$</td>
<td>$a$</td>
<td>$b$</td>
<td>$b$</td>
</tr>
<tr>
<td>$c$</td>
<td>$a$</td>
<td>$c$</td>
<td>$b$</td>
</tr>
</tbody>
</table>

The minimal generating free algebra for $Q(F_{G_{106}}(\omega))$ has two generators and ten elements. There are 21 subalgebras of $F_{G_{106}}(2)$ which are pre-homomorphic images of $G_{106}$, out of 93 subalgebras in total (see filled dots in Figure 3.1). The two smallest subalgebras $A$ with $G_{106} \in \mathbb{H}(A)$ have four elements, but $\text{MinGenSet}(Q(F_{G_{106}}(2)))$ consists of two algebras $B_1 := \langle\{a,b\}, \circ\rangle$, $B_2 := \langle\{a,b\}, \circ\rangle$ with

<table>
<thead>
<tr>
<th>$\circ^{B_1}$</th>
<th>$a$</th>
<th>$b$</th>
<th>$\circ^{B_2}$</th>
<th>$a$</th>
<th>$b$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$a$</td>
<td>$a$</td>
<td>$b$</td>
<td>$a$</td>
<td>$b$</td>
<td>$a$</td>
</tr>
<tr>
<td>$b$</td>
<td>$b$</td>
<td>$b$</td>
<td>$b$</td>
<td>$b$</td>
<td>$b$</td>
</tr>
</tbody>
</table>

and hence $A$ is not the best choice with respect to the multiset ordering $\leq_m$.

We combine the idea of decomposition via the algorithm $\text{MinGenSet}$ and the search for subalgebras of the minimal generating free algebra that still generate the quasivariety, using Corollary 3.13, into the algorithm $\text{AdmAlgs}$ (see Algorithm 3.2). This algorithm calculates the (unique up to isomor-
Figure 3.1: Lattice of subuniverses of the algebra \( F_{G_{106}}(2) \).

... minimal generating set for \( Q(F_{\mathcal{K}}(\omega)) \) for a finite set \( \mathcal{K} \) of finite \( \mathcal{L} \)-algebras.

**Theorem 3.15.** For a finite set \( \mathcal{K} \) of finite \( \mathcal{L} \)-algebras, \( \text{AdmAlgs}(\mathcal{K}) \) returns the (unique up to isomorphism) minimal generating set for \( Q(F_{\mathcal{K}}(\omega)) \).

**Proof.** Let \( \mathcal{K} \) be a finite set of finite \( \mathcal{L} \)-algebras. When \( \text{AdmAlgs} \) is applied to \( \mathcal{K} \), first \( \mathcal{D} := \text{MinGenSet}(\mathcal{K}) \) is calculated, which typically is a small set of small algebras with \( Q(\mathcal{K}) = Q(\mathcal{D}) \) (see Theorem 3.5). We know by Theorem 2.18 that \( Q(F_{\mathcal{K}}(\omega)) = Q(F_{\mathcal{D}}(n)) \) where \( n := \max\{|D| : D \in \mathcal{D}\} \).

By Corollary 3.13 it even suffices that the free algebras are prehomo morphic images of the algebras in \( \mathcal{D} \). Such free algebras are calculated in line 7 for each \( A \in \mathcal{D} \) by the procedure\(^3\) \( \text{Free}(A, \mathcal{D}) \), which returns the smallest free algebra \( F_{\mathcal{D}}(n) \), \( n \leq |A| \), with \( A \in \mathbb{H}(F_{\mathcal{D}}(n)) \). (The procedure begins by checking the smallest free algebra \( F_{\mathcal{D}}(0) \) or \( F_{\mathcal{D}}(1) \), then increases the number of generators one at a time.) The algorithm then searches for progressively smaller subalgebras of \( F_{\mathcal{D}}(m) \) which have \( A \) as a homomorphic image. More precisely, the procedure \( \text{SubPreHOM}(A, B) \) searches for a proper subalgebra of \( B \) that is a homomorphic image of \( A \), returning \( B \) if no such algebra exists (line 9). This process terminates with a (hopefully reasonably small)

\(^{3}\)We obviously do not calculate the same free algebra twice in the implementation.
Algorithm 3.2 \textsc{AdmAlgs}(\mathcal{K}): For a finite set \mathcal{K} of finite algebras, return the minimal generating set of \( \mathcal{Q}(\mathbf{F}_\mathcal{K}(\omega)) \).

1: \textbf{function} \textsc{AdmAlgs}(\mathcal{K})
2: \hspace{1em} \textbf{declare} \ A, \ D : \text{set}
3: \hspace{1em} \textbf{declare} \ B, \ B' : \text{algebra}
4: \hspace{1em} D \leftarrow \textsc{MinGenSet}(\mathcal{K})
5: \hspace{1em} A \leftarrow \emptyset
6: \hspace{1em} \textbf{for all} \ A \in D \ \textbf{do}
7: \hspace{2em} B \leftarrow \textsc{Free}(A, D)
8: \hspace{2em} B' \leftarrow \textsc{SubPreHom}(A, B)
9: \hspace{2em} \textbf{while} \ B' \neq B \ \textbf{do}
10: \hspace{3em} B \leftarrow B'
11: \hspace{3em} B' \leftarrow \textsc{SubPreHom}(A, B)
12: \hspace{2em} \textbf{end while}
13: \hspace{1em} \textbf{add} \ B \ \textbf{to} \ A
14: \hspace{1em} \textbf{end for}
15: \hspace{1em} \textbf{return} \ \textsc{MinGenSet}(A)
16: \textbf{end function}
algebra which is added to a set \( A \). Again using Corollary 3.13, \( \mathbb{Q}(A) = \mathbb{Q}(F_K(\omega)) \). Finally, the procedure \textsc{MinGenSet} is applied to \( A \) to get the minimal generating set of \( \mathbb{Q}(F_K(\omega)) \) by Theorem 3.5.

3.4 Structural Completeness

We now turn our attention to classes of algebras for which admissibility and validity of quasiequations coincide. More formally, a class \( K \) of \( L \)-algebras is said to be \textit{structurally complete} if for any \( L \)-quasiequation \( \Sigma \Rightarrow \varphi \approx \psi \):

\[
\Sigma \Rightarrow \varphi \approx \psi \text{ is } K \text{-admissible} \quad \text{iff} \quad \Sigma \models_K \varphi \approx \psi.
\]

We say that \( A \) is \textit{structurally complete} if \( \{ A \} \) is structurally complete.

Using Theorem 3.9, this is true if and only if \( \mathbb{Q}(K) = \mathbb{Q}(F_K(\omega)) \) and leads to the following useful characterization, which also includes the equivalent condition proved by Berman [9]:

**Theorem 3.16** ([9, Proposition 2.3]). Let \( K \) be a class of \( L \)-algebras. Then the following are equivalent:

1. \( K \) is structurally complete.
2. \( \mathbb{Q}(K) = \mathbb{Q}(F_K(\omega)) \).
3. \( Q' \subset \mathbb{Q}(K) \) for some quasivariety \( Q' \) implies \( \forall(Q') \subset \forall(K) \).

**Proof.** (1) \( \Leftrightarrow \) (2) Let \( K \) be a class of \( L \)-algebras and \( \Sigma \Rightarrow \varphi \approx \psi \) any \( L \)-quasiequation. By the definition of structural completeness and Theorem 3.9, \( \Sigma \models_K \varphi \approx \psi \) iff \( \Sigma \Rightarrow \varphi \approx \psi \) is \( K \)-admissible iff \( \Sigma \models_{F_K(\omega)} \varphi \approx \psi \) as required.

(2) \( \Rightarrow \) (3) Suppose that \( \mathbb{Q}(K) = \mathbb{Q}(F_K(\omega)) \) and, for a contradiction, that \( Q' \subset \mathbb{Q}(K) \) and \( \forall(Q') = \forall(K) \) for some quasivariety \( Q' \). But then \( \mathbb{Q}(K) \subseteq \mathbb{Q}(F_K(\omega)) = \mathbb{Q}(F_Q'(\omega)) \subseteq Q' \) by Corollaries 2.15 and 2.16, a contradiction.

(3) \( \Rightarrow \) (2) Assume that \( \forall(Q') \subset \forall(K) \) for every quasivariety \( Q' \subset \mathbb{Q}(K) \). Using Lemma 2.13 it is clear that \( \mathbb{Q}(F_K(\omega)) \subseteq \mathbb{Q}(K) \). Suppose for a contra-
diction that $Q(F_K(\omega)) \subset Q(K)$, so $\forall(F_K(\omega)) \subset \forall(K)$ by assumption, which is a contradiction by Corollaries 2.16 and 2.17. □

This provides a method for establishing structural completeness for quasi-varieties. A quasivariety $Q$ is structurally complete if each member of a class of algebras generating $Q$ as a quasivariety can be embedded into the free algebra $F_Q(\omega)$, since then any quasiequation failing in one of the generating algebras also fails in $F_Q(\omega)$. More precisely:

**Theorem 3.17** ([30, Theorem 3.3]). Let $K$ be a class of $L$-algebras and suppose that for each $A \in K$, there is a map $g^A : A \to Tm_L$ such that $\nu \circ g^A$ embeds $A$ into $F_K(\omega)$, where $\nu$ is the natural homomorphism (see Section 2.3). Then $K$ is structurally complete.

**Proof.** Let $K$ be a class of $L$-algebras and suppose that each $A \in K$ embeds into $F_K(\omega)$. $Q(F_K(\omega)) \subseteq Q(K)$ by Lemma 2.13. On the other hand $A \in IS(F_K(\omega)) \subseteq Q(F_K(\omega))$ for each $A \in K$, hence $Q(K) \subseteq Q(F_K(\omega))$ and $K$ is structurally complete by Theorem 3.16. □

Combining this result with Corollary 2.19 we obtain:

**Corollary 3.18.** Let $K$ be a finite set of finite $L$-algebras and suppose that for each $A \in K$, there is a map $g^A : A \to Tm_L$ such that $\nu \circ g^A$ embeds $A$ into $F_K(m)$, where $m := \max\{|A| : A \in K\}$. Then $K$ is structurally complete.

**Example 3.19.** Consider the variety $BA$ of Boolean algebras, generated as a quasivariety by the two element Boolean algebra $B_2$ (see Example 2.4). Define $g(0) := \bot$ and $g(1) := \top$. Then $\nu \circ g$ is a homomorphism embedding $B_2$ into $F_{BA}(0)$ and hence $BA$ is structurally complete.

If a quasivariety $Q$ is not structurally complete, then the question arises of how to characterize the $Q$-admissible quasiequations. Let $Q$ and $Q'$ be quasivarieties for a language $L$ and let $\Lambda$ be a set of $L$-quasiequations. Suppose that $A \in Q'$ if and only if both $A \in Q$ and each quasiequation in $\Lambda$ holds in $A$. Then $\Lambda$ axiomatizes $Q'$ relative to $Q$. In particular, if $Q(F_Q(\omega))$
is axiomatized by $\Lambda$ relative to $Q$, then we call $\Lambda$ a basis for the admissible quasiequations of $Q$.

**Example 3.20.** Rozière [94] (see also [95]) and Iemhoff [56] proved independently that the set $\{V_n : n = 1, 2, \ldots\}$ of quasiequations $V_n$ forms a basis for the admissible quasiequations of the variety of Heyting algebras, where $V_n$ is defined as

\[
\bigwedge_{i=1}^{n} (x_i \to y_i) \to (x_{n+1} \lor x_{n+2}) \lor z \approx \top \Rightarrow \bigvee_{j=1}^{n+2} \bigwedge_{i=1}^{n} (x_i \to y_i) \to x_j \lor z \approx \top.
\]

Since $Q(\mathbf{F}_Q(\omega)) \subseteq Q$ for any quasivariety $Q$, finding a basis for the admissible quasiequations of $Q$ essentially involves finding a set of quasiequations that are admissible in $Q$ and that axiomatize a structurally complete quasivariety relative to $Q$. More precisely:

**Theorem 3.21.** Let $Q$ and $Q'$ be $\mathcal{L}$-quasivarieties and let $\Lambda$ be a set of $\mathcal{L}$-quasiequations axiomatizing $Q'$ relative to $Q$. Suppose that $Q'$ is structurally complete and that each quasiequation in $\Lambda$ is admissible in $Q$. Then $\Lambda$ is a basis for the $Q$-admissible quasiequations.

**Proof.** It suffices to show that $Q' = Q(\mathbf{F}_Q(\omega))$. If each quasiequation in $\Lambda$ is admissible in $Q$, then by Theorem 3.9, each quasiequation in $\Lambda$ holds in $\mathbf{F}_Q(\omega)$. Hence $\mathbf{F}_Q(\omega) \in Q'$ and $Q(\mathbf{F}_Q(\omega)) \subseteq Q'$. Suppose for a contradiction that $Q(\mathbf{F}_Q(\omega)) \subset Q'$. Since $Q'$ is structurally complete, $\forall(\mathcal{Q}) = \forall(\mathbf{F}_Q(\omega)) = \forall(\mathcal{Q}(\mathbf{F}_Q(\omega))) \subseteq \forall(\mathcal{Q}')$ by Corollaries 2.16 and 2.17. But $Q' \subseteq Q$, so $\forall(\mathcal{Q}') \subseteq \forall(\mathcal{Q})$, a contradiction. \qed

We now present another characterization of structural completeness. We have already seen in Theorem 3.17 that whenever each algebra of a given class $\mathcal{K}$ embeds into the free algebra $\mathbf{F}_\mathcal{K}(\omega)$, then $\mathcal{K}$ is structurally complete. The converse is not true in general.

**Example 3.22.** Consider the four element algebra $\mathcal{P} := \langle \{a, b, c, d\}, * \rangle$ where the unary operation $*$ and the free algebras $\mathbf{F}_\mathcal{P}(n)$ are described by Figure 3.2.
We calculate that MinGenSet(\{P\}) = MinGenSet(\{F_P(2)\}) = \{F_P(1)\}, where F_P(2) is the minimal generating free algebra for F_P(\omega). Hence Q(P) = Q(F_P(1)) = Q(F_P(\omega)) and P is structurally complete by Theorem 3.16. But P can not be embedded into F_P(n) for any n \in \mathbb{N} since there is no element b' \in F_P(n) that is the *-image of three pairwise different other elements.

It turns out that we have to check the embeddings for the minimal generating sets to have a nice characterization of structural completeness:\(^4\)

**Theorem 3.23.** Let \mathcal{K} be a finite set of finite \mathcal{L}-algebras. Then the following are equivalent:

1. \mathcal{K} is structurally complete.
2. MinGenSet(\mathcal{K}) \subseteq IS(F_\mathcal{K}(n)) where n := \max\{|C| : C \in \mathcal{K}\}.

**Proof.** (1) \Rightarrow (2) If \mathcal{K} is structurally complete, then, by Theorem 3.16 and Corollary 3.12, Q(\mathcal{K}) = Q(F_\mathcal{K}(\omega)) = Q(F_\mathcal{K}(n)) where n := \max\{|C| : C \in \mathcal{K}\}. So MinGenSet(\mathcal{K}) \subseteq Q(F_\mathcal{K}(n)). But each A \in MinGenSet(\mathcal{K}) is Q(F_\mathcal{K}(n))-subdirectly irreducible, so by Lemma 2.9, A embeds into F_\mathcal{K}(n). I.e., MinGenSet(\mathcal{K}) \subseteq IS(F_\mathcal{K}(n)).

(2) \Rightarrow (1) Suppose that each A \in MinGenSet(\mathcal{K}) embeds into F_\mathcal{K}(n). Then Q(F_\mathcal{K}(n)) \subseteq Q(\mathcal{K}) = Q(MinGenSet(\mathcal{K})) \subseteq Q(F_\mathcal{K}(n)). So \mathcal{K} is structurally complete by Theorem 3.16. \(\square\)

\(^4\)Note that Rybakov has a similar result in the context of logics possessing an analogue of the deduction theorem (see [99, Theorem 5.1.4]).
Note that we can reduce the number of generators of the free algebra in which we embed the minimal generating set of \( \mathcal{K} \), using Corollaries 2.16 and 3.13:

**Corollary 3.24.** Let \( \mathcal{K} \) be a finite set of finite \( \mathcal{L} \)-algebras. Then the following are equivalent:

1. \( \mathcal{K} \) is structurally complete.
2. \( \text{MinGenSet}(\mathcal{K}) \subseteq \mathbb{H}(\mathbf{F}_\mathcal{K}(n)) \) where \( n \) is the smallest natural number such that \( \text{MinGenSet}(\mathcal{K}) \subseteq \mathbb{H}(\mathbf{F}_\mathcal{K}(n)) \).

### 3.5 Almost Structural Completeness

For certain classes, admissibility and validity coincide for quasiequations with unifiable premises. More precisely, we call a class \( \mathcal{K} \) of \( \mathcal{L} \)-algebras *almost structurally complete* if it satisfies the condition:

\[
\Sigma \Rightarrow \varphi \approx \psi \text{ is } \mathcal{K}\text{-admissible} \quad \text{iff} \quad \Sigma \models_{\mathcal{K}} \varphi \approx \psi \text{ or } \Sigma \text{ is not } \mathcal{K}\text{-unifiable.}
\]

**Theorem 3.25.** Let \( \mathcal{K} \) be a class of \( \mathcal{L} \)-algebras and \( B \in \mathbb{S}(\mathbf{F}_\mathcal{K}(\omega)) \). Then the following are equivalent:

1. \( \mathcal{K} \) is almost structurally complete.
2. \( \mathbb{Q}(\{A \times B : A \in \mathcal{K}\}) = \mathbb{Q}(\mathbf{F}_\mathcal{K}(\omega)) \).
3. \( \{A \times B : A \in \mathcal{K}\} \subseteq \mathbb{Q}(\mathbf{F}_\mathcal{K}(\omega)) \).

**Proof.** (1) \( \Rightarrow \) (2) Suppose that \( \mathcal{K} \) is almost structurally complete. To establish \( \mathbb{Q}(\{A \times B : A \in \mathcal{K}\}) = \mathbb{Q}(\mathbf{F}_\mathcal{K}(\omega)) \), it suffices to show that a quasiequation \( \Sigma \Rightarrow \varphi \approx \psi \) is valid in all algebras \( A \times B \) for \( A \in \mathcal{K} \) iff it is valid in \( \mathbf{F}_\mathcal{K}(\omega) \). Suppose first that \( \Sigma \models_{\mathbf{F}_\mathcal{K}(\omega)} \varphi \approx \psi \). Then by Theorem 3.9, either \( \Sigma \) is not \( \mathcal{K} \)-unifiable or \( \Sigma \Rightarrow \varphi \approx \psi \) is \( \mathcal{K} \)-valid. In the first case, by Theorem 3.7, \( \Sigma \) is not \( \mathcal{B} \)-satisfiable, so \( \Sigma \Rightarrow \varphi \approx \psi \) is valid in all \( A \times B \) for all \( A \in \mathcal{K} \). In the second case, \( \Sigma \Rightarrow \varphi \approx \psi \) is valid in all \( A \times B \in \mathbb{Q}(\mathcal{K}) \).

49
Conversely, if $\Sigma \Rightarrow \varphi \approx \psi$ is valid in $A \times B$ for each $A \in \mathcal{K}$, then either $\Sigma$ is not $B$-satisfiable or $\Sigma \Rightarrow \varphi \approx \psi$ is valid in each $A$ in $\mathcal{K}$. In the first case, by Theorem 3.7, $\Sigma$ is not $\mathcal{K}$-unifiable, so $\Sigma \Rightarrow \varphi \approx \psi$ is valid in $F_{\mathcal{K}}(\omega)$. In the second case, $\Sigma \Rightarrow \varphi \approx \psi$ is valid in $Q(\mathcal{K})$ and hence valid in $F_{\mathcal{K}}(\omega)$.

(2) $\Rightarrow$ (1) Suppose that $Q(F_{\mathcal{K}}(\omega)) = Q(\{A \times B : A \in \mathcal{K}\})$. Then whenever $\Sigma \Rightarrow \varphi \approx \psi$ is $\mathcal{K}$-admissible, it is $F_{\mathcal{K}}(\omega)$-valid and hence also valid in $A \times B$ for all $A \in \mathcal{K}$. Moreover, if $\Sigma$ is $\mathcal{K}$-unifiable, then, by Theorem 3.7, it is $B$-satisfiable. I.e., there exists a homomorphism $h: Tm_{\mathcal{L}} \rightarrow B$ with $\Sigma \subseteq \ker h$. For any $A \in \mathcal{K}$ and homomorphism $k: Tm_{\mathcal{L}} \rightarrow A$ with $\Sigma \subseteq \ker k$, define $e_A: Tm_{\mathcal{L}} \rightarrow A \times B$ by $e_A(u) := (k(u), h(u))$. Then, since $\Sigma \Rightarrow \varphi \approx \psi$ is valid in $A \times B$ for all $A \in \mathcal{K}$, $\Sigma \subseteq \ker e$, so $e(\varphi) = e(\psi)$ and $k(\varphi) = k(\psi)$. I.e., $\Sigma \models_{\mathcal{A}} \varphi \approx \psi$. So we have shown that $\Sigma \models_{\mathcal{K}} \varphi \approx \psi$.

(2) $\Rightarrow$ (3) Immediate.

(3) $\Rightarrow$ (2) Suppose that $\{A \times B : A \in \mathcal{K}\} \subseteq Q(F_{\mathcal{K}}(\omega))$. Then also, since $A \in \mathbb{H}(A \times B)$ for each $A \in \mathcal{K}$, we obtain $\mathcal{K} \subseteq \nabla(\{A \times B : A \in \mathcal{K}\})$. Hence by Theorem 3.11, $Q(\{A \times B : A \in \mathcal{K}\}) = Q(F_{\mathcal{K}}(\omega))$. \(\Box\)

Example 3.26. Consider the Wajsberg algebras with two and three elements $L_2 := \langle \{0, 1\}, \rightarrow, \neg \rangle$ and $L_3 := \langle \{0, \frac{1}{2}, 1\}, \rightarrow, \neg \rangle$ where

$$ x \rightarrow y := \min(1, 1 - x + y) \quad \text{and} \quad \neg x := 1 - x. $$

$L_2$ embeds into $F_{L_3}(\omega)$ via $0 \mapsto [\neg(x \rightarrow x)]$, $1 \mapsto [x \rightarrow x]$ and hence is (isomorphic to) a subalgebra of $F_{L_3}(\omega)$. The algebra $L_3 \times L_2$ embeds into $F_{L_3}(\omega)$, as illustrated in the diagram below by the terms associated to elements, and has $L_3$ as a homomorphic image, as indicated by the arrows. Hence by Corollary 3.13 and Theorem 3.25, $L_3$ is almost structurally complete. However, it is not structurally complete since, e.g., $x \approx \neg x \Rightarrow x \approx y$ is $L_3$-admissible, but not $L_3$-valid. On the other hand, its implicational reduct $L_3^\rightarrow := \langle \{0, \frac{1}{2}, 1\}, \rightarrow \rangle$ is structurally complete, since it embeds into $F_{L_3^\rightarrow}(2)$ (see Theorem 3.17).
We now are able to prove a characterization for almost structural completeness similar to Theorem 3.23:

**Theorem 3.27.** Let $\mathcal{K}$ be a finite set of finite $\mathcal{L}$-algebras, $B \in \mathcal{S}(F_{\mathcal{K}}(\omega))$ and $n := \max\{|C| : C \in \mathcal{K}\}$. Then the following are equivalent:

1. $\mathcal{K}$ is almost structurally complete.
2. $\text{MinGenSet}({A \times B : A \in \mathcal{K}}) \subseteq \mathcal{I}(F_{\mathcal{K}}(n)).$

**Proof.** $(1) \Rightarrow (2)$ If $\mathcal{K}$ is almost structurally complete, then by Theorem 3.25 and Corollary 3.12, $Q({A \times B : A \in \mathcal{K}}) = Q(F_{\mathcal{K}}(\omega)) = Q(F_{\mathcal{K}}(n))$ where $n := \max\{|C| : C \in \mathcal{K}\}$. In particular, $\text{MinGenSet}({A \times B : A \in \mathcal{K}}) \subseteq Q(F_{\mathcal{K}}(n))$. But each $C \in \text{MinGenSet}({A \times B : A \in \mathcal{K}})$ is $Q(F_{\mathcal{K}}(n))$-subdirectly irreducible, so by Lemma 2.9, $C$ embeds into $F_{\mathcal{K}}(n)$. I.e., $\text{MinGenSet}({A \times B : A \in \mathcal{K}}) \subseteq \mathcal{I}(F_{\mathcal{K}}(n))$.

$(2) \Rightarrow (1)$ If $\text{MinGenSet}({A \times B : A \in \mathcal{K}}) \subseteq \mathcal{I}(F_{\mathcal{K}}(n))$, then $\{A \times B : A \in \mathcal{K}\} \subseteq Q(F_{\mathcal{K}}(n)) = Q(F_{\mathcal{K}}(\omega))$. So by Theorem 3.25, $\mathcal{K}$ is almost structurally complete. 

### 3.6 Clone Equivalences

This section makes a useful observation regarding clone equivalent algebras: There is no need to calculate free algebras, minimal generating sets or the
Recall from Section 2.1 that clones of operations are defined on a fixed universe and hence two clone equivalent algebras $A$ and $B$ are isomorphic in the language $L = \text{Clo}_A = \text{Clo}_B$. The next theorem states that the free algebras and the minimal generating sets of the quasivarieties generated by the free algebras on countably infinitely many generators are clone equivalent for clone equivalent algebras. Hence if we calculated the minimal generating free algebra $F_A(n)$ for $Q(F_A(\omega))$, we only need to translate the operations from the language of $A$ into the language of $B$ to get the minimal generating free algebra $F_B(n)$ for $Q(F_B(\omega))$.

**Theorem 3.28.** Let $A$ and $B$ be two clone equivalent finite algebras.

(a) $F_A(n) \approx_{\text{clo}} F_B(n)$ for all natural numbers $n \geq m$, where $m$ is the maximal arity of the operations on $A$ and $B$.

(b) Any member of a minimal generating set for $Q(F_A(\omega))$ has exactly one clone equivalent member in a minimal generating set for $Q(F_B(\omega))$.

(c) $A$ is structurally complete iff $B$ is structurally complete.

(d) $A$ is almost structurally complete iff $B$ is almost structurally complete.

**Proof.** (a) $\text{Clo}_n A = \text{Clo}_n B$ for any $n$ greater than the maximal arity of the operations on $A$ and $B$ by the assumption, so $F_A(n) \approx_{\text{clo}} F_B(n)$ follows directly from $F_A(k) \cong \text{Clo}_k A$ for any $k \in \mathbb{N}$ (see [10, Exercise 4.34.3]), where $\text{Clo}_n A$ is the algebra with universe $\text{Clo}_n A$ and the natural induced operations.

(b) follows from (a) since $F_A(n) \cong F_B(n)$ in $L = \text{Clo}_n A$.

(c), (d) then follow directly from (a),(b) using Theorems 3.23 and 3.27. \qed
3.7 Finite-Valued Logics

For algebraizable logics, admissible rules may be translated into admissible quasiequations and vice versa (see [21]). The characterizations of admissibility we have seen in the preceding sections can be adapted to finite-valued logics. Unlike the algebraic case we have to treat here the designated values of the logic, i.e., the truth values considered true. Here we describe a method that given a finite-valued logic $L$, provides another (hopefully small) finite-valued logic $L'$ such that validity in $L'$ corresponds to admissibility in $L$. The more general case, where we search for a smallest finite set of logics such that validity in all members of the set corresponds to admissibility in a logic (or logics), will not be considered here.

Recall that a finite-valued logic $L := (A, D)$ for a language $L$ consists of a finite $L$-algebra $A$ and a set of designated values $D \subseteq A$. Given $\Gamma \cup \{\varphi\} \subseteq Tm_L$, we let $\Gamma \vdash_L \varphi$ denote that for all homomorphisms $h : Tm_L \to A$, whenever $h[\Gamma] \subseteq D$, also $h(\varphi) \in D$. A term $\varphi$ is $L$-valid if $\vdash_L \varphi$.

Consider now a finite-valued logic $L := (A, D)$ for a language $L$ and a finite set of terms $\Gamma \subseteq Tm_L$. We say that $\Gamma$ is $L$-unifiable if there exists a homomorphism $\sigma : Tm_L \to Tm_L$ such that $\vdash_L \sigma(\psi)$ for all $\psi \in \Gamma$ and call $\sigma$ in this case an $L$-unifier of $\Gamma$. A rule is a pair $\langle \Gamma, \varphi \rangle$, $\Gamma \cup \{\varphi\} \subseteq Tm_L$ finite, where the elements of $\Gamma$ are called the premises and $\varphi$ the conclusion of the rule. The pair $\langle \{\sigma(\varphi_1), \ldots, \sigma(\varphi_n)\}, \sigma(\varphi) \rangle$ is called an instance of the rule $\langle \{\varphi_1, \ldots, \varphi_n\}, \varphi \rangle$, where $\sigma$ is a substitution on $Tm_L$. A rule $\langle \{\varphi_1, \ldots, \varphi_n\}, \varphi \rangle$ named $\otimes$ is usually written as

$$\varphi_1, \ldots, \varphi_n / \varphi \quad \text{or} \quad \frac{\varphi_1, \ldots, \varphi_n}{\varphi} \otimes.$$

A rule $\Gamma / \varphi$ is said to be $L$-admissible if every $L$-unifier of $\Gamma$ is an $L$-unifier of $\varphi$. Note that if $L$ is an algebraizable logic (see [21]) with equivalent quasivariety $Q$ and translations $E$ and $\Delta$, then the rule $\Gamma / \varphi$ is $L$-admissible if and only if the quasiequation $E[\Gamma] \Rightarrow E(\varphi)$ is $Q$-admissible. Now if we define the finite-valued logic $L^* := (F_A(|A|), D^*)$ where $D^* := \{[\varphi] \in F_A(|A|) : \vdash_L$
\[ \varphi \}, \text{then we obtain the following analogue of Theorem 3.9.} \]

**Theorem 3.29.** Let \( L := (A, D) \) be a finite-valued logic for a language \( \mathcal{L} \). Then \( \Gamma / \varphi \) is \( L \)-admissible iff \( \Gamma \vdash L^* \varphi \).

**Proof.** (\( \Rightarrow \)) Suppose that \( \Gamma / \varphi \) is \( L \)-admissible and let \( h : \text{Tm}_L \to F_A(|A|) \) be a homomorphism such that \( h[\Gamma] \subseteq D^* \). We define a map \( \sigma \) that sends each variable \( x \) to a member of the equivalence class \( h(x) \). By the universal mapping property of \( \text{Tm}_L \), this extends to a homomorphism \( \sigma : \text{Tm}_L \to \text{Tm}_L \).

But since \( \nu(\sigma(x)) = h(x) \) for each variable \( x \) (\( \nu \) is the natural homomorphism for the congruence \( \Psi_A(|A|) \)), we obtain \( \nu \circ \sigma = h \). So for each \( \psi \in \Gamma \), we have \( \nu(\sigma(\psi)) \in D^* \) and therefore \( \vdash_L \sigma(\psi) \). Hence by assumption, \( \vdash_L \sigma(\varphi) \), and \( h(\varphi) = \nu(\sigma(\varphi)) \in D^* \) as required.

(\( \Leftarrow \)) Suppose that \( \Gamma \vdash L^* \varphi \) and let \( \sigma : \text{Tm}_L \to \text{Tm}_L \) be a unifier of \( \Gamma \), i.e., \( \vdash_L \sigma(\psi) \) for all \( \psi \in \Gamma \) and hence \( \nu(\sigma(\psi)) \in D^* \). By assumption, \( \nu(\sigma(\varphi)) \in D^* \). Hence \( \vdash_L \sigma(\varphi) \) as required. \( \square \)

The next result may then be understood as an analogue of Theorem 3.11.

**Theorem 3.30.** Let \( L := (A, D_A) \) and \( L' := (B, D_B) \) be finite-valued logics for a language \( \mathcal{L} \) such that \( B \) is a subalgebra of \( F_A(|A|) \), \( D_B = D_A^* \cap B \) and there exists a surjective homomorphism \( h : B \to A \) satisfying \( h[D_B] \subseteq D_A \). Then \( \Gamma / \varphi \) is \( L \)-admissible iff \( \Gamma \vdash_{L'} \varphi \).

**Proof.** If \( \Gamma / \varphi \) is \( L \)-admissible, then by Lemma 3.29, \( \Gamma \vdash_{L'} \varphi \). Since \( B \leq F_A(|A|) \) and \( D_B = D_A^* \cap B \), also \( \Gamma \vdash_{L'} \varphi \). Conversely, suppose that \( \Gamma \vdash_{L'} \varphi \) and that \( \sigma \) is an \( L \)-unifier of \( \Gamma \). Notice that if \( \vdash_L \psi \), then \( \vdash_{L'} \psi \) and \( \vdash_{L'} \psi \). So \( \sigma \) is also an \( L^* \)-unifier and \( L' \)-unifier of \( \Gamma \). But \( \sigma(\Gamma) \vdash_{L'} \sigma(\varphi) \) and therefore \( \vdash_{L'} \sigma(\varphi) \). Now consider any homomorphism \( e : \text{Tm}_L \to A \). Since \( h \) is a surjective homomorphism from \( B \) to \( A \), there exists a homomorphism \( k : A \to B \) such that \( h \circ k \) is the identity map on \( A \). But \( \vdash_{L'} \sigma(\varphi) \) and hence \( k \circ e \circ \sigma(\varphi) \in D_B \). Therefore \( e \circ \sigma(\varphi) = h \circ k \circ e \circ \sigma(\varphi) \in h[D_B] \subseteq D_A \). So \( \vdash_L \sigma(\varphi) \). \( \square \)
Example 3.31. The three-valued Lukasiewicz logic $L_3$ and Jaśkowski logic $J_3$ may both be presented using the three element Wajsberg algebra $L_3$ (Example 3.26) but with 1 as designated value for $L_3$ and $\frac{1}{2}$ and 1 as designated values for $J_3$. That is, $L_3 := (L_3, \{1\})$ and $J_3 := (L_3, \{\frac{1}{2}, 1\})$. In this case, there is a smallest subalgebra of $F_{L_3}(\omega)$ isomorphic to $L_3 \times L_2$ with a surjective homomorphism that maps $L_3 \times L_2$ onto $L_3$ and sends the inherited designated values $(1, 1)$ to 1 and $(\frac{1}{2}, 1)$ to $\frac{1}{2}$. We therefore obtain a logic $(L_3 \times L_2, \{(1, 1)\})$ corresponding to admissibility in $L_3$, and another logic $(L_3 \times L_2, \{(\frac{1}{2}, 1), (1, 1)\})$ corresponding to admissibility in $J_3$.

3.8 Automatically Generated Proof Systems

Here we show how proof systems for admissibility and validity can be generated using the system MUItlog [101]. We first give a brief overview of the most important definitions; please refer to [110] for a detailed introduction.

Let $L := (\text{Alg}, D)$ be an $n$-valued logic for a language $\mathcal{L}$. A sequent $\Gamma$ of $L$ is an $n$-tuple $\Gamma_{a_1} | \ldots | \Gamma_{a_n}$ of finite sequences $\Gamma_{a_i}$ of $\mathcal{L}$-terms, where $\text{Alg} := \{a_1, \ldots, a_n\}$. The $\Gamma_{a_i}$ are called the components of $\Gamma$. Let $h : \text{Tm}_L \rightarrow \text{Alg}$ be a homomorphism (also called an interpretation). $h$ satisfies a sequent $\Gamma$ if there is an $a \in A$ such that $h(\varphi) = a$ for some $\mathcal{L}$-term $\varphi \in \Gamma_a$. In this case, $h$ is called a model of $\Gamma$, written $h \models \Gamma$. $\Gamma$ is called satisfiable if there is an interpretation $h$ such that $h \models \Gamma$ and valid if for every interpretation $h$, $h \models \Gamma$. The sequent calculus $\mathcal{SC}_L$ for the logic $L$ is given by the following rules:

- an axiom for every $\mathcal{L}$-term $\varphi$:

$$\frac{}{\varphi | \ldots | \varphi} ax_\varphi$$

- weakening rules for every truth value $a_k$:

$$\frac{\Gamma_1 | \ldots | \Gamma_n}{\Gamma_1 | \ldots | \Gamma_k, \varphi | \ldots | \Gamma_n} \text{weak}_{a_k}$$
• exchange rules for every truth value $a_k$:

$$
\Gamma_1 | \ldots | \Gamma_k, \varphi, \psi, \Delta_k | \ldots | \Gamma_n \xrightarrow{\text{exch}_{a_k}}
$$

• contraction rules for every truth value $a_k$:

$$
\Gamma_1 | \ldots | \Gamma_k, \varphi | \ldots | \Gamma_n \xrightarrow{\text{cont}_{a_k}}
$$

• cut rules for every two truth values $a_k \neq a_l$:

$$
\Gamma_1 | \ldots | \Gamma_k, \varphi | \ldots | \Gamma_n, \Delta_1 | \ldots | \Delta_l, \varphi | \ldots | \Delta_n \xrightarrow{\text{cut}_{a_k,a_l}}
$$

• an introduction rule$^5$ $*_{a_k}$ for every connective $*$ and truth value $a_k$.

A finite tree $P$ of sequents is called a proof in the sequent calculus $\mathcal{SC}_L$ if every leaf is an axiom of $\mathcal{SC}$, and all other sequents are obtained from their children by applying one of the rules of $\mathcal{SC}$. The sequent at the root of $P$ is called its end-sequent. A sequent $\Gamma$ is called provable in $\mathcal{SC}$, written $\vdash_{\mathcal{SC}} \Gamma$, if it is the end-sequent of some proof in $\mathcal{SC}$. Soundness, completeness and cut-elimination for $\mathcal{SC}$ are proved in [110].

Note that the choice of designated values for the logic $L$ does not affect the structure of the rules of the sequent calculus $\mathcal{SC}$. Also, if we want to check whether an $L$-equation or $L$-quasiequation is valid in $L$, the choice of designated values does not change anything.

Let us now consider the three element algebra $G_3 := \langle \{0, 1, 2\}, * \rangle$ with the binary operation $*$ where $x * y := 2$ when $x = 2$ and $y \in \{1, 2\}$, $x * y := 0$ otherwise (see also Appendix A). We input this information to the tool MUltlog (see Figure 3.3) which then outputs, amongst many other things, the introduction rules for the operation $*$ (see Figure 3.4). Intuitively, the

---

$^5$We leave out a proper explanation of the construction of these logical rules here, but will present the concrete introduction rules in the upcoming examples.
logic "G9".
truth_values { 0 , 1 , 2 }.
designated_truth_values { 2 }.
operator( ast/2, table [
    0, 1, 2,
    0, 0, 0, 0,
    1, 0, 0, 0,
    2, 0, 2, 2
] ) .

Figure 3.3: Input file G9.lgc for the system MUltlog.

rule $*_{0}$ of Figure 3.4 expresses the fact that $\varphi * \psi$ takes value 0 under some interpretation $h: \text{TM}_{G} \rightarrow G_{9}$ whenever $h(\varphi) = 0$ or $h(\psi) = 0$ or $h(\varphi) = 1$. I.e., the stroke "|" denotes "or" between different values of the underlying logic while the comma "," denotes "or" between different formulas of the sequents. Together with the structural rules explained above they build the proof system $\mathcal{SC}_{G_{9}}$ to check validity in $G_{9}$.

\[
\frac{\Gamma_{1}, \varphi, \psi \mid \Gamma_{2}, \varphi \mid \Gamma_{3}}{\Gamma_{1}, \varphi * \psi \mid \Gamma_{2} \mid \Gamma_{3}} *_{0}
\]

\[
\frac{\Gamma_{1} \mid \Gamma_{2} \mid \Gamma_{3}}{\Gamma_{1} \mid \Gamma_{2} \mid \Gamma_{3}, \varphi \mid \varphi * \psi} *_{1}
\]

\[
\frac{\Gamma_{1} \mid \Gamma_{2}, \psi \mid \Gamma_{3}, \psi \mid \Gamma_{1} \mid \Gamma_{2} \mid \Gamma_{3}, \varphi}{\Gamma_{1} \mid \Gamma_{2} \mid \Gamma_{3}, \varphi * \psi} *_{2}
\]

Figure 3.4: The introduction rules for the operation $*$ of $G_{9}$.

Using the tool MUltseq (see [47]), the companion of MUltlog, we can check whether the following quasiequation holds in $G_{9}$ (we write $x^2$ to denote $(x * x)$ for convenience):

\[
x^2 \approx y * x^2, \quad x * y \approx y * x^2, \quad y * x \approx y^2 \quad \Rightarrow \quad y * x \approx y * x^2. \quad (3.1)
\]

The output of MUltseq tells us that proving (3.1) is equivalent to proving
the following sequents\(^6\), which is not possible and hence (3.1) does not hold in \(G_9\). MUltseq even provides a counterexample: \(x = 1, y = 2\).

\[
\begin{align*}
  y \ast x, &\quad y^2 \mid x^2, \; x \ast y, \; y \ast x^2 \mid x^2, \; x \ast y, \; y \ast x, \; y \ast x^2 \\
  y \ast x, &\quad y^2 \mid x^2, \; x \ast y, \; y \ast x, y^2, \; y \ast x^2 \mid x^2, \; x \ast y, \; y \ast x^2 \\
  x^2, &\quad x \ast y, \; y \ast x^2 \mid y \ast x, \; y^2 \mid x^2, \; x \ast y, \; y \ast x, \; y \ast x^2 \\
  x^2, &\quad x \ast y, \; y \ast x, y^2, \; y \ast x^2 \mid y \ast x, \; y \ast x^2, \; y \ast x \mid y \ast x, \; y \ast x^2, \; y \ast x \mid y \ast x, \; y \ast x^2
\end{align*}
\]

Using TAFA (see Chapter 5) we calculate the minimal generating free algebra for \(Q(F_{G_9}(\omega))\) which has two generators and seven elements. Calculating \(\text{MINGENSET}(F_{G_9}(2))\) returns \(\text{AdmG}_9 := \langle \{a, b, c, d\}, \ast \rangle\) with

<table>
<thead>
<tr>
<th>*</th>
<th>a</th>
<th>b</th>
<th>c</th>
<th>d</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>c</td>
<td>d</td>
<td>c</td>
<td>d</td>
</tr>
<tr>
<td>b</td>
<td>b</td>
<td>b</td>
<td>d</td>
<td>d</td>
</tr>
<tr>
<td>c</td>
<td>c</td>
<td>d</td>
<td>c</td>
<td>d</td>
</tr>
<tr>
<td>d</td>
<td>d</td>
<td>d</td>
<td>d</td>
<td>d</td>
</tr>
</tbody>
</table>

MUltlog then calculates the introduction rules for the operation \(\ast\) of the algebra \(\text{AdmG}_9\) (see Figure 3.5). Running MUltseq with the input for \(\text{AdmG}_9\) (see Figure 3.6) confirms that the quasiequation (3.1) is provable in \(SC_{\text{AdmG}_9}\) and hence is \(G_9\)-admissible. It is also possible to output proof trees of specific sequents. In this case (here with one out of twelve sequents to check for the proof of (3.1)) MUltseq then also outputs a skeleton of the proof as follows\(^7\) ((\(\varphi\)^\(a_i\) means that the term \(\varphi\) stands in the \(i\)-th position of the sequent):

Proof skeleton of \([(x \ast x)^a, (x \ast x)^c, (x \ast x)^d, (x \ast y)^a, (x \ast y)^c, (x \ast y)^d, (y \ast

---

\(^6\)It is not hard to see that checking the validity of an equation \(\varphi \approx \psi\) for, e.g., a three-valued algebra, is equivalent to checking the validity of the three sequents \(\varphi \mid \psi \mid \psi\), \(\psi \mid \varphi \mid \psi\) and \(\psi \mid \psi \mid \varphi\). This idea is then extended combinatorially to quasiequations.

\(^7\)The right upper side of the proof tree (which is obviously equal to the left part) is abbreviated here because of the space.
Table of sequents:

1. \([ (x * x)^a, (x * x)^c, (x * x)^d, (x * y)^a, (x * y)^c, (x * y)^d, (y * x)^a, (y * x)^b, (y * x)^c, (y * y)^a, (y * y)^b, (y * y)^c, (y * (x * x))^a, (y * (x * x))^b, (y * (x * x))^c, (y * (x * x))^d] \)

2. \([ (x * x)^c, (x * x)^d, (x * y)^a, (x * y)^c, (x * y)^d, (y * x)^a, (y * x)^b, (y * x)^c, (y * y)^a, (y * y)^b, (y * y)^c, (y * (x * x))^a, (y * (x * x))^b, (y * (x * x))^c, (y * (x * x))^d] \)

3. \([ x^a, x^c, (x * x)^d, (x * y)^a, (x * y)^c, (x * y)^d, (y * x)^a, (y * x)^b, (y * x)^c, (y * y)^a, (y * y)^b, (y * y)^c, (y * (x * x))^a, (y * (x * x))^b, (y * (x * x))^c, (y * (x * x))^d] \)

\(^8\)Note that we can apply axiom rules to the leaves of the proof tree, e.g., \(ax \) to no. 4.
% admgnine - specification of a sequent calculus for AdmG9

option(tex_rulenames(on)).
truth_values([a,b,c,d]).
designated_truth_values([d]).

% Definition of the operation ast.
tex_op((A*B), ["(" , A , bslash , "ast " , B , ")")]).
rule((A*B)^a, [[]], asta).
rule((A*B)^b, [[B^a,B^b],[A^b]], astb).
rule((A*B)^c, [[B^a,B^c],[A^a,A^c]], astc).
rule((A*B)^d, [[A^b,A^d,B^b,B^d],[A^a,A^c,A^d,B^c,B^d]], astd).
tex_rn(asta, ["{", bslash, "ast_a}"]).
tex_rn(astb, ["{", bslash, "ast_b}"]).
tex_rn(astc, ["{", bslash, "ast_c}"]).
tex_rn(astd, ["{", bslash, "ast_d}"]).

% Test the derivability of a sequent
ts(s1, [(a*a)^a,(a*a)^c,(a*a)^d,(a*b)^a,(a*b)^c,(a*b)^d,
        (b*a)^a,(b*a)^b,(b*a)^c,(b*(a*a))^a,(b*(a*a))^c,(b*(a*a))^d]).

% Test the validity of a quasiequation
tqe(qe1, [a*a=b*(a*a),a*b=b*(a*a),b*a=b*(a*a), b*a=b*(a*a)).
tex_opname(a, ["x"]).
tex_opname(b, ["y"]).

Figure 3.6: Input file admgnine.lgc for the system MUltseq.
4. \([x^a, x^b, x^c, x^d, (x*y)^a, (x*y)^c, (x*y)^{d}, (y*x)^a, (y*x)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

5. \([x^a, x^b, x^c, x^d, (x*y)^a, (x*y)^c, (x*y)^{d}, (y*x)^a, (y*x)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

6. \([x^a, x^b, x^c, x^d, (x*y)^a, (x*y)^c, (x*y)^{d}, (y*x)^a, (y*x)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

7. \([x^a, x^b, x^c, x^d, y^a, y^c, (x*y)^a, (x*y)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

8. \([x^a, x^b, x^c, x^d, y^a, y^b, y^c, y^d, (y*x)^a, (y*x)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

9. \([x^a, x^b, x^c, x^d, y^a, y^c, y^d, (y*x)^a, (y*x)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

10. \([x^a, x^b, x^c, x^d, y^a, y^c, (x*y)^a, (x*y)^b, (y*x)^b, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

11. \([x^a, x^b, x^c, x^d, y^a, y^b, y^d, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

12. \([x^a, x^b, x^c, x^d, y^a, y^b, y^d, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

13. \([x^a, x^b, x^c, x^d, (x*y)^a, (x*y)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

14. \([x^a, x^b, x^c, x^d, y^a, y^b, y^d, (y*x)^a, (y*x)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

15. \([x^a, x^b, x^c, y^a, y^d, (y*x)^a, (y*x)^b, (y*x)^c, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)

16. \([x^a, x^b, y^a, y^d, (y*x)^a, (y*y)^a, (y*y)^b, (y*y)^c, (y*(x*x))^a, (y*(x*x))^c, (y*(x*x))^d]\)
17. \([x^a, x^b, x^c, x^d, y^c, y^d, (y \ast x)^c, (y \ast y)^a, (y \ast y)^b, (y \ast y)^c, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)

18. \([x^a, x^c, x^d, y^b, y^d, (y \ast x)^c, (y \ast y)^a, (y \ast y)^b, (y \ast y)^c, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)

19. \([x^a, x^c, x^d, y^b, y^d, (y \ast y)^a, (y \ast y)^b, (y \ast y)^c, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)

20. \([x^a, x^c, x^d, y^b, y^d, (y \ast y)^b, (y \ast y)^c, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)

21. \([x^a, x^c, x^d, y^b, y^d, (y \ast y)^c, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)

22. \([x^a, x^c, x^d, y^b, y^d, (y \ast y)^c, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)

23. \([x^a, x^c, x^d, y^a, y^d, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)

24. \([x^a, x^c, x^d, y^a, y^d, (y \ast y)^a, (y \ast y)^b, (y \ast y)^c, (y \ast (x \ast x))^a, (y \ast (x \ast x))^c, (y \ast (x \ast x))^d]\)
Case Studies

In this chapter, we make use of the methods and theorems of the previous chapter to investigate admissibility for some well-known (classes of) algebras, obtaining new structural completeness, almost structural completeness and axiomatization results. We start with the proof that every two element algebra is structurally complete (Section 4.1). Section 4.2 investigates admissibility for three element algebras with one binary operation. Section 4.3 starts an investigation into admissibility of standard, bounded and pseudo-complemented finite lattices. In Section 4.4 we present bases for admissible quasiequations for De Morgan and Kleene algebras and lattices. Section 4.5 studies reducts of Sugihara monoids and Section 4.6 finally summarizes the obtained results

4.1 Two Element Algebras

In this section we prove that that admissibility in a two element algebra A coincides with validity in this algebra A, i.e., that every two element algebra is structurally complete. We remark that another proof of this fact was given by Rautenberg in [89, Corollary 1] by proving that each two element algebra generates a minimal quasivariety (compare Theorem 3.16).

\footnote{Note that most of the calculations in this chapter were done with TAFA (see Chapter 5).}
Figure 4.1: Possible unary and binary operations on \{0, 1\}.

**Theorem 4.1.** Any two element algebra \( \mathbf{A} \) is structurally complete.

**Proof.** Without loss of generality we assume that \( \mathbf{A} := \langle \{0, 1\}, \mathcal{F} \rangle \). By Corollary 3.18 it suffices to find an embedding \( h: \mathbf{A} \rightarrow \mathcal{F}_\mathbf{A}(\{x_0, x_1\}) \). First notice that there are only four unary and sixteen binary operations on the elements 0 and 1 (see Figure 4.1). Also note that some of the binary operations are not proper binary operations in the sense that they do not depend on both variables as, e.g., \( \text{id}_{x}(x, y) := x \) does not depend on \( y \). We proceed by a case distinction on \( \mathcal{F} \), always trying to find a suitable embedding \( h: \mathbf{A} \rightarrow \mathcal{F}_\mathbf{A}(\{x_0, x_1\}) \). For convenience we write \( \mathcal{F} \) for \( \mathcal{F}_\mathbf{A}(\{x_0, x_1\}) \) and we say that 0 or 1 is definable, if some \( c_i^0 \) or \( c_i^1 \) is definable for \( i \in \mathbb{N} \), respectively.

**Case 1:** \( \mathcal{F} = \emptyset \). Define \( h(0) := [x_0], h(1) := [x_1] \). Obviously this map is injective and it is a homomorphism since there are no operations to be preserved.
Case 2: 0 is definable by $\mathcal{F}$, 1 is not. Assume without loss of generality that $c_0$ defines 0. Define $h(0) := [c_0^0]$, $h(1) := [x_0]$. $h$ is injective so it remains to show that $h(\circ^A(a_1, \ldots, a_n)) = \circ^F(h(a_1), \ldots, h(a_n))$ for every $\circ \in \mathcal{F}$ and $a_i \in \{0, 1\}$. It suffices to show that $h(\circ^A(0, \ldots, 0, 1, \ldots, 1)) = \circ^F(h(0), \ldots, h(0), h(1), \ldots, h(1))$. Note that $\circ^A(0, \ldots, 0, x, \ldots, x)$ cannot be $\neg x$ or 1, since otherwise 1 would be definable. So there are only two cases:

(i) If $\circ^A(0, \ldots, 0, x, \ldots, x) = 0$, then $h(\circ^A(0, \ldots, 0, 1, \ldots, 1)) = h(0) = [c_0^0]$ and $\circ^F(h(0), \ldots, h(0), h(1), \ldots, h(1)) = [c_0^0]$.

(ii) If $\circ^A(0, \ldots, 0, x, \ldots, x) = x$, then $h(\circ^A(0, \ldots, 0, 1, \ldots, 1)) = h(1) = [x_0]$ and $\circ^F(h(0), \ldots, h(0), h(1), \ldots, h(1)) = [x_0]$.

Case 3: 1 is definable by $\mathcal{F}$, 0 is not. Very similar to the preceding case.

Case 4: Both 0 and 1 are definable by $\mathcal{F}$. Assume without loss of generality that $c_0$ defines 0 and $c_1$ defines 1. The map defined by $h(0) := [c_0^0]$ and $h(1) := [c_1^0]$ is certainly injective and preserves every operation $\circ$ of $\mathcal{F}$.

Case 5: $\mathcal{F} \neq \emptyset$ only contains unary and binary operations, but 0 and 1 are not definable by $\mathcal{F}$. Since $\mathcal{F}$ only contains unary or binary operations, all the possible operations on $A$ are listed in Figure 4.1. But the following operations cannot be in $\mathcal{F}$ since they define 0 or 1: $c_0^1$, $c_1^1$, $c_0^2$, $c_1^2$, $\leftarrow$, $\rightarrow$, $\leftrightarrow$, $\nleftrightarrow$, $\downarrow$ and $\uparrow$, as e.g., $(x \uparrow x) \uparrow x = 1$. We also do not need to consider binary operations depending only on one variable $(c_0^2, c_1^2, \text{id}_x, \text{id}_y, \neg x, \neg y)$ since they are preserved by any homomorphism preserving the unary operations. Since id is compatible with every operation, we only have to consider cases where $\mathcal{F}$ contains $\neg$, $\land$ or $\lor$. Note that $\neg$ cannot occur together with $\land$ or $\lor$, since then 0 and 1 would be definable (e.g., $\neg x \land x = 0$).

(i) $\mathcal{F} = \{\neg\}$: Define $h(0) := [x_0]$, $h(1) := [\neg x_0]$. This map is injective and $h(\neg^A x) = \neg^F h(x)$ since $h(\neg^A 0) = h(1) = [\neg x_0] = \neg^F [x_0] = \neg^F h(0)$ and $h(\neg^A 1) = h(0) = [x_0] = \neg^F [\neg x_0] = \neg^F h(1)$.

(ii) $\mathcal{F} = \{\land\}$: Let $h(0) := [x_0 \land x_1]$, $h(1) := [x_0]$. This map is injective. Also
- $h(0 \land A_0) = h(0) = [x_0 \land x_1] = [x_0 \land x_1] \land ^F [x_0 \land x_1] = h(0) \land ^F h(0)$.

- $h(0 \land A_1) = h(0) = [x_0 \land x_1] = [x_0 \land x_1] \land ^F [x_0] = h(0) \land ^F h(1)$.

- $h(1 \land A_0) = h(0) = [x_0 \land x_1] = [x_0] \land ^F [x_0 \land x_1] = h(1) \land ^F h(0)$.

- $h(1 \land A_1) = h(1) = [x_0] = [x_0] \land ^F [x_0] = h(1) \land ^F h(1)$.

(iii) $F = \{\lor\}$: Dual to the previous case with $h(0) := [x_0]$ and $h(1) := [x_0 \lor x_1]$.

(iv) $F = \{\land, \lor\}$: The map defined by $h(0) := [x_0 \land x_1]$ and $h(1) := [x_0 \lor x_1]$ is injective and (the preservation of $\lor$ is shown dually)

$$- h(0 \land A_0) = h(0) = [x_0 \land x_1] = [x_0 \land x_1] \land ^F [x_0 \land x_1] = h(0) \land ^F h(0).$$

$$- h(0 \land A_1) = h(0) = [x_0 \land x_1] = [x_0 \land x_1] \land ^F [x_0 \lor x_1] = h(0) \land ^F h(1).$$

$$- h(1 \land A_0) = h(0) = [x_0 \land x_1] = [x_0 \lor x_1] \land ^F [x_0 \land x_1] = h(1) \land ^F h(0).$$

$$- h(1 \land A_1) = h(1) = [x_0 \lor x_1] = [x_0 \lor x_1] \land ^F [x_0 \lor x_1] = h(1) \land ^F h(1).$$

Case 6: $F \neq \emptyset$ and $F$ contains operations with arity greater than two, but 0 and 1 are not definable by $F$. Let $G$ be the set of all unary and binary operations obtained by using at most two different parameters of operations in $F$. A ternary operation $\odot \in F$, for example, produces $\{\odot_{xxx}, \odot_{xx,y}, \odot_{x,y}, \odot_{yxx}\} \subseteq G$, where, e.g., $\odot_{x,y}(x,y) := \odot(x,x,y)$. By assumption $G$ fits into (i)–(iv) of the previous case. Define the appropriate embedding $h$ from $\langle A,G \rangle$ into $\langle F,G \rangle$. Indeed, this also embeds $A$ into $F$. Since $A$ has only two elements, it suffices to prove that for an arbitrary $n$-ary operation symbol $\odot \in F$

$$h(\odot^A(x_0,\ldots,x_0,x_1,\ldots,x_1)) = \odot^F(h(x_0),\ldots,h(x_0),h(x_1),\ldots,h(x_1)).$$

But by the definition of $G$ there is a binary $g \in G$ such that $g^{A,G}(x_0,x_1) = \odot^A(x_0,\ldots,x_0,x_1,\ldots,x_1)$, so $h(\odot^A(x_0,\ldots,x_0,x_1,\ldots,x_1)) = h(g^{A,G}(x_0,x_1))$.

With the fact that $h$ embeds $\langle A,G \rangle$ into $\langle F,G \rangle$ we get $h(g^{A,G}(x_0,x_1)) = g^{F,G}(h(x_0),h(x_1)) = \odot^F(h(x_0),\ldots,h(x_0),h(x_1),\ldots,h(x_1))$ as required.
4.2 Three Element Groupoids

An algebra $G$ having exactly one binary operation $\star$ is called a groupoid. The goal of the present section is to investigate the minimal generating sets of the quasivarieties $Q(F_G(\omega))$ for all three element groupoids $G := \langle\{0, 1, 2\}, \star\rangle$ (see also [16]). Using Theorems 3.23 and 3.27 we also check which groupoids are (almost) structurally complete. Furthermore we calculate the size of the smallest subalgebra of the free algebra $F_G(3)$ suitable for checking unifiability in the quasivariety generated by the groupoid $G$ (see Theorem 3.7).

There are 3330 different groupoids up to isomorphism (out of $3^9 = 19683$ in total) which build 411 classes of clone equivalent algebras. By Theorem 3.28 it suffices to calculate the mentioned properties just once for each clone equivalence class. The full list of the results obtained can be found in Appendix A.

Figure 4.2 gives a rough idea of the distribution of the cardinalities of the minimal generating free algebras of all clone equivalence classes. The number of generators is not always the same to produce a free algebra of a given cardinality and there are even sixteen cases where three generators are needed.

The main goal was to calculate the smallest set of algebras to check admissibility for all groupoids $G$, namely the results of $\text{MINGenSet}(\{F_G(3)\})$ (see...
Figure 4.3: Cardinalities of \( \text{MINGenSet}(\{F_G(3)\}) \) (x-axis) and the number of corresponding clone equivalence classes (logarithmic scaled y-axis).

Section 3.1). For free algebras with less than 25 elements we performed \( \text{MINGenSet} \) directly, for the larger cases we used \( \text{ADMALGS} \) (see Section 3.3). The algebras of the minimal generating sets all have fewer than ten elements. Figure 4.3 lists the multisets of cardinalities of the minimal generating sets and for how many clone equivalence class they occur.

Performing the completeness checks to representatives of the groupoid clone equivalence classes confirmed that 107 of the investigated algebras are not structurally complete, of which 31 are almost structurally complete. The remaining 304 groupoids are structurally complete.

Finally, the checks for unifiability showed that for most groupoids unification is trivial: 344 of the groupoids have a one element algebra as subalgebra of the free algebra \( F_G(\omega) \). For the remaining free algebras the smallest subalgebras had two (fifty-seven cases), three (eight cases) or four elements (two cases).

### 4.3 Lattices

In this section we begin an investigation into admissibility in finite lattices. For small lattices up to five elements we easily confirm structural complete-
ness with TAF\textsuperscript{2}, i.e., validity and admissibility coincide for the quasivarieties generated by these lattices. For some lattices, structural completeness also follows from well-known theorems:

**Example 4.2.** A modular lattice \( L \) may be characterized as a lattice satisfying the equation \((x \land y) \lor (y \land z) \approx y \land ((x \land y) \lor z)\). Famously, a lattice \( L \) is non-modular if and only if the lattice \( L_5 \) (often called \( N_5 \)) displayed in Table 4.1 embeds into \( L \) (see [25, Theorem I.3.5]). But since \( L_5 \) is non-modular, also \( F_{L_5}(\omega) \) (which must satisfy the same equations) is non-modular. So \( L_5 \) embeds into \( F_{L_5}(\omega) \), hence \( L_5 \) is structurally complete. Similarly, it is well-known that a lattice \( L \) is distributive if and only if neither \( L_5 \) nor \( L_4 \) (often called \( M_5 \)), also displayed in Table 4.1, embeds into \( L \) (see [25, Theorem I.3.6]). Since \( L_4 \) is non-distributive and modular, also \( F_{L_4}(\omega) \) is non-distributive and modular. So \( L_4 \) embeds into \( F_{L_4}(\omega) \), and \( L_4 \) is structurally complete.

Note that bounded lattices (see Section 2.3), obtained from lattices by just adding the constants \( \perp \) and \( \top \) to the language \( \mathcal{L} := \{\land, \lor\} \), are not structurally complete in general:

**Theorem 4.3.** The smallest bounded lattice which is not structurally complete has five elements.

**Proof.** TAF\textsuperscript{2} provides embeddings from the bounded lattices with up to four elements into the corresponding free algebras, so these lattices are structurally complete by Corollary 3.18. Let \( L^b \) be the five element bounded lattice with the universe of \( L_4 \) (see Table 4.1), i.e., \( L^b := \langle L_4, \land, \lor, \perp, \top \rangle \). TAF\textsuperscript{2} confirms that \( \text{MINGENSET}(L^b) = \{L^b\} \) and that there is no embedding from \( L^b \) into \( F_{L_5}(3) \), the minimal generating free algebra for \( Q(F_{L_5}(\omega)) \). Hence \( L^b \) is not structurally complete by Corollary 3.24. An example of a quasiequation that is admissible but not valid in \( L^b \) is

\[
x \lor y \approx \top, \quad x \land z \approx \perp, \quad y \land z \approx \perp \quad \Rightarrow \quad z \approx \perp.
\]

\(^{2}\text{A list of all (non-trivial) lattices up to size seven can be found on http://math.chapman.edu/~jipsen/posets/lattices77.html.}\)
We were unable to check structural completeness for all six element lattices since the free algebras for the lattices $L_9$ and $L_{10}$ are too big for TAFA (e.g., the algebra $F_{L_9}(4)$ has 56694 elements). For all other lattices with up to six elements (see Table 4.1) TAFA confirms structural completeness. To our knowledge it is still an open question whether all finite lattices are structurally complete. However, the variety of all lattices is not structurally complete, since every free lattice satisfies the semi-distributivity laws (see Example 3.10), but there are lattices which are not semi-distributive, e.g., $L_4$ (see also [106, 80]).

We now consider a special class of distributive lattices extended not only with $\top$ and $\bot$, but also a unary operation $^*$. A pseudocomplemented distributive lattice ($PCL$ for short) is an algebra $L := \langle L, \wedge, \vee, ^*, \bot, \top \rangle$ such that $\langle L, \wedge, \vee, \bot, \top \rangle$ is a distributive bounded lattice and the unary operation $^*$ is pseudocomplementation, i.e.,

$$x \wedge y = \bot \text{ iff } y \leq x^*.$$ 

It is known that the class of PCLs is a variety (see [90]) and that the subdirectly irreducible pseudocomplemented distributive lattices are exactly (up to isomorphism) Boolean algebras extended with an extra top element corresponding to the constant $\top$ where the negation is adapted such that both $\neg \bot = \top$ and $\neg \top = \bot$ hold ([67, Theorem 2]).

We have considered here the first five subdirectly irreducible PCLs, depicted in Figure 4.4. Note that $PCL_0$, the smallest non-trivial PCL, is just the two element Boolean algebra. The cardinalities of the minimal generating free algebras and the minimal generating sets (column “M”) are listed in Table 4.2. The algebra $PCL_1$ generates the variety of Stone algebras (see, e.g., [52]), which is structurally complete. $PCL_2$ is also structurally complete, but not $PCL_3$ or $PCL_4$.  

70
Table 4.1: Lattices with up to six elements.

<table>
<thead>
<tr>
<th>MinGenSet(L)</th>
<th>Lattices</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$L_4$</td>
</tr>
<tr>
<td></td>
<td>$L_5$</td>
</tr>
<tr>
<td></td>
<td>$L_6$</td>
</tr>
<tr>
<td></td>
<td>$L_7$</td>
</tr>
<tr>
<td></td>
<td>$L_{17}$</td>
</tr>
<tr>
<td></td>
<td>$L_{18}$</td>
</tr>
<tr>
<td></td>
<td>$L_{21}$</td>
</tr>
<tr>
<td></td>
<td>$L_{22}$</td>
</tr>
<tr>
<td></td>
<td>$L_{23}$</td>
</tr>
<tr>
<td></td>
<td>$L_9$</td>
</tr>
<tr>
<td></td>
<td>$L_{10}$</td>
</tr>
<tr>
<td></td>
<td>$L_{11}$</td>
</tr>
<tr>
<td></td>
<td>$L_{12}$</td>
</tr>
<tr>
<td></td>
<td>$L_{13}$</td>
</tr>
</tbody>
</table>
Table 4.2: Admissibility for PCLs.

| Lattice | Cardinality | Free algebra $|F_{PCL\alpha}(\beta)|$ | $M$ |
|---------|-------------|----------------------------------|-----|
| PCL$_0$ | $2^0 + 1 = 2$ | $|F_{PCL\alpha}(0)| = 2$ | 2   |
| PCL$_1$ | $2^1 + 1 = 3$ | $|F_{PCL\alpha}(1)| = 6$ | 3   |
| PCL$_2$ | $2^2 + 1 = 5$ | $|F_{PCL\alpha}(1)| = 7$ | 5   |
| PCL$_3$ | $2^3 + 1 = 9$ | $|F_{PCL\alpha}(2)| = 625$ | 19  |
| PCL$_4$ | $2^4 + 1 = 17$ | $|F_{PCL\alpha}(2)| = 626$ | 167$^3$ |

4.4 De Morgan and Kleene Algebras

This section provides bases for the admissible quasiequations of the classes of Kleene lattices $KL$, Kleene algebras $KA$, De Morgan lattices $DML$ and De Morgan algebras $DMA$, mainly making use of Theorems 3.17 and 3.21.

Recall from Example 3.8 that De Morgan algebras are defined as algebras $\langle A, \land, \lor, \neg, \bot, \top \rangle$ such that $\langle A, \land, \lor, \bot, \top \rangle$ is a bounded distributive lattice satisfying the De Morgan laws and $\neg$ is an involutive negation. The class $DMA$ of De Morgan algebras forms a variety containing just two proper non-trivial subvarieties: the class $KA$ of Kleene algebras satisfying $x \land \neg x \leq y \lor \neg y$ and the class $BA$ of Boolean algebras satisfying $x \leq y \lor \neg y$ (see [65]), where $x \leq y$ stands for $x \land y \approx y$. The classes $DML$, $KL$ and $BL$ of De Morgan, Kleene and Boolean lattices are defined analogously by omitting the

---

$^3$We have found a subalgebra of $F_{PCL_4}(2)$ with 167 elements which is a prehomomorphic image of $PCL_4$, but we were not able to confirm that this is the smallest subalgebra with this property. Also, for the procedure MinGenSet this algebra is too big.
constants ⊥ and ⊤ from the language. We define \( L_{DMA} := \{\land, \lor, \neg, \bot, \top\} \), \( L_{DML} := L_{DMA} \setminus \{\bot, \top\} \) and write \( A^\ell \) to denote the \( L_{DML} \)-reduct of a De Morgan algebra \( A \). Moreover, we define the following finite members of \( KA \) for \( 1 \leq m \in \mathbb{N} \), with operations \( x \land y := \min\{x, y\} \), \( x \lor y := \max\{x, y\} \), \( \neg x := -x \), \( \bot := -m \) and \( \top := m \):

\[
C_{2m} := \langle \{-m, -m + 1, \ldots, -1, 1, \ldots, m - 1, m\}, \land, \lor, \neg, \bot, \top \rangle \\
C_{2m+1} := \langle \{-m, -m + 1, \ldots, -1, 0, 1, \ldots, m - 1, m\}, \land, \lor, \neg, \bot, \top \rangle.
\]

The “fuzzy algebra” \( \langle [0, 1], \min, \max, 1 - x, 0, 1 \rangle \) and also each \( C_n \) for any \( n \) odd \( n \geq 3 \), generates \( KA \) as a quasivariety. In particular, \( KA = Q(C_3) \) (see, e.g. \([65, 88]\)). Now consider the quasiequation

\[
x \approx \neg x \Rightarrow x \approx y.
\]

(4.1) is not \( C_3 \)-valid: just consider the homomorphism \( h: Tm_{L_{DMA}}(x, y) \to C_3 \) defined by \( h(x) := 0 \) and \( h(y) := 1 \). But there is no term \( \varphi \) such that \( \varphi \approx \neg \varphi \) holds in all Kleene algebras (or indeed, in all Boolean algebras). So the quasiequation (4.1) is admissible and by Theorem 3.16, \( KA \) is not structurally complete. However, the proper subquasivariety of \( KA \) generated by \( C_n \) for any \( n \) even \( \geq 4 \) is structurally complete. In particular, using Corollary 3.18 we can show that \( C_4 \) is structurally complete with the map \( g^{C_4}: C_4 \to Tm_{L_{DMA}} \) defined by

\[
2 \mapsto \top \\
1 \mapsto x \lor \neg x \\
-1 \mapsto x \land \neg x \\
-2 \mapsto \bot.
\]

**Lemma 4.4.** \( Q(C_4) \) is axiomatized relative to \( KA \) by the quasiequation

\[
\neg x \leq x, \ x \land \neg y \leq \neg x \lor y \Rightarrow \neg y \leq y.
\]

(4.2)

**Proof.** Very similar to the proof of \([88], Proposition 4.7\), which states that
Q(C₄) is axiomatized relative to KL by the quasiequation (4.2). □

**Theorem 4.5.** \{\{(4.2)\}\} is a basis for the admissible quasiequations of KA.

**Proof.** Q(C₄) is structurally complete and axiomatized relative to KA by \{\{(4.2)\}\} by Lemma 4.4. Moreover, C₃ is a homomorphic image of C₄, so V(C₄) = V(C₃) = KA. Hence, since (4.2) holds in C₄, it is admissible in KA, and the result follows by Theorem 3.21. □

Note that the quasiequation (4.1) does not provide a basis for the admissible quasiequations of KA. In fact, it axiomatizes the quasivariety Q(C₃ x C₂) relative to KA (see [88], Proposition 4.5). With the same reasoning we also obtain a basis for the admissible quasiequations of KL:

**Lemma 4.6** ([88, Proposition 4.7]). Q(C₄) is axiomatized relative to KL by the quasiequation (4.2).

**Theorem 4.7.** \{\{(4.2)\}\} is a basis for the admissible quasiequations of KL.

**Proof.** Using Corollary 3.18 with the map \(g^{C₄}: C₄ \rightarrow \text{Tm}_{\mathcal{L}_{DML}}\) defined by

\[
egin{align*}
2 & \mapsto (x \lor \neg x) \lor y \\
1 & \mapsto x \lor \neg x \\
-1 & \mapsto x \land \neg x \\
-2 & \mapsto (x \land \neg x) \land y,
\end{align*}
\]

Q(C₄) is structurally complete. By Lemma 4.6, Q(C₄) is axiomatized relative to KL by \{\{(4.2)\}\}. Moreover, C₃ is a homomorphic image of C₄, so V(C₄) = V(C₃) = KL. Hence, since (4.2) holds in C₄, it is admissible in KL, and the result follows by Theorem 3.21. □

We now turn our attention to the classes of De Morgan algebras DMA and De Morgan lattices DML (see Example 3.8 or Figure 4.5), which are generated as quasivarieties by the algebras D₄ and D₄, respectively (see [65]). De Morgan lattices were first studied by Moisil [79] and Kalman [65], and subsequently, with or without the constants \(\bot\) and \(\top\), by many other researchers.
In particular, the quasivariety lattice of De Morgan lattices has been fully characterized by Pynko in [88] (see Figure 4.6), while the more complicated (infinite) quasivariety lattice of De Morgan algebras has been investigated by Gaitán and Perea in [40].

As before, we use an axiomatization lemma and Theorem 3.21 to find a basis for the admissible quasiequations of DML:

**Lemma 4.8** ([88, Proposition 4.2]). \( \mathcal{Q}(D_{42}) \) is axiomatized relative to DML by the quasiequation (4.1).

**Theorem 4.9.** \{ (4.1) \} is a basis for the admissible quasiequations of DML.

*Proof.* By Theorem 3.16 a quasivariety \( \mathcal{Q} \) is structurally complete if every proper subquasivariety of \( \mathcal{Q} \) generates a proper subvariety of \( \mathcal{V}(\mathcal{Q}) \). The only non-trivial varieties of De Morgan lattices are \( BL = \mathcal{Q}(C_2') \), \( KL = \mathcal{Q}(C_3') \) and \( DML = \mathcal{Q}(D_4') \). Hence by inspection of the subquasivariety lattice, the only non-trivial structurally complete subquasivarieties of DML are \( BL = \mathcal{Q}(C_2') \), \( \mathcal{Q}(C_4') \) and \( \mathcal{Q}(D_{42}') \) where \( D_{42} \) is defined as the direct product \( D_4 \times C_2 \) (see Figure 4.5).

By Lemma 4.8, \( \mathcal{Q}(D_{42}') \) is axiomatized relative to DML by \{ (4.1) \}. Moreover, \( D_4' \) is a homomorphic image of \( D_{42}' \) using the first projection homomorphism, so \( \mathcal{V}(D_{42}') = \mathcal{V}(D_4') = DML \). Hence, since (4.1)

4We also easily find an embedding of \( D_{42}' \) into \( F_{D_4}(2) \) using TAFA. Then \( \mathcal{Q}(D_{42}') \) is structurally complete using Corollary 3.18.
holds in $D_{42}^f$, it is admissible in DML, and the result follows by Theorem 3.21. \hfill \Box

The case of De Morgan algebras is more complicated since the lattice of quasivarieties is infinite (see [40, Figure 7]). Unlike the case of DML, the quasiequation (4.1) does not provide a basis for the admissible quasiequations of DMA. It follows from results of Pynko [88] that \{(4.1)\} axiomatizes the quasivariety $Q(D_{42})$ relative to DMA. However, the quasiequation

$$(x \land \neg x) \lor y \approx \top \Rightarrow y \approx \top$$

is admissible in DMA but does not hold in the De Morgan algebra $D_{42}$. So \{(4.1)\} cannot suffice as a basis for the admissible quasiequations of DMA.

Let us consider instead the De Morgan algebra $\overline{D}_{42}$ obtained from $D_{42}$ by adding an extra top element $\top$ and bottom element $\bot$ (see Figure 4.5). Note that $D_4$ is a homomorphic image of $\overline{D}_{42}$ under the composition of $f : \overline{D}_{42} \to D_{42}$, $f(\top) := (\top, 1)$, $f(\bot) := (\bot, 0)$, $f((x, y)) := (x, y)$ for all $(x, y) \not\in \{\bot, \top\}$ and the projection $p_{D_4}^2 : D_{42} \to D_4$. Hence $\forall(Q(D_{42})) = 76$
DMA. TAFA provides an embedding of \( \overline{D}_{42} \) into the free algebra \( F_{\overline{D}_{42}}(\{x, y\}) \) defined by

\[
(\bot, \bot) \mapsto (\varphi \land \psi) \lor (\neg \varphi \land \neg \psi) \quad (T, T) \mapsto (\varphi \lor \psi) \land (\neg \varphi \lor \neg \psi)
\]

\[
(a, \bot) \mapsto (\neg \varphi \land \neg \psi) \lor \varphi \quad (a, T) \mapsto (\varphi \lor \psi) \land \neg \varphi
\]

\[
(b, \bot) \mapsto (\varphi \land \psi) \lor \neg \psi \quad (b, T) \mapsto (\neg \varphi \lor \neg \psi) \land \psi
\]

\[
(T, \bot) \mapsto \varphi \lor \neg \psi \quad (\bot, T) \mapsto \neg \varphi \land \psi,
\]

where \( \varphi := x \land \neg x \) and \( \psi := y \lor \neg y \). Hence \( \overline{D}_{42} \) is structurally complete by Corollary 3.18, so the admissible quasiequations of DMA consist of those quasiequations that hold in \( Q(\overline{D}_{42}) \).

We now present an axiomatization of the admissible quasiequations of De Morgan algebras using also clauses and not only quasiequations. Observe that the following clause holds in \( \overline{D}_{42} \) and hence also in \( F_{DMA} \) using \( V(\overline{D}_{42}) = V(DMA) \), Theorem 2.14 and Corollary 2.16:

\[ x \lor y \approx \top \Rightarrow x \approx \top, y \approx \top. \]  

(4.3)

We define \( DMA^* := \{A \in DMA : A \text{ satisfies (4.1) and (4.3)}\} \). We will show that a quasiequation is admissible in DMA if and only if it is valid in \( DMA^* \). The main idea of the proof is to reduce the question of the admissibility of a quasiequation in DMA to the question of the admissibility of quasiequations in DML. The following lemma will be useful in this respect. For a set of \( L_{DMA} \)-equations, let \( c(\Sigma) \) be the number of occurrences of connectives \( \land, \lor \) and \( \neg \).

**Lemma 4.10.** For any \( \varphi \in Tm_{L_{DMA}} \), one of the following holds:

(i) \( \models_{DMA} \varphi \approx \bot \).

(ii) \( \models_{DMA} \varphi \approx \top \).

(iii) \( \models_{DMA} \varphi \approx \psi \) for some \( \psi \in Tm_{L_{DML}} \) with \( c(\psi) \leq c(\varphi) \).

**Proof.** For an arbitrary \( \varphi \in Tm_{L_{DMA}} \), we proceed by induction on the length of the term: In the base case \( \varphi \) is atomic, i.e., \( \varphi = \bot, \varphi = \top \) or \( \varphi = x \) for
some variable $x$ as required. For the inductive step suppose the assumption holds for $|\varphi| < n$. Then there are three cases:

(i) \( \varphi = \varphi_1 \land \varphi_2 \). Without loss of generality we have the following cases:

- \( \vdash_{\text{DMA}} \varphi_1 \approx \bot \Rightarrow \vdash_{\text{DMA}} \varphi \approx \bot \land \varphi_2 = \bot \).
- \( \vdash_{\text{DMA}} \varphi_1 \approx \top \Rightarrow \vdash_{\text{DMA}} \varphi \approx \top \land \varphi_2 = \varphi_2 \).
- \( \vdash_{\text{DMA}} \varphi_1 \approx \psi_1 \) and \( \vdash_{\text{DMA}} \varphi_2 \approx \psi_2 \) for some \( \psi_1, \psi_2 \in \text{Tm}_{\mathcal{L}_{\text{DMA}}} \) with \( c(\psi_1) \leq c(\varphi_1) \) and \( c(\psi_2) \leq c(\varphi_2) \) \( \Rightarrow \vdash_{\text{DMA}} \varphi \approx \psi_1 \land \psi_2 = \psi \) with \( \psi \in \text{Tm}_{\mathcal{L}_{\text{DMA}}} \) and \( c(\psi) \leq c(\varphi) \).

(ii) \( \varphi = \varphi_1 \lor \varphi_2 \). Dual to the previous case.

(iii) \( \varphi = \neg \varphi_1 \). There are three cases:

- \( \vdash_{\text{DMA}} \varphi_1 \approx \bot \Rightarrow \vdash_{\text{DMA}} \varphi \approx \top \).
- \( \vdash_{\text{DMA}} \varphi_1 \approx \top \Rightarrow \vdash_{\text{DMA}} \varphi \approx \bot \).
- \( \vdash_{\text{DMA}} \varphi_1 \approx \psi_1 \) for some \( \psi_1 \in \text{Tm}_{\mathcal{L}_{\text{DMA}}} \) with \( c(\psi_1) \leq c(\varphi_1) \) \( \Rightarrow \vdash_{\text{DMA}} \varphi \approx \neg \psi_1 = \psi \) with \( \psi \in \text{Tm}_{\mathcal{L}_{\text{DMA}}} \) and \( c(\psi) \leq c(\varphi) \). \( \square \)

Let us say that an \( \mathcal{L}_{\text{DMA}} \)-equation \( \varphi \approx \psi \) is in normal form if \( \varphi \) and \( \psi \) are either \( \bot, \top \) or members of \( \text{Tm}_{\mathcal{L}_{\text{DMA}}} \).

\textbf{Theorem 4.11.} Let \( \Sigma \Rightarrow \varphi \approx \psi \) be an \( \mathcal{L}_{\text{DMA}} \)-quasiequation. Then

\[ \Sigma \Rightarrow \varphi \approx \psi \text{ is admissible in DMA } \iff \Sigma \models_{\text{DMA}^*} \varphi \approx \psi. \]

\textit{Proof.} Suppose first that \( \Sigma \models_{\text{DMA}^*} \varphi \approx \psi \). Both the quasiequation (4.1) and the clause (4.3) hold in \( \mathcal{F}_{\text{DMA}} \), so \( \mathcal{F}_{\text{DMA}} \subseteq \text{DMA}^* \). Hence \( \Sigma \models_{\mathcal{F}_{\text{DMA}}} \varphi \approx \psi \) and by Theorem 3.9, \( \Sigma \Rightarrow \varphi \approx \psi \) is admissible in DMA.

For the other direction, it suffices, using Lemma 4.10 and Theorem 3.9, to prove that for any finite set \( \Sigma \cup \{ \varphi \approx \psi \} \) of \( \mathcal{L}_{\text{DMA}} \)-equations in normal form:

\[ \Sigma \models_{\mathcal{F}_{\text{DMA}}} \varphi \approx \psi \text{ implies } \Sigma \models_{\text{DMA}^*} \varphi \approx \psi. \quad (*) \]
We prove \((\ast)\) by induction on the lexicographically ordered pair \(\langle c(\Sigma), s(\Sigma) \rangle\), where \(s(\Sigma)\) be the number of equations in \(\Sigma\) containing \(\bot\) or \(\top\). The idea is to successively eliminate occurrences of \(\bot\) and \(\top\) in \(\Sigma\) by reducing \(\langle c(\Sigma), s(\Sigma) \rangle\).

**Base case.** Suppose that there are no occurrences of \(\bot\) and \(\top\) in \(\Sigma\), i.e., \(s(\Sigma) = 0\). If \(\varphi = \psi\) or \(\{\varphi, \psi\} \subseteq \{\bot, \top\}\), then we are done. Moreover, if \(\varphi \in \text{Tm}_{\mathcal{L}_{\text{DML}}}\) and \(\psi \in \{\bot, \top\}\), then \(\Sigma \not\models_{\text{F_{DMA}}} \varphi \approx \psi\): just consider a homomorphism from \(\text{Tm}_{\mathcal{L}_{\text{DML}}}\) to \(\mathbf{D}_4\) that maps all the variables to \(a\). Finally, consider \(\varphi, \psi \in \text{Tm}_{\mathcal{L}_{\text{DML}}}\). Suppose that \(\Sigma \models_{\text{F_{DMA}}} \varphi \approx \psi\). By Theorem 3.9, \(\Sigma \Rightarrow \varphi \approx \psi\) is admissible in \(\text{DMA}\). But for any \(\varphi', \psi' \in \text{Tm}_{\mathcal{L}_{\text{DML}}}\), we have \(\models_{\text{DMA}} \varphi' \approx \psi'\) iff \(\models_{\mathbf{D}_4} \varphi' \approx \psi'\) iff \(\models_{\text{DML}} \varphi' \approx \psi'\). So \(\Sigma \Rightarrow \varphi \approx \psi\) is admissible in \(\text{DML}\). Hence by Theorem 4.9, \(\Sigma \Rightarrow \varphi \approx \psi\) holds in \(\mathbb{Q}(\mathbf{D}_{42})\). But every De Morgan algebra in \(\text{DMA}^*\) is also (ignoring \(\bot\) and \(\top\) in the language) a De Morgan lattice in \(\mathbb{Q}(\mathbf{D}_{42})\), so \(\Sigma \models_{\text{DMA}^*} \varphi \approx \psi\).

**Inductive step.** Given the set \(\Sigma\), suppose that \((\ast)\) holds for all \(\Delta\) and \(\langle c(\Delta), s(\Delta) \rangle < \langle c(\Sigma), s(\Sigma) \rangle\). We use \(A \sqcup B\) to denote the *disjoint union* of two sets \(A\) and \(B\), i.e., \(A \cap B = \emptyset\). Consider the following cases:

- \(\Sigma = \Delta \sqcup \{\bot \approx \top\}\). Then \((\ast)\) clearly holds since \(\Sigma \models_{\text{DMA}^*} \varphi \approx \psi\).

- \(\Sigma = \Delta \sqcup \{\chi \approx \chi\}\). Then \(\Sigma \models_{\text{F_{DMA}}} \varphi \approx \psi\) implies \(\Delta \models_{\text{F_{DMA}}} \varphi \approx \psi\) and, by the induction hypothesis, \(\Delta \models_{\text{DMA}^*} \varphi \approx \psi\). So \(\Delta \sqcup \{\chi \approx \chi\} \models_{\text{DMA}^*} \varphi \approx \psi\) as required.

- \(\Sigma = \Delta \sqcup \{\chi_1 \lor \chi_2 \approx \bot\}\). Suppose that \(\Delta \sqcup \{\chi_1 \lor \chi_2 \approx \bot\} \models_{\text{F_{DMA}}} \varphi \approx \psi\). Then also \(\Delta \sqcup \{\chi_1 \approx \bot, \chi_2 \approx \bot\} \models_{\text{F_{DMA}}} \varphi \approx \psi\). So by the induction hypothesis, \(\Delta \sqcup \{\chi_1 \approx \bot, \chi_2 \approx \bot\} \models_{\text{DMA}^*} \varphi \approx \psi\). But then since \(\{\chi_1 \lor \chi_2 \approx \bot\} \models_{\text{DMA}^*} \chi_i \approx \bot\) for \(i = 1, 2\), we obtain \(\Delta \sqcup \{\chi_1 \lor \chi_2 \approx \bot\} \models_{\text{DMA}^*} \varphi \approx \psi\) as required.

- \(\Sigma = \Delta \sqcup \{\chi_1 \lor \chi_2 \approx \top\}\). Suppose that \(\Delta \sqcup \{\chi_1 \lor \chi_2 \approx \top\} \models_{\text{F_{DMA}}} \varphi \approx \psi\). Then \(\Delta \sqcup \{\chi_i \approx \top\} \models_{\text{F_{DMA}}} \varphi \approx \psi\) for \(i = 1, 2\). So by the induction hypothesis, \(\Delta \sqcup \{\chi_i \approx \top\} \models_{\text{DMA}^*} \varphi \approx \psi\) for \(i = 1, 2\). But now, since \((4.3)\) holds in every algebra in \(\text{DMA}^*\), we have \(\Delta \sqcup \{\chi_1 \lor \chi_2 \approx \top\} \models_{\text{DMA}^*} \varphi \approx \psi\) as required.

79
• \( \Sigma = \Delta \cup \{ \neg \chi \approx \top \} \). Suppose that \( \Delta \cup \{ \neg \chi \approx \top \} \vdash_{\text{DMA}} \varphi \approx \psi \). Then \( \Delta \cup \{ \chi \approx \bot \} \vdash_{\text{DMA}} \varphi \approx \psi \), so by the induction hypothesis, \( \Delta \cup \{ \chi \approx \bot \} \vdash_{\text{DMA}} \varphi \approx \psi \). But then also \( \Delta \cup \{ \neg \chi \approx \top \} \vdash_{\text{DMA}} \varphi \approx \psi \) as required.

• \( \Sigma = \Delta \cup \{ x \approx \top \} \). Suppose that \( \Delta \cup \{ x \approx \top \} \vdash_{\text{DMA}} \varphi \approx \psi \). Let \( \Delta' \) and \( \varphi' \approx \psi' \) be the result of substituting every occurrence of \( \top \) for \( x \) in \( \Delta \) and \( \varphi \approx \psi \), respectively. Then \( \Delta' \vdash_{\text{DMA}} \varphi' \approx \psi' \). Notice that \( c(\Delta') = c(\Sigma) \) and \( s(\Delta') < s(\Sigma) \). By Lemma 4.10, we can find equations \( \Delta^* \) and \( \varphi^* \approx \psi^* \) in normal form such that

(a) \( \Delta^* \vdash_{\text{DMA}} \varphi^* \approx \psi^* \).

(b) \( c(\Delta^*) \leq c(\Delta') \) and \( s(\Delta^*) = s(\Delta') \).

(c) \( \Delta^* \vdash_{\text{DMA}} \varphi^* \approx \psi^* \) implies \( \Delta \cup \{ x \approx \top \} \vdash_{\text{DMA}} \varphi \approx \psi \).

By the induction hypothesis, using 1. and 2., \( \Delta^* \vdash_{\text{DMA}} \varphi^* \approx \psi^* \). But then also by 3., \( \Delta \cup \{ x \approx \top \} \vdash_{\text{DMA}} \varphi \approx \psi \) as required.

• The cases \( \Sigma = \Delta \cup \{ \chi_1 \land \chi_2 \approx \bot \} \), \( \Sigma = \Delta \cup \{ \chi_1 \land \chi_2 \approx \top \} \), \( \Sigma = \Delta \cup \{ \neg \chi \approx \bot \} \) and \( \Sigma = \Delta \cup \{ x \approx \bot \} \) are treated symmetrically to the preceding cases. \( \square \)

We close this section by remarking that Cabrer and Metcalfe (see [26, Theorem 30]) have recently used natural dualities to show that the following quasi-equations (4.4) and (4.5) provide a basis for the admissible quasi-equations of DMA:

\[
\begin{align*}
x \leq \neg x, & \quad \neg(x \lor y) \leq x \lor y, \quad \neg y \lor z \approx \top \quad \Rightarrow \quad z \approx \top \quad (4.4) \\
x \leq \neg x, & \quad y \leq \neg y, \quad x \land y \approx \bot \quad \Rightarrow \quad x \lor y \leq \neg(x \lor y) \quad (4.5)
\end{align*}
\]
4.5 Reducts of Sugihara Monoids

In this section we consider (reducts of) Sugihara monoids, members of the variety generated by the algebras \( \{ Z_{e}^{2m} : m \geq 1 \} \), where

\[
Z_{2m}^{e} := \langle \{-m, -m+1, \ldots, -1, 1, \ldots, m-1, m\}, \land, \lor, \rightarrow, \neg, e \rangle
\]

with \( \land \) and \( \lor \) as min and max, respectively, \( \neg x := -x \), \( x \rightarrow y := \neg x \lor y \) if \( x \leq y \) and \( \neg x \land y \) otherwise, and \( e := 1 \) (see [35]). We also define the algebras

\[
Z^{e} := \langle Z, \land, \lor, \rightarrow, \neg, e \rangle \quad \text{and} \quad Z_{2m+1}^{e} := \langle \{-m, -m+1, \ldots, -1, 0, 1, \ldots, m-1, m\}, \land, \lor, \rightarrow, \neg, e \rangle,
\]

with the same definitions of the operations except that the constant \( e \) has value 0. For any \( L \)-reduct of a Sugihara monoid \( A \) we write \( A^L \), except that we delete the set \( \{ \land, \lor, \rightarrow, \neg \} \) from the superscript for convenience. The variety of Sugihara algebras \( V(Z) \) builds the algebraic semantics (see [21]) for the relevant logic \( R \)-mingle \( RM \), i.e., for a set of terms \( \Gamma \cup \{ \varphi \} \), \( \Gamma \vdash_{RM} \varphi \) if and only if \( \{ \psi \approx \psi \rightarrow \psi : \psi \in \Gamma \} \models_{Z} \varphi \approx \varphi \rightarrow \varphi \). The logic \( RM \) as well as the variety of Sugihara algebras have been studied intensively (see, e.g., [22, 35, 73, 20, 81]). Note that in particular the algebra \( Z_{3}^{-\neg} \) generates the variety of multiplicative Sugihara algebras (see [73] for details):

**Theorem 4.12** ([103], see also [73, Theorem 5.1]). Let \( SA_{m} \) be the algebraic semantics of the \{\( \rightarrow, \neg \}\}-fragment of the logic \( RM \), denoted \( RM_{m} \). Then \( V(SA_{m}) = V(Z_{3}^{-\neg}) \).

Moreover, \( Q(Z_{3}^{-\neg}) \) provides algebraic semantics\(^5\) for the logic \( RM_{m} \) extended by the modus-ponens-like "Avron-rule"

\[
\varphi, (\varphi \rightarrow (\psi \rightarrow \psi)) \rightarrow (\varphi \rightarrow \psi) \quad \text{(A)}
\]

**Theorem 4.13** ([73, Lemma 5.4]). \( Q(Z_{3}^{-\neg}) \) builds the algebraic semantics of \( RM_{m} + (A) \).

\(^5\)Note that the multiplication \( \cdot \) used in [73] can be defined by \( x \cdot y := \neg(x \rightarrow \neg y) \).
We study here some reducts of the Sugihara monoids $Z^e_3$ and $Z^e_4$ with universes $\{-1, 0, 1\}$ and $\{-2, -1, 1, 2\}$, respectively. The tables of the corresponding implications $\rightarrow$ are shown in Figure 4.7.

We list in Table 4.3 the results obtained when applying $\text{AdmAlgs}$ to $Z^e_3$ and $Z^e_4$, respectively, while changing the underlying language. The algebras $Z_3$ and $Z_3^{\rightarrow\neg}$ are the only three element algebras of the list which are not structurally complete, since there are quasiequations which are admissible but not valid in the corresponding algebras. E.g., considering the truth table for the equation

$$y \rightarrow (x \rightarrow x) \approx (x \land \neg x) \land (y \land \neg y)$$  \hspace{1cm} (4.6)

confirms that (4.6) is only satisfiable with $x = y = 0$ or $x = y = -1$. But it is not hard to see that there cannot be any $\{\land, \lor, \rightarrow, \neg\}$-term which always takes value 0 or $-1$, respectively. Hence (4.6) is not $Z_3$-unifiable. So the quasiequation (4.7) is $Z_3$-admissible, but not $Z_3$-valid and $Z_3$ is not structurally complete$^6$.

$$y \rightarrow (x \rightarrow x) \approx (x \land \neg x) \land (y \land \neg y) \Rightarrow x \approx z.$$  \hspace{1cm} (4.7)

Note moreover that although $Z_3$ and $Z_3^{\rightarrow\neg}$ are not clone equivalent by Theorem 3.28 and the size of their free algebras, their minimal generating algebras are isomorphic when we define $\land$ and $\lor$ component-wise for $Z_3^{\rightarrow\neg}$. In

$^6$The argument also holds for $Z_3^{\rightarrow\neg}$, since $(x \land \neg x) \land (y \land \neg y) = \neg(((x \rightarrow x) \rightarrow y) \rightarrow y)$. 

\begin{table}[h]
\begin{tabular}{c|ccc}
$\rightarrow Z^e_3$ & $-1$ & $0$ & $1$ \\
\hline
$-1$ & $1$ & $1$ & $1$ \\
$0$ & $-1$ & $0$ & $1$ \\
$1$ & $-1$ & $-1$ & $1$
\end{tabular}
\end{table}

\begin{table}[h]
\begin{tabular}{c|cccc}
$\rightarrow Z^e_4$ & $-2$ & $-1$ & $1$ & $2$ \\
\hline
$-2$ & $2$ & $2$ & $2$ & $2$ \\
$-1$ & $2$ & $1$ & $1$ & $2$ \\
$1$ & $2$ & $-1$ & $1$ & $2$ \\
$2$ & $2$ & $-2$ & $-2$ & $2$
\end{tabular}
\end{table}
Table 4.3: Admissibility for reducts of Sugihara monoids.

| A     | |A| | Language | n | F(n) | M   | SC |
|-------|---|-----|--------|---|------|-----|----|
| \(Z_3^e\) | 3 | \(\land, \lor, \to, \neg, e\) | 1 | 9 | 3 | sc |
| \(Z_3\) | 3 | \(\land, \lor, \to, \neg\) | 2 | 1296 | 6 | asc |
| \(Z_3^{\to}\) | 3 | \(\to, \neg\) | 2 | 264 | 6 | asc |
| \(Z_3^{\to-e}\) | 3 | \(\to, \neg, e\) | 1 | 5 | 3 | sc |
| \(Z_3^{e}\) | 3 | \(\to, e\) | 1 | 5 | 3 | sc |

| \(Z_4^e\) | 4 | \(\land, \lor, \to, \neg, e\) | 1 | 64 | 8 | asc |
| \(Z_4\) | 4 | \(\land, \lor, \to, \neg\) | 2 | 20736 | ? | ? |
| \(Z_4^{\to}\) | 4 | \(\to, \neg\) | 2 | 264 | 6 | no |
| \(Z_4^{\to-e}\) | 4 | \(\to, \neg, e\) | 1 | 18 | 6 | no |
| \(Z_4^{e}\) | 4 | \(\to, e\) | 2 | 453 | 4 | no |

The fact they are isomorphic to the product \(Z_3 \times Z_2\). On the other hand, \(Z_3^{\to-e}\) and \(Z_3^{e}\) are clone equivalent, since \(-x = x \to e\) if \(e = 0\).

It is remarkable that although the algebra \(Z_4^{e}\) is not structurally complete and not \(Z_4^{\to-e}\)-irreducible, nevertheless the algorithm ADMALG\(S\) produces a four element algebra that is not isomorphic to \(Z_4^{\to-e}\). For \(Z_4^{\to}\) we even obtain a three element algebra.

Even though the free algebra of \(Z_4\) is too big\(^7\) to run ADMALG\(S\)(\(\{Z_4\}\)) within TAFA, it is clear that \(F_{Z_4}(2)\) is the minimal generating free algebra for \(Q(F_{Z_4}(\omega))\): Since \(F_{Z_4}(1)\) has four elements and is not isomorphic to \(Z_4\), it cannot be a generating algebra for \(Q(F_{Z_4}(\omega))\) by Corollary 3.13. So we define a map \(h: \{x, y\} \to Z_4\) by \(h(x) := 1, h(y) := 2\). By the universal mapping property of \(F_{Z_4}(\omega)\) for \(Q(Z_4)\) this extends to a homomorphism \(\overline{h}: F_{Z_4}(\omega) \to Z_4\) with \(h(-x) := -1\) and \(h(-y) := -2\). Hence \(\overline{h}\) is surjective and by Corollary 3.13, \(F_{Z_4}(2)\) is the minimal generating free algebra for \(Q(F_{Z_4}(\omega))\) as required.

---

\(^7\)The size of \(F_{Z_4}(2)\) was calculated by the tool UACalc of Ralph Freese [38].
4.6 Summary

We remark that all the quasivarieties $Q(\mathcal{K})$ studied so far had only one generating algebra, i.e., $|\mathcal{K}| = 1$. There are certainly interesting examples with more generating algebras (see, e.g., Example 4.14 below). Nevertheless every finitely generated quasivariety is also generated by one finite algebra, i.e., $F_{\mathcal{K}}(\omega) = F_{A_1 \times \cdots \times A_n} (\omega)$ for a finite set of finite $\mathcal{L}$-algebras $\mathcal{K} := \{A_1, \ldots, A_n\}$ by Corollary 2.16 and $A_1 \times \cdots \times A_n \in \mathbb{P}(\mathcal{K})$ and $A_i \in S(\{A_1 \times \cdots \times A_n\})$ using the $i$-th projection homomorphism for $i \in \{1, \ldots, n\}$.

Example 4.14. Consider the two chains $C_2 := \langle \bot, \top, \land, \lor, \neg, c \rangle$ and $C_3 := \langle \bot, e, \top, \land, \lor, \neg, c \rangle$ where $\neg$ swaps $\bot$ and $\top$ and leaves $e$ fixed and $c_{C_2} := \top$, $c_{C_3} := e$. Individually, these algebras are structurally complete. However, applying $\text{ADMAlgs}$ to $\mathcal{K} := \{C_2, C_3\}$, we find that $\mathcal{K}$ is not structurally complete: both $C_2$ and $C_3$ are homomorphic images of the sixteen element free algebra $F_{\mathcal{K}}(1)$, and the minimal generating set for $Q(F_{\mathcal{K}}(\omega))$ consists of a single four element algebra.

Table 4.4 summarizes the results (without the lattices of Table 4.1), ordered by the cardinalities of the algebras (first priority) and their free algebras (second priority).
Table 4.4: Algebras for checking admissibility. The column “$n$” lists the number of generators needed to generate $Q(F_A(\omega))$, “$F_A(n)$” the cardinality of the minimal generating free algebra, “$M$” the cardinalities of the minimal generating set for $Q(F_A(n))$ and “SC” whether $A$ is structurally complete (“sc”), almost structurally complete (“asc”) or none of the two (“no”).

| $A$   | $|A|$ | Language | Quasivariety $Q(A)$ | $n$ | $F(n)$ | $M$ | $SC$ |
|-------|------|----------|---------------------|-----|--------|-----|------|
| $B_2$ | 2    | $\land, \lor, \neg, \bot, \top$ | $Q(B_2)$ (Exs 2.4, 3.19) | 0   | 2      | 2   | sc   |
| $Z_3^{-e}$ | 3 | $\to, \neg, e$ | $Q(Z_3^{-e})$ (Sec. 4.5) | 1   | 5      | 3   | sc   |
| $Z_3^{e}$ | 3 | $\to, e$ | $Q(Z_3^{e})$ (Sec. 4.5) | 1   | 5      | 3   | sc   |
| $C_3$ | 3 | $\land, \lor, \neg, \bot, \top$ | Kleene algebras (Sec. 4.4) | 1   | 6      | 4   | no   |
| $PCL_1$ | 3 | $\land, \lor^*, \bot, \top$ | Stone algebras (Sec. 4.3) | 1   | 6      | 3   | sc   |
| $G_9$ | 3 | $*$ | $Q(G_9)$ (Sec. 3.8) | 2   | 7      | 4   | no   |
| $S$ | 3 | $\supset, \neg$ | Algebras for $P^1$ (Sec. 5.3) | 1   | 9      | 9   | no   |
| $Z_3^e$ | 3 | $\land, \lor, \rightarrow, \neg, e$ | $Q(Z_3^e)$ (Sec. 4.5) | 1   | 9      | 3   | sc   |
| $G_{106}$ | 3 | $\circ$ | $Q(G_{106})$ (Ex. 3.14) | 2   | 10     | 2,2 | no   |
| $L_3$ | 3 | $\rightarrow, \neg$ | Algebras for $L_3$ (Ex. 3.26) | 1   | 12     | 6   | asc  |
| $L_3^\rightarrow$ | 3 | $\rightarrow$ | Algebras for $L_3^\rightarrow$ (Ex. 3.26) | 2   | 40     | 3   | sc   |
| $Z_3^\rightarrow$ | 3 | $\rightarrow$ | Algebras for $RM^\rightarrow$ (Sec. 4.5) | 2   | 60     | 3   | sc   |
| $C_3^f$ | 3 | $\land, \lor, \neg$ | Kleene lattices (Sec. 4.4) | 2   | 82     | 4   | no   |
| $Z_3^\rightarrow$ | 3 | $\rightarrow, \neg$ | Algebras for $RM^\rightarrow$ (Sec. 4.5) | 2   | 264    | 6   | asc  |
| $Z_3$ | 3 | $\land, \lor, \rightarrow, \neg$ | $Q(Z_3)$ (Sec. 4.5) | 2   | 1296   | 6   | asc  |
| $P$ | 4 | $*$ | $Q(P)$ (Ex. 3.22) | 2   | 6      | 3   | sc   |
| $Z_4^\rightarrow$ | 4 | $\rightarrow, \neg, e$ | Algebras for $RM^\rightarrow$ (Sec. 4.5) | 1   | 18     | 6   | no   |
| $Z_4^e$ | 4 | $\rightarrow$ | $Q(Z_4^e)$ (Sec. 4.5) | 2   | 60     | 3   | no   |
| $Z_4^f$ | 4 | $\land, \lor, \rightarrow, \neg, e$ | $Q(Z_4^f)$ (Sec. 4.5) | 1   | 64     | 8   | asc  |
| $D_4^f$ | 4 | $\land, \lor, \neg$ | De Morgan lattices (Sec. 4.4) | 2   | 166    | 8   | asc  |
| $D_4$ | 4 | $\land, \lor, \neg, \bot, \top$ | De Morgan algebras (Sec. 4.4) | 2   | 168    | 10  | no   |
| $Z_4^\rightarrow$ | 4 | $\rightarrow, \neg$ | $Q(Z_4^\rightarrow)$ (Sec. 4.5) | 2   | 264    | 6   | no   |
| $Z_4^\rightarrow$ | 4 | $\rightarrow, e$ | Algebras for $RM^\rightarrow$ (Sec. 4.5) | 2   | 453    | 4   | no   |
| $Z_4$ | 4 | $\land, \lor, \rightarrow, \neg$ | $Q(Z_4)$ (Sec. 4.5) | 2   | 20736  | ?   | ?    |
| $PCL_2$ | 5 | $\land, \lor^*, \bot, \top$ | $Q(PCL_2)$ (Sec. 4.3) | 1   | 7      | 5   | sc   |
| $PCL_3$ | 9 | $\land, \lor^*, \bot, \top$ | $Q(PCL_3)$ (Sec. 4.3) | 2   | 625    | 19  | no   |
| $PCL_4$ | 17 | $\land, \lor^*, \bot, \top$ | $Q(PCL_4)$ (Sec. 4.3) | 2   | 626    | ?   | no   |

85
Chapter 5

TAFA - A Toolbox for Finite Algebras

This chapter presents TAFA (standing for “Tool for Admissibility in Finite Algebras”), an implementation of the algebraic tools and algorithms from Chapter 3. Nearly all the calculations made in this thesis, in particular, those in Chapter 4, were made using TAFA. We implemented TAFA using Delphi XE2, a development environment for Object Pascal. It is currently compiled for Windows, but can easily be used on Mac and Linux using an emulator such as Wine. Many ideas concerning the data structures and basic operations are taken from the source code of the Algebra Workbench (see [104, 91]). An executable file of TAFA is available from https://sites.google.com/site/admissibility/.

Sections 5.1 and 5.2 provide an overview of the features offered by TAFA. Section 5.3 then gives an insight into the look-and-feel of the tool by guiding the reader through an example session related to the paraconsistent Sette algebra, which was introduced in [87].

1Note, however, that to calculate the size of a free algebra with more than 1500 elements (without having the corresponding operation tables) we used UACalc [38].

2Wine can be downloaded from http://www.winehq.org/.
5.1 Basic Operations

In order to use TAFA the user should first either define the algebras of interest in TAFA or load some predefined (see File > Predefined algebras\(^3\)) or previously stored algebras (from a file). Defining a new algebra (see File > New algebra) includes giving it a name, labeling the elements and defining the operations. The user can easily rename, sort, delete or edit algebras, their elements and operations or add some comment by either double clicking the corresponding field of the grid in the main window or using the menu Edit. The main window of TAFA contains a list showing for each algebra its name, cardinality, the names and arities of its operations and any comments.

TAFA can save the selected or chosen\(^4\) algebras as a binary file (*.fab, fast, illegible), as a text file (*.fai, slower, legible) or, if the algebra is a partially ordered set with an operation “meet”, to a *.osf file which can be read by the Algebra Workbench to visualize the corresponding Hasse diagram. TAFA loads algebras from fab- or fai-files and is able to copy or remove algebras in the main window (menu File). The algebras are stored as the data type TAlgebra within TAFA, which is connected to lists of the type TAlgebraUniverse and TOperationList providing further procedures and objects. Once the algebras of interest are defined in the main window, the basic operations of universal algebra described below can be performed.

The menu item Tools > Morphisms opens a dialogue window where the user can choose a domain \(A_1\) and a codomain \(A_2\) (of the same language) from the list of defined algebras. It is possible to choose whether to calculate all homomorphisms between \(A_1\) and \(A_2\) or only those that are surjective, injective or bijective. When the button “Calculate” is pressed, TAFA lists the homomorphisms satisfying the chosen criteria. Double-clicking on an entry of the list shows the mappings from elements of \(A_1\) to elements of \(A_2\). Using the Tools menu of this dialogue window it is also possible to add the

\(^3\)Navigation through the menus is denoted here by Menu > Menu item.

\(^4\)We say that an entry of a list, e.g., an algebra in the main window, is selected if it is highlighted, and chosen if the appropriate check box is checked.
homomorphic image as a new algebra to the main window or to save the mapping information to a text file.

The menu item **Tools > Subalgebras** opens a dialogue window which lists all the subalgebras of the active algebra. The subalgebras are stored as entities of TAlgebraUniverse within this dialogue window to save time (there is no need to build up the operation tables), but it is possible to add the checked subalgebras as new algebras to the main window using the menu **Tools** of the dialogue window. The **Options** menu of the dialogue window offers the possibility to (heuristically) first list the smaller and then the bigger algebras by first calculating the subalgebras generated by zero or one element, storing their sizes and then trying to combine the given generators in such a way that the subalgebras generated are potentially small.

**Tools > Generating subalgebra** opens a dialogue window where the user can choose some elements \(a_1, \ldots, a_k\) of the active algebra \(A\). TAFA then calculates the unique subalgebra of \(A\) generated by the elements \(a_1, \ldots, a_k\) and adds it as a new algebra to the main window.

Having defined algebras \(A_1, \ldots, A_n\) of the same language in the main window of TAFA, the user can calculate the direct product \(A_1 \times \cdots \times A_n\) using **Tools > Direct product**. Specifying some \(k \in \mathbb{N}\) with **Tools > Direct power**, the direct power \(A^k\) of the selected \(\mathcal{L}\)-algebra \(A\) is calculated.

**Tools > Congruences** opens a dialogue window which lists the congruences \(\text{Con}(A)\) of the selected \(\mathcal{L}\)-algebra \(A\) in the main window. Selecting a congruence in the list shows the congruence classes on the right side. The dialogue window menu **Tools** lets the user store the congruence lattice \(\text{Con}(A)\) as a new algebra (with the lattice operations \(\land\) and \(\lor\) as language) to the main window. It is also possible to quotient the active structure with the selected congruence or to save the congruence information to a text file.

If the set \(\mathcal{K} := \{A_1, \ldots, A_n\}\) of \(\mathcal{L}\)-algebras is chosen in TAFA, the menu item **Tools > Free algebra** lets the user specify a natural number \(n \in \mathbb{N}\) and TAFA calculates the free algebra \(F_{\mathcal{K}}(n)\). There is also the possibility to search for the smallest generating free algebra for \(\mathcal{K}\).
5.2 Advanced Features

*Tools > Minimal Generating Set (MinGenSet)* calculates $\text{MinGenSet}({\mathcal{K}})$ for the chosen set of $\mathcal{L}$-algebras $\mathcal{K}$ in TAFA (see Algorithm 3.1).

Let $A$ be an $\mathcal{L}$-algebra and $F_A(n)$ the minimal generating free algebra for $\mathcal{Q}(F_A(\omega))$. We call an $\mathcal{L}$-algebra $B$ an *admissibility algebra*, if $B \in S(F_A(n))$ and $A \in \mathbb{H}(B)$ (see Corollary 3.13).

Given a set $\mathcal{K}$ of $\mathcal{L}$-algebras chosen in TAFA, the user selects the appropriate free algebra or lets the program find the smallest generating free algebra for $\mathcal{K}$ with *Tools > Admissibility algebra*. The menu *Options* of the dialogue window for calculating admissibility algebras then lets the user choose whether to search for admissibility algebras from smaller to larger or with the usual algorithm of searching for subalgebras (which is independent of their cardinalities). Although the latter is much quicker for small algebras, there are some cases where the heuristic method performs faster. Once the admissibility algebra is stored as a new algebra in the main window, the user can calculate $\text{MinGenSet}({\mathcal{K}})$ as needed.

The menu *Check* enables the user to check whether the selected $\mathcal{L}$-algebra $A$ is subdirectly irreducible, $\mathcal{Q}(A)$-subdirectly irreducible (see Corollary 2.11), structurally complete (see Theorem 3.23) or almost structurally complete (see Theorem 3.27).

5.3 Example Session

In this section we guide the reader through an example TAFA session, trying to find the minimal generating set for the quasivariety $\mathcal{Q}(F_S(\omega))$, where $S$ is the *Sette algebra* generating the algebraic semantics $\mathcal{Q}(S)$ for the paraconsistent *Sette logic* $P^1$ (see [102, 87]).

The first step is of course to define the algebra $S$ within TAFA. $S$ has three elements $\{0, 0.5, 1\}$, a binary operation $\supset$ and a unary operation $\neg$. 

90
defined as follows:

\[
\begin{array}{c|ccc|c|c}
\supset & 0 & 0.5 & 1 & \neg \\
0 & 1 & 1 & 1 & 0 & 1 \\
0.5 & 0 & 1 & 1 & 0.5 & 1 \\
1 & 0 & 1 & 1 & 1 & 0 \\
\end{array}
\]

We first open TAFA, select the menu item *File > New algebra* (see figure below), enter the name “Sette” into the opened text field and hit “OK”. The algebra is now defined, but has no elements and operations yet.

To define the universe select *Edit > Edit elements* or double click onto the “0” in the column called “Card”. A dialogue window called “Elements of Sette” opens. Define the elements 0, 0.5 and 1 with the appropriate buttons, then hit “OK” (see figure below). The universe is now defined.
To define the operations select *Edit > Edit operations* or double click onto the operations cell of the grid. A dialogue window called “Operations of Sette” opens. Click “Add”, then name the first operation (e.g., “imp”) and fix the arity (here two). After confirming with “OK” we see a row displayed in red in the grid of this dialogue window, which means that the operation is defined but there are still undefined values. Now we either click the button “Edit” or double click on the line of the operation “imp” to define the table of values for ⊆. In the opened window called “Operation table of imp” we can either enter the values by typing them on the keyboard or by selecting them in the drop down menu called “Active element” and then double clicking on the desired coordinate of the table (see figure below). When the table is completely defined we confirm with “OK” and go through the same procedure to define the operation ¬.

By either selecting *Edit > Edit comment* or double clicking on the comment
cell in the grid we can also add a comment if we like. Now the algebra $S$ is completely defined and ready to use. With the menu item File > Save algebra to file we can save the algebra into a file for later use.

In order to find the minimal generating set for $Q(F_S(\omega))$, we first need to calculate the minimal generating free algebra for this quasivariety. The menu item Tools > Free algebra opens a dialogue window called “Number of generators for the free algebra”, where we check the box “Calculate the minimal generating free algebra” and confirm with “OK”:

It turns out that the minimal generating free algebra for $Q(F_S(\omega))$ is $F_S(1)$ which has nine elements. By double clicking on the “Card” cell we get a list of representatives of the equivalence classes of the free algebra showing how the elements of the free algebra were generated (see figure below).

Suppose that we would like to know the definition of a homomorphism from the free algebra $F_S(1)$ onto $S$ (note that there must be at least one such homomorphism since $F_S(1)$ is the minimal generating free algebra for $Q(F_S(\omega))$). Calculating morphisms is done through the menu item Tools > Morphisms:
The morphisms window opens, where we choose the domain, codomain and type of homomorphism we search for. Clicking “Calculate” shows us that there is only one surjective homomorphism from the free algebra onto $S$.

Double clicking the corresponding row presents the mapping:
The menu item *Tools > Congruences* opens a dialogue window called “Congruences of $\mathbf{F}_\omega \{-\text{Sette}\}(1)$”. Calculating the congruences by clicking “Calculate” shows that there are only twelve congruences in $\text{Con}(\mathbf{F}_\omega(1))$ (see figure below) and hence we could directly apply the algorithm $\text{MinGenSet}$ to $\{\mathbf{F}_\omega(1)\}$ to get (in a reasonable amount of time) the minimal generating set for the quasivariety $\mathbb{Q}(\mathbf{F}_\omega(\omega))$. But for the sake of the example, let us suppose that we want to apply the algorithm $\text{AdmAlgs}$.

![Congruences of $\mathbf{F}_\omega \{-\text{Sette}\}(1)$](image1)

For this we choose the menu item *Tools > Admissibility algebra* (note that we need to choose the algebra “Sette” first in the main grid) and then select the free algebra called “$\mathbf{F}_\omega \{-\text{Sette}\}(1)$” in the list that pops up:

![Free algebra](image2)
Clicking “OK” opens a dialogue window called “Admissibility algebras for Sette”. We only deselect “Chain of subalgebras (found subalgebras as new starting point)” of the menu Options if we want to find all the subalgebras of the minimal generating free algebra (here $F_S(1)$) which are prehomomorphic images of the generating algebra (here $S$). For small algebra it is much faster to have the option “From smaller to bigger algebras (heuristic)” deselected. So we start the calculation by clicking the button “Calculate” and then see that the new algebra in the main grid has nine elements like the free algebra and hence must be the free algebra itself. To finish our search we have finally to apply the algorithm MinGenSet to this algebra with the menu item Tools > Minimal generating set (MinGenSet) since it could be that there are smaller algebras generating the same quasivariety which are not prehomomorphic images of $S$. This is not the case here for $F_S(1)$, hence

$$\text{MinGenSet}(F_S(\omega)) = \{ F_S(1) \}.$$ 

Note that we can check that $S$ is not almost structurally complete (see figure below) with the use of Check > Almost structural completeness.
Chapter 6

Concluding Remarks

This chapter summarizes the results obtained in this thesis and explains how they fit into the existing theory of admissible rules in universal algebra and finite-valued logics (Section 6.1). We conclude the thesis by sketching some ideas for future research into questions related to this work (Section 6.2).

6.1 Contribution of the Thesis

Our primary goal in this thesis was to investigate admissibility in finitely generated quasivarieties and finite-valued logics. There has been a substantial amount of research into admissibility for intermediate and modal logics (see, e.g., [99, 43, 44, 56, 60]), but a general theory of admissibility for finite-valued logics was, before the work reported here, lacking. A central aim of the thesis was to establish general algorithms to check whether a given quasiequation is admissible in a finitely generated quasivariety \( Q \). This is the case if and only if it is valid in the free algebra \( F_Q(n) \) where \( n \) is the maximum of the cardinalities of the generating algebras (see Theorem 3.9), but free algebras are often quite big even for a small number of generators.

A first step towards addressing this issue was the introduction of minimal generating sets for any finitely generated quasivariety \( Q \) (see Algorithm 3.1), i.e., smallest (with respect to the standard multiset ordering) sets of alge-
bras $\mathcal{K}$ such that $Q = \mathcal{Q}(\mathcal{K})$. Minimal generating sets are unique up to isomorphism (see Theorem 3.3) and provide a useful general tool for investigating finitely generated quasivarieties in universal algebra. The algorithm MinGenSet provides here a possibility of answering the problem of checking admissibility in finitely generated quasivarieties $\mathcal{Q}(\mathcal{K})$, since MinGenSet$(\{F_{\mathcal{Q}(\mathcal{K})}(n)\})$ (where $n$ is the maximum of the cardinalities of the algebras in $\mathcal{K}$) returns the minimal generating set for $\mathcal{Q}(F_{\mathcal{Q}(\mathcal{K})}(\omega))$.

However, finding a minimal generating set is not generally feasible for larger algebras. A further important ingredient of our approach is therefore Theorem 3.11 since it describes how to replace the generating free algebra with a smaller algebra while making sure that the new (sub)algebra still generates the same quasivariety $\mathcal{Q}(F_{\mathcal{Q}}(\omega))$. Results from Birkhoff (see Lemma 2.12) and Rybakov (see Theorem 2.18) allow this theorem to be applied to finitely generated quasivarieties. Finally, the procedure AdmAlgs (see Algorithm 3.2) joins the two ideas of finding the minimal generating set and reducing the size of the generating algebras by searching for suitable subalgebras, providing a general algorithm for checking admissibility (see Theorem 3.15). Table 4.4 lists the remarkable reductions of the cardinalities from the appropriate free algebras to the results of the algorithm AdmAlg. These results contribute to the study of some well known classes of algebras, including the varieties of De Morgan and Kleene algebras.

Theorem 3.7 connects unifiability of a set of equations with satisfiability of this set in a subalgebra of a finite free algebra. Hence unifiability is decidable and can be checked in the (usually small) smallest subalgebra of the free algebra. Theorem 3.23 characterizes structural completeness using the algorithm MinGenSet. This implementable (see Chapter 5) characterization provides a nice alternative to known proof techniques for establishing structural completeness in finitely generated quasivarieties or finite-valued logics such as Theorem 3.17 or “Prucnal’s trick” (see [85]). Theorem 3.25 provides a characterization for almost structural completeness similar to Theorem 3.16 for structural completeness. This has been used to describe almost structural
completeness in terms of the algorithm \textsc{MINGENSET} in Theorem 3.27.

Theorem 3.28 can save a lot of calculation time since it ensures that free algebras and minimal generating sets of clone equivalent algebras are isomorphic (up to translations inside their clone of operations) and hence we only need to run our algorithms once if the operations of two algebras are inter-definable. Theorem 3.30 transfers Theorem 3.11 into the logical setting, i.e., for a given logic \( L \), it characterizes the admissibility of a rule \( \Gamma / \varphi \) by the validity in another logic \( L' \).

These theoretical results and obtained algorithms for admissibility in finitely generated quasivarieties have allowed us to investigate when admissibility and validity diverge in some basic cases: Theorem 4.1 provides a new proof for the fact that every two element algebra is structurally complete (compare [89, Corollary 1]). Section 4.2 comprehensively investigates the minimal generating sets for \( \mathcal{Q}(F_G(\omega)) \) for all three element groupoids \( G \).

We have also used the obtained tools to investigate axiomatization problems: Theorems 4.7, 4.5 and 4.9 provide bases for the admissible quasiequations of the quasivarieties of Kleene algebras, Kleene lattices and De Morgan lattices, respectively. Moreover, Theorem 4.11 presents a “basis” for the admissible quasiequations of the variety of De Morgan algebras which does not consist only of quasiequations, but also includes the proper clause (4.3) (in contrast to more recent work [26], where a proper basis is found using natural dualities).

\subsection{6.2 Outlook}

For any finitely generated quasivariety \( \mathcal{Q} \), we can find a minimal set \( \mathcal{K} \) (with respect to the standard multiset ordering) of algebras to check admissibility in \( \mathcal{Q} \) (by checking validity in \( \mathcal{K} \)). Nevertheless, the algorithm \textsc{AdmALG} is not feasible for arbitrary input size because of the complexity of the tasks involved. The bottlenecks are in particular: generating the free algebra, calculating the congruence lattice (or, equivalently, checking homomorphisms) and
calculating subalgebras. Checking, e.g., whether $A \in \mathbb{H}(B)$ or $A \in \mathbb{S}(B)$ is NP-hard for finite algebras $A$ and $B$ (see, e.g., [13, 53]), but running through all subalgebras or congruences is EXPTIME-hard in general\(^1\). The following ideas might be used to obtain faster algorithms:

- Only construct small subalgebras of the free algebra (heuristically) to check if they generate the whole quasivariety, i.e., if they are prehomomorphic images of the initial algebras.

- Do not calculate the whole lattice of congruences in $\text{MingGenSet}$. Intuitively, we are only interested in the bottom region of the congruence lattice $\text{Con}(A)$ if we want to check whether $A$ is $Q(A)$-subdirectly irreducible (see Lemma 3.4 and Corollary 2.11(b)).

- Improve the algorithm for generating subalgebras used for the heuristic procedure where we first check smaller, then bigger subalgebras of the free algebra in $\text{AdmAlgs}$. Construct a directed graph to store (based on the operation tables of the operations of the algebra) which elements are “reachable” by which elements. E.g., in the Kleene lattice $C_{L}^{3}$ (see Section 4.4), 1 is reachable by $-1$, since $- - 1 = 1$, but 0 is not.

- Search for convenient subalgebras of the free algebra top-down rather than bottom-up by systematically excluding elements. This would be particularly helpful if our conjecture is true, that the “admissibility algebras” are always on the top of the lattice of subuniverses. I.e., given a finitely generated quasivariety $Q$ and its minimal generating free algebra $F_{Q}(n)$, then $Q(B) = Q(F_{Q}(n))$ for some algebra $B$ implies $Q(B') = Q(F_{Q}(n))$ for all algebras $B'$ in the upset of $B$ inside the lattice of subuniverses (compare Figure 3.1 as an example).

- Improve the algorithms by restricting attention to certain classes of algebras. E.g., if we consider congruence-distributive algebras, we

---

\(^1\)See [14] for investigations on the size of free algebras.
could use a polynomial time algorithm to find a subdirect decomposition (see [33]) instead of a $\mathcal{Q}$-subdirect decomposition, since every $\mathcal{Q}$-subdirectly irreducible algebra is subdirectly irreducible for a congruence-distributive quasivariety\(^2\) $\mathcal{Q}$ (see [37, Theorem 2.3]).

- Try to prohibit redundant calculations as with Theorem 3.28 by considering the type sets (containing the types unary, affine, Boolean, lattice or semilattice) of tame congruence theory (see [55]) for the given finite algebra (see, e.g., [68] for complexity studies in universal algebra with respect to tame congruence theory).

The usability of TAFA could also be improved. E.g., rather than calculating the free algebra within TAFA, we could implement an interface to the tool UACalc, since this tool already implemented many optimization tricks like “thinning the coordinates”. Also, it could be convenient to have import (export) possibilities from (to) other formats such as \LaTeX, UACalc, AWB or Sage. Moreover, it could be helpful to save the calculated parts of the free algebra if the calculation is aborted, e.g., to generate the fully defined subalgebras of this part of the free algebra.

Finally, there remain numerous open problems and directions in the theoretical framework of admissible rules that might be tackled using the ideas and tools developed in this thesis. In particular:

- The present work only considers propositional logics. Could the results obtained in this thesis be transferred to predicate logics? Note, however, that admissibility is far from being understood even in the case of classical predicate logic.

- How could we extend the work to locally finite quasivarieties, i.e., where finitely generated algebras are finite, or even infinite algebras? The problem of non-finitely generated quasivarieties is certainly that either

\(^2\)A quasivariety $\mathcal{Q}$ is called congruence-distributive, if for every algebra $\mathbf{A} \in \mathcal{Q}$ the lattice $\text{Con}_\mathcal{Q}(\mathbf{A})$ is distributive. By [37, Proposition 2.1] this is the case if and only if for each $n \in \mathbb{N}$, $\text{Con}_\mathcal{Q}(\mathbf{F}_\mathcal{Q}(n))$ is distributive.
only infinitely many algebras generate the quasivariety or some of the
generating algebras have infinite cardinalities. So using TAFA to inves-
tigate these algebras or hoping for the presented algorithms to termi-
nate will not work. Moreover, we would have to consider ultraproducts
in this case, since $Q(K) = ISP_U(K)$ in general. Nevertheless, it still
makes sense to concentrate on $Q(K)$-subdirectly irreducible algebras
(to find minimal generating sets) since they generate the quasivariety
(see Theorem 2.8). Also methods for checking, e.g., structural com-
pleteness, like finding an embedding into the free algebra (see Theo-
rem 3.17) extend to infinite algebras.

• Finding admissible rules with some algorithm could be helpful in finding
bases of admissible rules automatically for a given quasivariety which
is not structurally complete. One of the motivations for investigating
admissibility is to obtain quasiequations that can be used to tune up
proof systems (shortening derivations, constraining proof search, . . .)
for these algebras. A further step could then also be to find potentially
useful quasiequations for a given finite algebra. Note however, that
there are finite algebras which do not have a finite basis of admissible
rules (see [73, Corollary 5.12]).

• We only treated admissible quasiequations here except for the clause

$$x \lor y \approx \top \Rightarrow x \approx \top, \ y \approx \top,$$

which is admissible in De Morgan algebras (see Section 4.4), i.e., whenever $\sigma(x) \lor \sigma(y) \approx \top$ is valid in all De Morgan algebras for any substi-
tution $\sigma$, then either $\sigma(x) \approx \top$ or $\sigma(y) \approx \top$ is valid in all De Morgan
algebras. We would therefore like to investigate how to adapt our al-
gorithms to treat such “multiple-conclusion rules” (see also [26]).

• A logic is said to be hereditarily structurally complete if all of its ex-
tensions are structurally complete. Algebraically, this corresponds to
the fact that every proper subquasivariety is a variety. We would like to investigate whether there is a characterization as for structural and almost structural completeness in terms of minimal generating sets for this property (see Theorems 3.23, 3.27).
List of Three Element Groupoids

Table A.1 lists all three element pairwise not clone equivalent groupoids. The listed numbers are the same for clone equivalent groupoids (see Theorem 3.28). For the groupoid \( G := \langle \{0, 1, 2\}, * \rangle \) the operation \(*\) is coded in flat form as

\[
(*(0, 0), *(0, 1), *(0, 2), *(1, 0), *(1, 1), *(1, 2), *(2, 0), *(2, 1), *(2, 2)),
\]

i.e., the operation table “line-by-line”. The groupoids are sorted and numbered by the alpha-numerical order of the flat form representation of their operation tables. For each clone equivalence class the first groupoid corresponding to this order is listed. The columns of the table are labelled as follows:

- \( CE \): The number of the clone equivalence class \( \text{Clo} G \).
- \( G \): The number of the first groupoid \( G \) in this clone equivalence class.
- \( \text{Operation} \): The operation table of \( *^G \) in flat form.
- \( n \): The number of generators needed to generate \( \mathbb{Q}(F_G(\omega)) \).

---

\(^{1}\) A list of all non-isomorphic groupoids with the corresponding numbers of the clone equivalence classes can be downloaded from the webpage of S.N. Burris, [www.math.uwaterloo.ca/~snburris/htdocs/MYWORKS/PAPERS/Groupoid_Tables.pdf](http://www.math.uwaterloo.ca/~snburris/htdocs/MYWORKS/PAPERS/Groupoid_Tables.pdf)
- **F(n)**: The cardinality of the free algebra $F_G(n)$.
- **SS**: The cardinality of the smallest subalgebra of $F_G(n)$.
- **MGS**: The cardinalities of the minimal generating set for $Q(F_G(n))$.
- **SC**: $G$ is structurally complete.
- **ASC**: $G$ is almost structurally complete.

Table A.1: Three element groupoids.

<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>(0,0,0,0,0,0,0,0,0)</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>(0,0,0,0,0,0,0,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>(0,0,0,0,0,0,0,0,2)</td>
<td>2</td>
<td>5</td>
<td>1</td>
<td>2,2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>(0,0,0,0,0,0,0,1,0)</td>
<td>2</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>(0,0,0,0,0,0,0,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>(0,0,0,0,0,0,0,1,2)</td>
<td>2</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>(0,0,0,0,0,0,0,2,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>(0,0,0,0,0,0,0,2,2)</td>
<td>2</td>
<td>7</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>(0,0,0,0,0,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>(0,0,0,0,0,0,1,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>(0,0,0,0,0,0,1,0,2)</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>(0,0,0,0,0,0,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>13</td>
<td>14</td>
<td>(0,0,0,0,0,0,1,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>14</td>
<td>15</td>
<td>(0,0,0,0,0,0,1,1,2)</td>
<td>2</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
<td>(0,0,0,0,0,0,1,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>16</td>
<td>18</td>
<td>(0,0,0,0,0,0,1,2,2)</td>
<td>2</td>
<td>13</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>17</td>
<td>19</td>
<td>(0,0,0,0,0,0,2,0,0)</td>
<td>2</td>
<td>16</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>21</td>
<td>(0,0,0,0,0,2,0,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>19</td>
<td>22</td>
<td>(0,0,0,0,0,2,1,0)</td>
<td>2</td>
<td>24</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>20</td>
<td>24</td>
<td>(0,0,0,0,0,2,1,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>21</td>
<td>25</td>
<td>(0,0,0,0,0,2,2,0)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>3</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>22</td>
<td>26</td>
<td>(0,0,0,0,0,2,2,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>23</td>
<td>27</td>
<td>(0,0,0,0,0,2,2,2)</td>
<td>2</td>
<td>4</td>
<td>1</td>
<td>2.2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>24</td>
<td>30</td>
<td>(0,0,0,0,1,0,1,0)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>25</td>
<td>31</td>
<td>(0,0,0,0,1,0,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>26</td>
<td>32</td>
<td>(0,0,0,0,1,0,1,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>27</td>
<td>33</td>
<td>(0,0,0,0,1,0,2,0)</td>
<td>2</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>28</td>
<td>34</td>
<td>(0,0,0,0,1,0,2,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>29</td>
<td>35</td>
<td>(0,0,0,0,1,0,2,2)</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>30</td>
<td>36</td>
<td>(0,0,0,0,1,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>31</td>
<td>37</td>
<td>(0,0,0,0,1,1,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>32</td>
<td>38</td>
<td>(0,0,0,0,1,1,0,2)</td>
<td>2</td>
<td>15</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>33</td>
<td>39</td>
<td>(0,0,0,0,1,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>34</td>
<td>40</td>
<td>(0,0,0,0,1,1,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>35</td>
<td>41</td>
<td>(0,0,0,0,1,1,1,2)</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>36</td>
<td>42</td>
<td>(0,0,0,0,1,1,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>37</td>
<td>43</td>
<td>(0,0,0,0,1,1,2,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>38</td>
<td>44</td>
<td>(0,0,0,0,1,1,2,2)</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>39</td>
<td>45</td>
<td>(0,0,0,0,1,2,0,0)</td>
<td>2</td>
<td>24</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>40</td>
<td>46</td>
<td>(0,0,0,0,1,2,0,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>41</td>
<td>47</td>
<td>(0,0,0,0,1,2,0,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>42</td>
<td>48</td>
<td>(0,0,0,0,1,2,1,0)</td>
<td>2</td>
<td>36</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>43</td>
<td>49</td>
<td>(0,0,0,0,1,2,1,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>44</td>
<td>50</td>
<td>(0,0,0,0,1,2,1,2)</td>
<td>2</td>
<td>14</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>45</td>
<td>51</td>
<td>(0,0,0,0,1,2,2,0)</td>
<td>2</td>
<td>12</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>46</td>
<td>52</td>
<td>(0,0,0,0,1,2,2,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>47</td>
<td>53</td>
<td>(0,0,0,0,1,2,2,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>48</td>
<td>59</td>
<td>(0,0,0,0,2,0,2,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>49</td>
<td>60</td>
<td>(0,0,0,0,2,0,2,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>50</td>
<td>61</td>
<td>(0,0,0,0,2,1,0,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>51</td>
<td>63</td>
<td>(0,0,0,0,2,1,0,2)</td>
<td>2</td>
<td>29</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>52</td>
<td>65</td>
<td>(0,0,0,0,2,1,1,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>53</td>
<td>66</td>
<td>(0,0,0,0,2,1,1,2)</td>
<td>2</td>
<td>19</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>54</td>
<td>67</td>
<td>(0,0,0,0,2,1,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>55</td>
<td>69</td>
<td>(0,0,0,0,2,1,2,2)</td>
<td>2</td>
<td>29</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>56</td>
<td>70</td>
<td>(0,0,0,0,2,2,0,0)</td>
<td>2</td>
<td>26</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>57</td>
<td>72</td>
<td>(0,0,0,0,2,2,0,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>58</td>
<td>73</td>
<td>(0,0,0,0,2,2,1,0)</td>
<td>2</td>
<td>50</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>59</td>
<td>75</td>
<td>(0,0,0,0,2,2,1,2)</td>
<td>2</td>
<td>18</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>60</td>
<td>78</td>
<td>(0,0,0,0,2,2,2,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>61</td>
<td>79</td>
<td>(0,0,0,1,0,0,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>62</td>
<td>80</td>
<td>(0,0,0,1,0,0,0,2)</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>63</td>
<td>81</td>
<td>(0,0,0,1,0,0,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>64</td>
<td>82</td>
<td>(0,0,0,1,0,0,1,2)</td>
<td>2</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>65</td>
<td>83</td>
<td>(0,0,0,1,0,0,2,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>66</td>
<td>85</td>
<td>(0,0,0,1,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>67</td>
<td>87</td>
<td>(0,0,0,1,0,1,0,2)</td>
<td>2</td>
<td>14</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>68</td>
<td>88</td>
<td>(0,0,0,0,1,0,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>69</td>
<td>89</td>
<td>(0,0,0,0,1,0,1,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>70</td>
<td>90</td>
<td>(0,0,0,0,1,0,1,1,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>71</td>
<td>91</td>
<td>(0,0,0,0,1,0,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>72</td>
<td>92</td>
<td>(0,0,0,0,1,0,1,2,2)</td>
<td>2</td>
<td>34</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>73</td>
<td>94</td>
<td>(0,0,0,0,1,0,2,0,0)</td>
<td>2</td>
<td>18</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>74</td>
<td>96</td>
<td>(0,0,0,0,1,0,2,0,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>75</td>
<td>97</td>
<td>(0,0,0,0,1,0,2,1,0)</td>
<td>2</td>
<td>30</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>76</td>
<td>99</td>
<td>(0,0,0,0,1,0,2,1,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>77</td>
<td>100</td>
<td>(0,0,0,0,1,0,2,2,0)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>2.2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>78</td>
<td>101</td>
<td>(0,0,0,0,1,0,2,2,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>79</td>
<td>102</td>
<td>(0,0,0,0,1,0,2,2,2)</td>
<td>2</td>
<td>4</td>
<td>1</td>
<td>2.2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>80</td>
<td>103</td>
<td>(0,0,0,0,1,1,0,1,1)</td>
<td>2</td>
<td>5</td>
<td>1</td>
<td>2.2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>81</td>
<td>105</td>
<td>(0,0,0,0,1,1,0,1,2)</td>
<td>3</td>
<td>7</td>
<td>1</td>
<td>2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>82</td>
<td>106</td>
<td>(0,0,0,0,1,1,0,2,1)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>2.2</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>83</td>
<td>107</td>
<td>(0,0,0,0,1,1,0,2,2)</td>
<td>3</td>
<td>12</td>
<td>1</td>
<td>2.2</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>84</td>
<td>111</td>
<td>(0,0,0,0,1,1,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>85</td>
<td>112</td>
<td>(0,0,0,0,1,1,1,1,1)</td>
<td>2</td>
<td>7</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>86</td>
<td>113</td>
<td>(0,0,0,0,1,1,1,1,2)</td>
<td>2</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>87</td>
<td>115</td>
<td>(0,0,0,0,1,1,1,2,1)</td>
<td>2</td>
<td>26</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>88</td>
<td>116</td>
<td>(0,0,0,0,1,1,1,2,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>89</td>
<td>117</td>
<td>(0,0,0,0,1,1,2,0,0)</td>
<td>2</td>
<td>34</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>90</td>
<td>119</td>
<td>(0,0,0,0,1,1,2,0,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>91</td>
<td>120</td>
<td>(0,0,0,0,1,1,2,1,0)</td>
<td>2</td>
<td>44</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>92</td>
<td>121</td>
<td>(0,0,0,0,1,1,2,1,1)</td>
<td>2</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>93</td>
<td>122</td>
<td>(0,0,0,1,2,1,2)</td>
<td>3</td>
<td>54</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>94</td>
<td>123</td>
<td>(0,0,0,1,2,2,0)</td>
<td>2</td>
<td>18</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>95</td>
<td>124</td>
<td>(0,0,0,1,2,2,1)</td>
<td>2</td>
<td>14</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>96</td>
<td>125</td>
<td>(0,0,0,1,2,2,2)</td>
<td>3</td>
<td>18</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>97</td>
<td>129</td>
<td>(0,0,0,1,2,0,2,1)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>2,2</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>98</td>
<td>130</td>
<td>(0,0,0,1,2,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>99</td>
<td>132</td>
<td>(0,0,0,1,2,1,0,2)</td>
<td>2</td>
<td>38</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>100</td>
<td>134</td>
<td>(0,0,0,1,2,1,1,1)</td>
<td>2</td>
<td>16</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>101</td>
<td>135</td>
<td>(0,0,0,1,2,1,1,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>102</td>
<td>136</td>
<td>(0,0,0,1,2,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>103</td>
<td>137</td>
<td>(0,0,0,1,2,1,2,1)</td>
<td>2</td>
<td>24</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>104</td>
<td>138</td>
<td>(0,0,0,1,2,1,2,2)</td>
<td>2</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>105</td>
<td>139</td>
<td>(0,0,0,1,2,2,0,0)</td>
<td>2</td>
<td>28</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>106</td>
<td>141</td>
<td>(0,0,0,1,2,2,0,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>107</td>
<td>142</td>
<td>(0,0,0,1,2,2,1,0)</td>
<td>2</td>
<td>52</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>108</td>
<td>143</td>
<td>(0,0,0,1,2,2,1,1)</td>
<td>2</td>
<td>34</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>109</td>
<td>144</td>
<td>(0,0,0,1,2,2,1,2)</td>
<td>3</td>
<td>183</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>110</td>
<td>147</td>
<td>(0,0,0,1,2,2,2,2)</td>
<td>3</td>
<td>15</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>111</td>
<td>148</td>
<td>(0,0,0,2,0,0,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>112</td>
<td>149</td>
<td>(0,0,0,2,0,0,1,1)</td>
<td>1</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>113</td>
<td>151</td>
<td>(0,0,0,2,0,1,0,0)</td>
<td>1</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>114</td>
<td>153</td>
<td>(0,0,0,2,0,1,0,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>115</td>
<td>155</td>
<td>(0,0,0,2,0,1,1,1)</td>
<td>1</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>116</td>
<td>157</td>
<td>(0,0,0,2,0,1,2,0)</td>
<td>1</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>117</td>
<td>160</td>
<td>(0,0,0,2,0,2,0,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>118</td>
<td>161</td>
<td>(0,0,0,2,0,2,0,1)</td>
<td>1</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>119</td>
<td>162</td>
<td>(0,0,0,2,0,2,0,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>120</td>
<td>163</td>
<td>(0,0,0,2,0,2,1,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>121</td>
<td>165</td>
<td>(0,0,0,2,0,2,1,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>122</td>
<td>166</td>
<td>(0,0,0,2,0,2,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>123</td>
<td>168</td>
<td>(0,0,0,2,0,2,2,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>124</td>
<td>169</td>
<td>(0,0,0,2,1,0,1,1)</td>
<td>2</td>
<td>24</td>
<td>2</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>125</td>
<td>170</td>
<td>(0,0,0,2,1,0,2,1)</td>
<td>2</td>
<td>8</td>
<td>2</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>126</td>
<td>171</td>
<td>(0,0,0,2,1,1,0,0)</td>
<td>1</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>127</td>
<td>175</td>
<td>(0,0,0,2,1,1,1,1)</td>
<td>2</td>
<td>56</td>
<td>2</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>128</td>
<td>176</td>
<td>(0,0,0,2,1,1,2,0)</td>
<td>2</td>
<td>68</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>129</td>
<td>178</td>
<td>(0,0,0,2,1,2,1,0)</td>
<td>2</td>
<td>68</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>130</td>
<td>179</td>
<td>(0,0,0,2,1,2,2,0)</td>
<td>2</td>
<td>70</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>131</td>
<td>180</td>
<td>(0,0,0,2,2,0,0,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>132</td>
<td>182</td>
<td>(0,0,0,2,2,0,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>133</td>
<td>183</td>
<td>(0,0,0,2,2,1,0,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>134</td>
<td>184</td>
<td>(0,0,0,2,2,1,1,0)</td>
<td>2</td>
<td>272</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>135</td>
<td>185</td>
<td>(0,0,0,2,2,1,2,0)</td>
<td>2</td>
<td>24</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>136</td>
<td>186</td>
<td>(0,0,0,2,2,2,0,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>137</td>
<td>188</td>
<td>(0,0,0,2,2,2,2,0)</td>
<td>2</td>
<td>12</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>138</td>
<td>194</td>
<td>(0,0,0,2,2,1,1,1)</td>
<td>2</td>
<td>16</td>
<td>2</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>139</td>
<td>195</td>
<td>(0,0,0,2,2,1,1,2)</td>
<td>2</td>
<td>102</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>140</td>
<td>198</td>
<td>(0,0,0,2,2,1,2,2)</td>
<td>2</td>
<td>13</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>141</td>
<td>199</td>
<td>(0,0,0,2,2,2,0,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>142</td>
<td>201</td>
<td>(0,0,0,2,2,2,0,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page

111
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>143</td>
<td>203</td>
<td>(0,0,0,2,2,2,1,1)</td>
<td>2</td>
<td>36</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>144</td>
<td>204</td>
<td>(0,0,0,2,2,2,1,2)</td>
<td>2</td>
<td>32</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>145</td>
<td>207</td>
<td>(0,0,1,0,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>146</td>
<td>209</td>
<td>(0,0,1,0,0,1,0,2)</td>
<td>2</td>
<td>60</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>147</td>
<td>213</td>
<td>(0,0,1,0,0,1,2,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>148</td>
<td>215</td>
<td>(0,0,1,0,0,1,2,2)</td>
<td>2</td>
<td>136</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>149</td>
<td>216</td>
<td>(0,0,1,0,0,2,0,0)</td>
<td>2</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>150</td>
<td>218</td>
<td>(0,0,1,0,0,2,0,2)</td>
<td>2</td>
<td>24</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>151</td>
<td>219</td>
<td>(0,0,1,0,0,2,1,0)</td>
<td>2</td>
<td>40</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>152</td>
<td>221</td>
<td>(0,0,1,0,0,2,1,2)</td>
<td>2</td>
<td>48</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>153</td>
<td>222</td>
<td>(0,0,1,0,0,2,2,0)</td>
<td>2</td>
<td>14</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>154</td>
<td>223</td>
<td>(0,0,1,0,0,2,2,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>155</td>
<td>224</td>
<td>(0,0,1,0,0,2,2,2)</td>
<td>2</td>
<td>16</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>156</td>
<td>235</td>
<td>(0,0,1,0,1,2,0,2)</td>
<td>2</td>
<td>16</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>157</td>
<td>239</td>
<td>(0,0,1,0,1,2,2,0)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>158</td>
<td>241</td>
<td>(0,0,1,0,1,2,2,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>2,2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>159</td>
<td>244</td>
<td>(0,0,1,0,2,1,0,2)</td>
<td>2</td>
<td>160</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>160</td>
<td>250</td>
<td>(0,0,1,0,2,1,2,2)</td>
<td>2</td>
<td>198</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>161</td>
<td>252</td>
<td>(0,0,1,0,2,2,0,2)</td>
<td>2</td>
<td>18</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>162</td>
<td>253</td>
<td>(0,0,1,0,2,2,1,0)</td>
<td>2</td>
<td>18</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>163</td>
<td>255</td>
<td>(0,0,1,0,2,2,1,2)</td>
<td>2</td>
<td>72</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>164</td>
<td>257</td>
<td>(0,0,1,1,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>165</td>
<td>258</td>
<td>(0,0,1,1,0,1,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>166</td>
<td>259</td>
<td>(0,0,1,1,0,1,0,2)</td>
<td>2</td>
<td>18</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>167</td>
<td>260</td>
<td>(0,0,1,1,0,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>168</td>
<td>261</td>
<td>(0,0,0,1,1,0,1,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>169</td>
<td>262</td>
<td>(0,0,0,1,1,0,1,1,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>170</td>
<td>263</td>
<td>(0,0,0,1,1,0,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>171</td>
<td>265</td>
<td>(0,0,0,1,1,0,1,2,2)</td>
<td>2</td>
<td>30</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>172</td>
<td>266</td>
<td>(0,0,0,1,1,0,2,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>173</td>
<td>267</td>
<td>(0,0,0,1,1,0,2,0,2)</td>
<td>2</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>174</td>
<td>268</td>
<td>(0,0,0,1,1,0,2,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>175</td>
<td>269</td>
<td>(0,0,0,1,1,0,2,1,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>176</td>
<td>270</td>
<td>(0,0,0,1,1,0,2,2,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>177</td>
<td>271</td>
<td>(0,0,0,1,1,0,2,2,2)</td>
<td>2</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>178</td>
<td>272</td>
<td>(0,0,0,1,1,1,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>179</td>
<td>273</td>
<td>(0,0,0,1,1,1,1,0,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>180</td>
<td>274</td>
<td>(0,0,0,1,1,1,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>181</td>
<td>275</td>
<td>(0,0,0,1,1,1,1,2,2)</td>
<td>3</td>
<td>3</td>
<td>1</td>
<td>2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>182</td>
<td>278</td>
<td>(0,0,0,1,1,2,1,0,2)</td>
<td>2</td>
<td>44</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>183</td>
<td>280</td>
<td>(0,0,0,1,1,2,1,1,1)</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>184</td>
<td>281</td>
<td>(0,0,0,1,1,2,1,1,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>185</td>
<td>282</td>
<td>(0,0,0,1,1,2,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>186</td>
<td>283</td>
<td>(0,0,0,1,1,2,1,2,1)</td>
<td>2</td>
<td>16</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>187</td>
<td>284</td>
<td>(0,0,0,1,1,2,1,2,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>188</td>
<td>286</td>
<td>(0,0,0,1,1,2,2,1,1)</td>
<td>2</td>
<td>24</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>189</td>
<td>287</td>
<td>(0,0,0,1,1,2,2,1,2)</td>
<td>3</td>
<td>36</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>190</td>
<td>298</td>
<td>(0,0,0,1,2,0,2,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>191</td>
<td>305</td>
<td>(0,0,0,1,2,1,1,1,1)</td>
<td>2</td>
<td>128</td>
<td>2</td>
<td>8</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>192</td>
<td>306</td>
<td>(0,0,0,1,2,1,1,1,2)</td>
<td>2</td>
<td>32</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>193</td>
<td>308</td>
<td>(0,0,0,1,2,1,1,2,1)</td>
<td>2</td>
<td>20</td>
<td>2</td>
<td>8</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>194</td>
<td>309</td>
<td>(0,0,0,1,2,1,1,2,2)</td>
<td>2</td>
<td>32</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>195</td>
<td>311</td>
<td>(0,0,0,1,2,1,2,2,1)</td>
<td>2</td>
<td>16</td>
<td>2</td>
<td>8</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>196</td>
<td>316</td>
<td>(0,0,0,1,2,2,1,1,1)</td>
<td>2</td>
<td>2</td>
<td>8</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>197</td>
<td>317</td>
<td>(0,0,0,1,2,2,1,1,1,2)</td>
<td>2</td>
<td>48</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>198</td>
<td>320</td>
<td>(0,0,0,1,2,2,1,2,2)</td>
<td>2</td>
<td>16</td>
<td>2</td>
<td>8</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>199</td>
<td>321</td>
<td>(0,0,0,1,2,2,1,2,1,1)</td>
<td>2</td>
<td>8</td>
<td>2</td>
<td>8</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>200</td>
<td>322</td>
<td>(0,0,0,2,0,0,1,0,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>201</td>
<td>341</td>
<td>(0,0,0,2,0,2,1,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>202</td>
<td>347</td>
<td>(0,0,0,2,1,0,1,0,2)</td>
<td>2</td>
<td>15</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>203</td>
<td>349</td>
<td>(0,0,0,2,1,0,1,1,2)</td>
<td>2</td>
<td>153</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>204</td>
<td>353</td>
<td>(0,0,0,2,1,1,1,1,1)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>205</td>
<td>354</td>
<td>(0,0,0,2,1,1,1,1,1,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>206</td>
<td>356</td>
<td>(0,0,0,2,1,1,1,2,2)</td>
<td>2</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>207</td>
<td>359</td>
<td>(0,0,0,2,1,2,2,1,1,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>208</td>
<td>366</td>
<td>(0,0,0,2,2,1,1,1,1,1)</td>
<td>2</td>
<td>4</td>
<td>2</td>
<td>2</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>209</td>
<td>376</td>
<td>(0,0,1,0,0,0,1,0,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>210</td>
<td>377</td>
<td>(0,0,1,0,0,0,1,0,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>211</td>
<td>378</td>
<td>(0,0,1,0,0,0,1,0,1,2)</td>
<td>2</td>
<td>15</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>212</td>
<td>379</td>
<td>(0,0,1,0,0,0,1,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>213</td>
<td>380</td>
<td>(0,0,1,0,0,0,1,1,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>214</td>
<td>381</td>
<td>(0,0,1,0,0,0,1,1,1,2)</td>
<td>2</td>
<td>14</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>215</td>
<td>382</td>
<td>(0,0,1,0,0,0,1,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>216</td>
<td>384</td>
<td>(0,0,1,0,0,0,1,2,2)</td>
<td>2</td>
<td>46</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>217</td>
<td>385</td>
<td>(0,0,1,0,0,0,2,0,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>218</td>
<td>387</td>
<td>(0,0,1,0,0,0,2,0,2)</td>
<td>2</td>
<td>37</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>219</td>
<td>388</td>
<td>(0,0,1,0,0,0,2,1,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>220</td>
<td>390</td>
<td>(0,0,1,0,0,0,2,1,2)</td>
<td>2</td>
<td>58</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>221</td>
<td>391</td>
<td>(0,0,1,0,0,0,2,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>222</td>
<td>405</td>
<td>(0,0,1,0,0,1,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>223</td>
<td>406</td>
<td>(0,0,1,0,0,1,1,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>224</td>
<td>407</td>
<td>(0,0,1,0,0,1,1,1,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>225</td>
<td>410</td>
<td>(0,0,1,0,0,1,1,2,2)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>226</td>
<td>417</td>
<td>(0,0,1,0,0,2,2,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>227</td>
<td>434</td>
<td>(0,0,1,0,0,2,2,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>228</td>
<td>436</td>
<td>(0,0,1,0,0,2,2,2,2)</td>
<td>2</td>
<td>33</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>229</td>
<td>437</td>
<td>(0,0,1,0,0,2,2,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>230</td>
<td>439</td>
<td>(0,0,1,0,0,2,2,0,2)</td>
<td>2</td>
<td>46</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>231</td>
<td>454</td>
<td>(0,0,1,0,1,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>232</td>
<td>455</td>
<td>(0,0,1,0,1,0,1,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>233</td>
<td>456</td>
<td>(0,0,1,0,1,0,1,0,2)</td>
<td>2</td>
<td>15</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>234</td>
<td>457</td>
<td>(0,0,1,0,1,0,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>235</td>
<td>458</td>
<td>(0,0,1,0,1,0,1,1,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>236</td>
<td>459</td>
<td>(0,0,1,0,1,0,1,1,2)</td>
<td>2</td>
<td>17</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>237</td>
<td>460</td>
<td>(0,0,1,0,1,0,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>238</td>
<td>462</td>
<td>(0,0,1,0,1,0,1,2,2)</td>
<td>2</td>
<td>46</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>239</td>
<td>463</td>
<td>(0,0,1,0,1,0,2,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>240</td>
<td>465</td>
<td>(0,0,1,0,1,0,2,0,2)</td>
<td>2</td>
<td>58</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>241</td>
<td>469</td>
<td>(0,0,1,0,1,0,2,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>242</td>
<td>483</td>
<td>(0,0,1,0,1,1,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>243</td>
<td>484</td>
<td>(0,0,1,0,1,1,1,1,1)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>244</td>
<td>485</td>
<td>(0,0,1,0,1,1,1,1,2)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>245</td>
<td>487</td>
<td>(0,0,1,0,1,1,1,2,1)</td>
<td>2</td>
<td>36</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>246</td>
<td>488</td>
<td>(0,0,1,0,1,1,1,2,2)</td>
<td>2</td>
<td>12</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>247</td>
<td>493</td>
<td>(0,0,1,0,1,1,2,1,1)</td>
<td>2</td>
<td>12</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>248</td>
<td>494</td>
<td>(0,0,1,0,1,1,2,1,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>249</td>
<td>495</td>
<td>(0,0,1,0,1,2,1,2,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>250</td>
<td>496</td>
<td>(0,0,1,0,1,2,2,1,1)</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>251</td>
<td>512</td>
<td>(0,0,1,0,1,2,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>252</td>
<td>513</td>
<td>(0,0,1,0,1,2,1,2,1)</td>
<td>2</td>
<td>28</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>253</td>
<td>514</td>
<td>(0,0,1,0,1,2,1,2,2)</td>
<td>2</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>254</td>
<td>515</td>
<td>(0,0,1,0,1,2,2,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>255</td>
<td>517</td>
<td>(0,0,1,0,1,2,2,0,2)</td>
<td>2</td>
<td>83</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>256</td>
<td>519</td>
<td>(0,0,1,0,1,2,2,1,1)</td>
<td>2</td>
<td>58</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>257</td>
<td>520</td>
<td>(0,0,1,0,1,2,2,1,2)</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>258</td>
<td>522</td>
<td>(0,0,1,0,1,2,2,2,0)</td>
<td>2</td>
<td>40</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>259</td>
<td>532</td>
<td>(0,0,1,0,2,0,1,0,0)</td>
<td>1</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>260</td>
<td>534</td>
<td>(0,0,1,0,2,0,1,0,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>261</td>
<td>538</td>
<td>(0,0,1,0,2,0,1,2,0)</td>
<td>1</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>262</td>
<td>562</td>
<td>(0,0,1,0,2,1,1,1,1)</td>
<td>2</td>
<td>82</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>263</td>
<td>563</td>
<td>(0,0,1,0,2,1,1,1,2)</td>
<td>2</td>
<td>324</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>264</td>
<td>565</td>
<td>(0,0,1,0,2,1,1,2,1)</td>
<td>2</td>
<td>324</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>265</td>
<td>566</td>
<td>(0,0,1,0,2,1,1,2,2)</td>
<td>2</td>
<td>486</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>266</td>
<td>571</td>
<td>(0,0,1,0,2,1,2,1,1)</td>
<td>2</td>
<td>1296</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>267</td>
<td>580</td>
<td>(0,0,1,0,1,0,0,0,0,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page

116
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>268</td>
<td>602</td>
<td>(0,0,1,1,0,0,0,0,0,2)</td>
<td>2</td>
<td>100</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>269</td>
<td>603</td>
<td>(0,0,1,1,0,0,0,1,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>270</td>
<td>604</td>
<td>(0,0,1,1,0,0,0,1,1,1)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>271</td>
<td>606</td>
<td>(0,0,1,1,1,0,0,0,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>272</td>
<td>608</td>
<td>(0,0,1,1,1,0,0,0,2,2)</td>
<td>2</td>
<td>208</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>273</td>
<td>609</td>
<td>(0,0,1,1,1,0,1,0,1,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>274</td>
<td>612</td>
<td>(0,0,1,1,1,0,1,1,0,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>275</td>
<td>613</td>
<td>(0,0,1,1,1,0,1,1,1,1)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>276</td>
<td>615</td>
<td>(0,0,1,1,1,0,1,2,0,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>277</td>
<td>618</td>
<td>(0,0,1,1,1,0,2,0,2,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>278</td>
<td>620</td>
<td>(0,0,1,1,1,0,2,0,2,2)</td>
<td>2</td>
<td>256</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>279</td>
<td>624</td>
<td>(0,0,1,1,1,0,2,2,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>280</td>
<td>629</td>
<td>(0,0,1,1,1,1,0,1,0,1,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>281</td>
<td>630</td>
<td>(0,0,1,1,1,1,0,1,0,1,1)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>282</td>
<td>632</td>
<td>(0,0,1,1,1,1,0,1,0,2,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>283</td>
<td>638</td>
<td>(0,0,1,1,1,1,1,1,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>284</td>
<td>639</td>
<td>(0,0,1,1,1,1,1,1,1,1)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>285</td>
<td>652</td>
<td>(0,0,1,1,1,2,0,0,0,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>286</td>
<td>654</td>
<td>(0,0,1,1,1,2,0,0,0,2)</td>
<td>2</td>
<td>336</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>287</td>
<td>658</td>
<td>(0,0,1,1,1,2,0,2,0,2)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>288</td>
<td>677</td>
<td>(0,0,1,1,1,1,0,0,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>289</td>
<td>678</td>
<td>(0,0,1,1,1,1,0,0,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>290</td>
<td>679</td>
<td>(0,0,1,1,1,1,0,0,0,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>291</td>
<td>680</td>
<td>(0,0,1,1,1,1,0,0,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>292</td>
<td>681</td>
<td>(0,0,1,1,1,1,0,0,1,2)</td>
<td>2</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>293</td>
<td>682</td>
<td>(0,0,1,1,1,0,0,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>294</td>
<td>684</td>
<td>(0,0,1,1,1,0,0,2,2)</td>
<td>2</td>
<td>60</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>295</td>
<td>687</td>
<td>(0,0,1,1,1,0,1,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>296</td>
<td>690</td>
<td>(0,0,1,1,1,0,2,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>297</td>
<td>691</td>
<td>(0,0,1,1,1,2,0,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>298</td>
<td>693</td>
<td>(0,0,1,1,1,2,0,0,2)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>299</td>
<td>695</td>
<td>(0,0,1,1,1,2,0,1,1)</td>
<td>2</td>
<td>80</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>300</td>
<td>696</td>
<td>(0,0,1,1,1,2,0,1,2)</td>
<td>2</td>
<td>24</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>301</td>
<td>697</td>
<td>(0,0,1,1,1,2,0,2,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>302</td>
<td>698</td>
<td>(0,0,1,1,1,2,0,2,1)</td>
<td>2</td>
<td>72</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>303</td>
<td>704</td>
<td>(0,0,1,1,1,2,1,1,1)</td>
<td>2</td>
<td>48</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>304</td>
<td>705</td>
<td>(0,0,1,1,1,2,1,1,2)</td>
<td>2</td>
<td>14</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>305</td>
<td>707</td>
<td>(0,0,1,1,1,2,1,2,1)</td>
<td>2</td>
<td>48</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>306</td>
<td>710</td>
<td>(0,0,1,1,1,2,2,0,2)</td>
<td>2</td>
<td>162</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>307</td>
<td>712</td>
<td>(0,0,1,1,1,2,2,1,1)</td>
<td>2</td>
<td>72</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>308</td>
<td>755</td>
<td>(0,0,1,1,2,1,1,1,1)</td>
<td>2</td>
<td>896</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>309</td>
<td>756</td>
<td>(0,0,1,1,2,1,1,1,2)</td>
<td>2</td>
<td>224</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>310</td>
<td>758</td>
<td>(0,0,1,1,2,1,1,2,1)</td>
<td>2</td>
<td>224</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>311</td>
<td>780</td>
<td>(0,0,1,1,2,2,1,1,1)</td>
<td>2</td>
<td>144</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>312</td>
<td>792</td>
<td>(0,0,1,2,0,0,0,0,0)</td>
<td>1</td>
<td>7</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>313</td>
<td>870</td>
<td>(0,0,1,2,1,0,0,0,2)</td>
<td>2</td>
<td>729</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>314</td>
<td>885</td>
<td>(0,0,1,2,1,0,1,2,2)</td>
<td>2</td>
<td>27</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>315</td>
<td>898</td>
<td>(0,0,1,2,1,1,2,0,2)</td>
<td>2</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>316</td>
<td>984</td>
<td>(0,0,1,2,2,2,1,1,1)</td>
<td>2</td>
<td>36</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>317</td>
<td>1012</td>
<td>(0,0,2,0,0,0,2,0,0)</td>
<td>2</td>
<td>18</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page

118
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>318</td>
<td>1014</td>
<td>(0,0,2,0,0,0,2,1,0)</td>
<td>2</td>
<td>34</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>319</td>
<td>1038</td>
<td>(0,0,2,0,0,1,2,1,0)</td>
<td>2</td>
<td>38</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>320</td>
<td>1040</td>
<td>(0,0,2,0,0,1,2,1,2)</td>
<td>2</td>
<td>13</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>321</td>
<td>1065</td>
<td>(0,0,2,0,0,2,2,2,0)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>322</td>
<td>1066</td>
<td>(0,0,2,0,0,2,2,2,1)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>323</td>
<td>1084</td>
<td>(0,0,2,0,1,0,2,0,0)</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>324</td>
<td>1086</td>
<td>(0,0,2,0,1,0,2,0,1)</td>
<td>2</td>
<td>36</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>325</td>
<td>1107</td>
<td>(0,0,2,0,1,1,2,1,0)</td>
<td>2</td>
<td>36</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>326</td>
<td>1108</td>
<td>(0,0,2,0,1,1,2,1,2)</td>
<td>3</td>
<td>15</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>327</td>
<td>1132</td>
<td>(0,0,2,0,1,2,2,2,0)</td>
<td>2</td>
<td>8</td>
<td>1</td>
<td>2.2</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>328</td>
<td>1133</td>
<td>(0,0,2,0,1,2,2,2,1)</td>
<td>2</td>
<td>13</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>329</td>
<td>1151</td>
<td>(0,0,2,0,2,0,2,0,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>330</td>
<td>1153</td>
<td>(0,0,2,0,2,0,2,1,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>331</td>
<td>1176</td>
<td>(0,0,2,0,2,1,2,1,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>332</td>
<td>1200</td>
<td>(0,0,2,0,2,2,2,2,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>333</td>
<td>1202</td>
<td>(0,0,2,1,0,0,0,0,0)</td>
<td>2</td>
<td>164</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>334</td>
<td>1205</td>
<td>(0,0,2,1,0,0,0,1,0)</td>
<td>2</td>
<td>240</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>335</td>
<td>1219</td>
<td>(0,0,2,1,0,0,2,0,0)</td>
<td>2</td>
<td>160</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>336</td>
<td>1221</td>
<td>(0,0,2,1,0,0,2,1,0)</td>
<td>2</td>
<td>216</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>337</td>
<td>1225</td>
<td>(0,0,2,1,0,1,0,0,0)</td>
<td>2</td>
<td>68</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>338</td>
<td>1227</td>
<td>(0,0,2,1,0,1,0,0,2)</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>339</td>
<td>1231</td>
<td>(0,0,2,1,0,1,0,2,0)</td>
<td>2</td>
<td>96</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>340</td>
<td>1233</td>
<td>(0,0,2,1,0,1,0,2,2)</td>
<td>2</td>
<td>32</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>341</td>
<td>1242</td>
<td>(0,0,2,1,0,1,2,0,0)</td>
<td>2</td>
<td>64</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>342</td>
<td>1249</td>
<td>(0,0,2,1,0,2,0,0,1)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>343</td>
<td>1268</td>
<td>(0,0,2,1,0,2,2,2)</td>
<td>2</td>
<td>40</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>344</td>
<td>1269</td>
<td>(0,0,2,1,0,2,2,2)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>345</td>
<td>1271</td>
<td>(0,0,2,1,1,2,0,0,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>346</td>
<td>1277</td>
<td>(0,0,2,1,1,2,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>347</td>
<td>1281</td>
<td>(0,0,2,1,1,2,2,2,0)</td>
<td>2</td>
<td>12</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>348</td>
<td>1321</td>
<td>(0,0,2,1,2,1,2,0,0)</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>349</td>
<td>1433</td>
<td>(0,0,2,2,1,0,2,0,0)</td>
<td>2</td>
<td>68</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>350</td>
<td>1437</td>
<td>(0,0,2,2,1,0,2,2,0)</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>351</td>
<td>1481</td>
<td>(0,0,2,2,2,0,2,2,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>352</td>
<td>1700</td>
<td>(0,1,1,1,0,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>353</td>
<td>1708</td>
<td>(0,1,1,1,0,0,2,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>354</td>
<td>1791</td>
<td>(0,1,1,1,2,1,1,1)</td>
<td>2</td>
<td>264</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>355</td>
<td>1793</td>
<td>(0,1,1,1,2,1,1,2,1)</td>
<td>2</td>
<td>28</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>356</td>
<td>1799</td>
<td>(0,1,1,1,2,1,2,2,1)</td>
<td>2</td>
<td>52</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>357</td>
<td>1818</td>
<td>(0,1,1,1,2,2,1,1)</td>
<td>2</td>
<td>20</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>358</td>
<td>1829</td>
<td>(0,1,1,2,0,0,1,0,0)</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>359</td>
<td>1837</td>
<td>(0,1,1,2,0,0,2,0,0)</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>360</td>
<td>1962</td>
<td>(0,1,1,2,2,1,1,1)</td>
<td>2</td>
<td>12</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>361</td>
<td>2088</td>
<td>(0,1,2,1,0,0,2,0,0)</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>362</td>
<td>2090</td>
<td>(0,1,2,1,0,0,2,1,0)</td>
<td>2</td>
<td>36</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>363</td>
<td>2102</td>
<td>(0,1,2,1,0,1,2,1,0)</td>
<td>2</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>364</td>
<td>2104</td>
<td>(0,1,2,1,0,1,2,2,0)</td>
<td>2</td>
<td>12</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>365</td>
<td>2116</td>
<td>(0,1,2,1,0,2,2,2,1)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>366</td>
<td>2124</td>
<td>(0,1,2,1,2,0,2,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>367</td>
<td>2135</td>
<td>(0,1,2,1,2,1,2,2,1)</td>
<td>2</td>
<td>20</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>368</td>
<td>2144</td>
<td>(0,1,2,2,0,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>369</td>
<td>2159</td>
<td>(0,1,2,2,0,2,1,1,0)</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>370</td>
<td>2171</td>
<td>(0,1,2,2,2,2,1,1,1)</td>
<td>2</td>
<td>12</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>371</td>
<td>2346</td>
<td>(0,2,1,2,1,0,1,0,2)</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>372</td>
<td>2353</td>
<td>(1,0,0,0,0,0,0,0,0)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>373</td>
<td>2354</td>
<td>(1,0,0,0,0,0,0,0,1)</td>
<td>1</td>
<td>9</td>
<td>2</td>
<td>9</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>374</td>
<td>2357</td>
<td>(1,0,0,0,0,0,0,2,0)</td>
<td>1</td>
<td>12</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>375</td>
<td>2369</td>
<td>(1,0,0,0,0,0,2,2,0)</td>
<td>1</td>
<td>12</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>376</td>
<td>2393</td>
<td>(1,0,0,0,0,2,0,2,0)</td>
<td>1</td>
<td>12</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>377</td>
<td>2407</td>
<td>(1,0,0,0,2,0,0,0,0)</td>
<td>1</td>
<td>27</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>378</td>
<td>2428</td>
<td>(1,0,0,0,2,1,0,1,1)</td>
<td>1</td>
<td>12</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>379</td>
<td>2430</td>
<td>(1,0,0,0,2,1,0,2,1)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>380</td>
<td>2436</td>
<td>(1,0,0,0,2,1,1,2,1)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>381</td>
<td>2460</td>
<td>(1,0,0,1,0,0,0,0,0)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>382</td>
<td>2461</td>
<td>(1,0,0,1,0,0,0,0,1)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>383</td>
<td>2462</td>
<td>(1,0,0,1,0,0,1,0,0)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>384</td>
<td>2463</td>
<td>(1,0,0,1,0,0,1,0,1)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>385</td>
<td>2464</td>
<td>(1,0,0,1,0,0,0,2,0)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>386</td>
<td>2466</td>
<td>(1,0,0,1,0,0,1,0,0)</td>
<td>1</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>387</td>
<td>2467</td>
<td>(1,0,0,1,0,0,1,0,1)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>388</td>
<td>2472</td>
<td>(1,0,0,1,0,0,2,0,0)</td>
<td>1</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>389</td>
<td>2476</td>
<td>(1,0,0,1,0,0,2,2,0)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>390</td>
<td>2478</td>
<td>(1,0,0,1,0,1,0,0,0)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>391</td>
<td>2479</td>
<td>(1,0,0,1,0,1,0,0,1)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>392</td>
<td>2480</td>
<td>(1,0,0,1,0,1,0,1,0)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

Table A.1; continued on next page
continued from previous page

<table>
<thead>
<tr>
<th>CE</th>
<th>G</th>
<th>Operation</th>
<th>n</th>
<th>F(n)</th>
<th>SS</th>
<th>MGS</th>
<th>SC</th>
<th>ASC</th>
</tr>
</thead>
<tbody>
<tr>
<td>393</td>
<td>2483</td>
<td>(1,0,0,1,0,1,1,0,0)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>394</td>
<td>2486</td>
<td>(1,0,0,1,0,1,2,2,0)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>395</td>
<td>2487</td>
<td>(1,0,0,1,0,2,0,0,0)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>396</td>
<td>2493</td>
<td>(1,0,0,1,0,2,1,0,0)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>397</td>
<td>2529</td>
<td>(1,0,0,1,2,1,2,2,0)</td>
<td>1</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>398</td>
<td>2539</td>
<td>(1,0,0,1,2,2,1,1,1)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>399</td>
<td>2545</td>
<td>(1,0,0,1,2,2,2,1,1)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>400</td>
<td>2552</td>
<td>(1,0,0,2,0,0,1,1,0)</td>
<td>1</td>
<td>6</td>
<td>4</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>401</td>
<td>2558</td>
<td>(1,0,0,2,0,0,2,0,0)</td>
<td>1</td>
<td>5</td>
<td>4</td>
<td>4</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>402</td>
<td>2636</td>
<td>(1,0,0,2,2,2,1,1,1)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>6</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>403</td>
<td>2654</td>
<td>(1,0,1,0,0,0,1,2,1)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>404</td>
<td>2686</td>
<td>(1,0,1,0,0,2,1,2,1)</td>
<td>1</td>
<td>6</td>
<td>2</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>405</td>
<td>2698</td>
<td>(1,0,1,0,2,0,1,0,1)</td>
<td>1</td>
<td>10</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>406</td>
<td>2702</td>
<td>(1,0,1,0,2,0,1,2,1)</td>
<td>1</td>
<td>12</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>407</td>
<td>2739</td>
<td>(1,0,1,1,0,0,0,0,1)</td>
<td>1</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>408</td>
<td>2799</td>
<td>(1,0,1,2,0,0,1,0,1)</td>
<td>1</td>
<td>15</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>409</td>
<td>2803</td>
<td>(1,0,1,2,0,0,1,2,1)</td>
<td>1</td>
<td>15</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>410</td>
<td>2934</td>
<td>(1,0,2,0,2,1,2,1,0)</td>
<td>1</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>411</td>
<td>3242</td>
<td>(1,1,1,2,2,2,0,0,0)</td>
<td>1</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
List of Figures

1.1 Excerpt from Lorenzen 1955. ................................. 10

3.1 Lattice of subuniverses of the algebra $F_{G_{106}}(2)$. ............ 43
3.2 The algebra $P$ and its free algebras $F_p(n)$. .................. 48
3.3 Input file $G9.lgc$ for the system MUltlog. ....................... 57
3.4 The introduction rules for the operation $*$ of $G_9$. ........... 57
3.5 The introduction rules for the operation $*$ of $AdmG_9$. ....... 59
3.6 Input file $admgnine.lgc$ for the system MUltseq. ............... 60

4.1 Possible unary and binary operations on $\{0,1\}$. ............... 64
4.2 Cardinality of free algebras of groupoids. ....................... 67
4.3 Cardinality of minimal generating sets for groupoids. .......... 68
4.4 The five first (non-trivial) subdirectly irreducible PCLs. ...... 72
4.5 The De Morgan algebras $D_4$, $D_{42}$ and $\overline{D}_{42}$. .......... 75
4.6 Subquasivarieties of $DML$. .................................. 76
4.7 The tables for $\rightarrow$ of the algebras $Z_3^e$ and $Z_4^e$. ...... 82
List of Tables

4.1 Lattices with up to six elements. . . . . . . . . . . . . . . . . . 71
4.2 Admissibility for PCLs. . . . . . . . . . . . . . . . . . . . . . . 72
4.3 Admissibility for reducts of Sugihara monoids. . . . . . . . . 83
4.4 Algebras for checking admissibility. . . . . . . . . . . . . . . . 85

A.1 Three element groupoids. . . . . . . . . . . . . . . . . . . . . . 106
List of Algorithms

3.1 MinGenSet(\mathcal{K})  

3.2 AdmAlgs(\mathcal{K})
Bibliography


131


Index

Clo A, Clo_n A, 17
Ψ_K(X), 25
L-term, 16
  over X, 16
H, I, S, P, P_U, P_U^*, H^{-1}, 19
c(Σ), 77
s(Σ), 79

absorption, 20
admissibility, 38–41, 47, 53, 54, 90
algebra
  L-, 15
    admissibility, 90
    Boolean, 20, 46, 72
    De Morgan, 37, 72
    finite, 16
    free, 25, 26, 39–41, 45, 46, 89
    Kleene, 72
    minimal generating free, 31
    quotient of, 22
    reduct of, 16
    Sette, 90
    sub-, 17, 89
    Sugihara, 81

universe, 15
Wajsberg, 50
antivariety, 19
arity, 15
associativity, 20
axiomatization, 19, 46, 73–75
basis for admissible quasiequations, 47,
  74, 75
bound
  (greatest) lower, 21
  (least) upper, 21
clause, 18
  Κ-valid, 18
    negative, 18
close equivalent, 17, 52
close of operations of A, 17
commutativity, 20
completeness
  almost structural, 49, 51, 90
  hereditary structural, 102
  structural, 45, 46, 48, 49, 64, 69,
    90
  conclusion, 53
congruence, 22, 89
congruence-distributive, 101
congruence-distributive, 101
constant, 15
constant operation $c^n_a$, 16
cover, 21
designated values, 53
disjoint union, 79
distributivity, 21
distributivity, 21
embedding, 18
embedding, 18
$\mathcal{K}$-subdirect, 23
equation, 18
equation, 18
normal form, 78
equivalence class modulo $\theta$, 22
equivalence relation, 22
finitely generated, 19
generated by, 19
generating set, 19
minimal, 30, 44, 68, 90
groupoid, 67
Hasse Diagram, 21
homomorphism, 18, 88
homomorphism, 18, 88
homomorphic image, 18
homomorphic image, 18
kernel of, 18
kernel of, 18
natural $\nu_\theta$, 23
natural $\nu_\theta$, 23
idempotency, 20
infix notation, 16
instance, 53
interpretation, 55
irreducible
irreducible
$\mathcal{K}$-subdirectly, 23, 90
completely join, 21
completely meet, 21
join, 21
meet, 21
subdirectly, 90
isomorphism, 18

join, 20
language $\mathcal{L}$, 15
lattice, 20, 68
lattice, 20, 68
Boolean, 72
bounded, 21, 69
complete, 21
De Morgan, 72
distributive, 21
Kleene, 72
modular, 69
pseudocomplemented, 70
logic
Łukasiewicz, 55
finite-valued, 53
Jaśkowski, 55
R-mingle RM, 81
sequent calculus, 55
Sette, 90
meet, 20
multiset, 30
ordering $\leq_m$, 30
ordering $\leq_m$, 30
operation (symbol)
  \(n\)-ary, 15
  binary, 15
  composition of, 17
  definability, 17
  nullary, 15
  unary, 15

order
  multiset, 30
  partial, 21

partially ordered set (poset), 21
PCL, 70
prehomomorphistic image, 18

premises, 53

product
  \(\mathcal{K}\)-subdirect, 23
  direct, 18
  subdirect, 23
projection \(p^n_i\), 16

pseudocomplementation, 70

quasiequation, 18
quasivariety, 19

quotient of \(A\), 22

rule, 53, 55, 56

satisfiability, 18, 55

sequent
  \(\Gamma\), 55
  calculus, 55
  end-, 56

model of \(\Gamma\), 55
proof in the calculus, 56
provable, 56

subdirect components, 23
subdirect representation, 23
substitution, 36

Sugihara monoid, 81
term algebra over \(X\), 16
term operation, 16

unifiability, 36, 53
universal class, 19
universal mapping property, 26
valid, 53, 55
variables, 16
variety, 19
Erklärung

gemäss Art. 28 Abs. 2 RSL 05

Name/Vorname Röthlisberger Christoph
Matrikelnummer 99-114-498
Studiengang Mathematik, Dissertation
Titel der Arbeit Admissibility in Finitely Generated Quasivarieties
Leiter der Arbeit Prof. Dr. George Metcalfe


Ort/Datum Unterschrift
# Lebenslauf

Christoph Röthlisberger, geboren am 21. Juli 1979 in Sumiswald BE

<table>
<thead>
<tr>
<th>Zeitraum</th>
<th>Stelle</th>
<th>Einrichtung</th>
<th>Tätigkeit</th>
</tr>
</thead>
<tbody>
<tr>
<td>07.10–heute</td>
<td>Peter Lehmann AG, Bärau</td>
<td></td>
<td>20%-Anstellung IT</td>
</tr>
<tr>
<td>07.10–12.13</td>
<td>Mathematisches Institut, Universität Bern</td>
<td></td>
<td>Doktorstudium Mathematik</td>
</tr>
<tr>
<td>07.10–09.13</td>
<td>Mathematisches Institut, Universität Bern</td>
<td></td>
<td>10%-Anstellung Assistent (Mathematik)</td>
</tr>
<tr>
<td>11.05–07.10</td>
<td>Peter Lehmann AG, Bärau</td>
<td></td>
<td>100%-Anstellung IT</td>
</tr>
<tr>
<td>10.02–02.03</td>
<td>IAM, Universität Bern</td>
<td></td>
<td>25%-Anstellung Hilfsassistent (Datenbanken)</td>
</tr>
<tr>
<td>10.01–02.02</td>
<td>IAM, Universität Bern</td>
<td></td>
<td>50%-Anstellung Hilfsassistent (Neuronale Netze)</td>
</tr>
<tr>
<td>10.99–11.05</td>
<td>Mathematisches Institut, Universität Bern</td>
<td></td>
<td>Diplomstudium Mathematik</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Informatik (60ETCS), Physik (21ECTS)</td>
</tr>
<tr>
<td>08.95–06.99</td>
<td>Gymnasium, Burgdorf</td>
<td></td>
<td>Mathematisch-naturwissenschaftliche Maturität</td>
</tr>
<tr>
<td>08.90–07.95</td>
<td>Sekundarschule, Langnau i.E.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>08.86–07.90</td>
<td>Primarschule, Emmenmatt</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>